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1. Introduction 
The purpose of this XML Specification is to provide information on how to use Extensible 
Markup Language (XML) files in the Group Practice Reporting Option (GPRO) Web Interface. 
The data stored in the database may be exported, or the data may be updated using XML files. 

The GPRO Web Interface accepts data from Pioneer Model, Medicare Shared Savings Program 
(MSSP), NextGen Accountable Care Organizations (ACOs), and PQRS group practices. Where 
the information applies to both the ACOs and the PQRS group practices, the two organization 
types will be referred to as “group”. If the information only applies to one of the organization 
types, the group type will be specified in the document. 

The XML files exported from the GPRO Web Interface may be imported into an Excel 
spreadsheet. The data in the Excel spreadsheets may then be updated before exporting the 
Excel spreadsheet to the XML format required for upload into the GPRO Web Interface. 

For organizations using custom coding, this document provides the valid format that must be 
used to create the XML files to be uploaded into the GPRO Web Interface. 

References to the “current program year” mean the year as shown on the title page of this 
document. 

This PDF is provided as a reference only. It is NOT Section 508 compliant. For a Section 508 
compliant version of this content, please refer to the Online Content. The Online Content is the 
web page you used to download the PDF file. 

2. Release Notes 
The list below details the revisions made since the release of the 2015 GPRO Web Interface 
XML Specifications. The 2016 GPRO Web Interface XML Specifications have been updated to 
reflect the 2016 measures and the 2016 GPRO Web Interface. 

2.1. Patient Medication XML 
The next table provides the changes to the Patient Medication XML tags used in both exported 
and uploaded XML files. 

Patient Medication XML Tag 

2016 Tag 2015 Tag Comment 

<caremeddoc-rm-ticket> N/A New tag for 2016. 

2.2. Patient XML File 
The next table provides the changes to the Patient XML Tags used in both exported and 
uploaded XML files. 
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Patient XML Tag 

2016 Tag 2015 Tag Comment 

pcstatin-rm-ticket N/A New tag for 2016. 

pcdepression-rm-ticket N/A New tag for 2016. 

pcbloodpressure-rm-ticket N/A New tag for 2016. 

pctobaccouse-rm-ticket N/A New tag for 2016. 

pcbmiscreen-rm-ticket N/A New tag for 2016. 

pcpneumoshot-rm-ticket N/A New tag for 2016. 

pcflushot-rm-ticket N/A New tag for 2016. 

pccolorectal-rm-ticket N/A New tag for 2016. 

pcmammogram-rm-ticket N/A New tag for 2016. 

mh-rm-ticket N/A New tag for 2016. 

ivd-rm-ticket N/A New tag for 2016. 

htn-rm-ticket N/A New tag for 2016. 

hf-rm-ticket N/A New tag for 2016. 

dm-rm-ticket N/A New tag for 2016. 

cad-rm-ticket N/A New tag for 2016. 

carefalls-rm-ticket N/A New tag for 2016. 

pcstatin-rank N/A New tag for 2016. 

pcstatin-ascvd N/A New tag for 2016. 

pcstatin-ldlc N/A New tag for 2016. 

pcstatin-diabetes N/A New tag for 2016. 

pcstatin-ldlc-reading N/A New tag for 2016. 

pcstatin-prescribed N/A New tag for 2016. 

pcstatin-comments N/A New tag for 2016. 
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2.3. Patient Ranking XML File 
The next table provides the changes to Patient Ranking XML Tags used in exported XML files. 

Patient Ranking XML Tag 

2016 Tag 2015 Tag Comment 

<pcstatin-rank> N/A New tag for the patient’s rank in the PREV-13 
measure 

3. XML Schema Definitions (XSD) 
Depending on your browser version, you may need to perform additional steps to download the 
XSD files as text files. The XSD files may only be downloaded from the online version of this 
XML Specification; they are not downloadable from the PDF file. 

3.1. Download & Save XSD Files 
1. From the XSD files listed below, place your mouse over the desired file, right click, and 

select Save Target As....  

 

2. The Save As window appears. Specify a location to save the XSD File and click Save.  
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3.2. XSD Files 
The XSD files may only be downloaded from the online version of this XML Specification; they 
are not downloadable from the PDF file. 

Right click to download all the Sample XSD Files: XSD_Files_2016.zip 

The XSD Files 2016 zip file contains the following files: 

• WEB-INTERFACE-PATIENT.xsd file – For more information, see the topic on Patients 
XML. 

• WEB-INTERFACE-PATIENT-MEDICATION.xsd file – For more information, see the 
topic on Patient Medication XML. 

• WEB-INTERFACE-PATIENT-RANKING.xsd file – For more information, see the topic on 
Patient Ranking XML File. 

• WEB-INTERFACE-CLINIC.xsd file – For more information, see the topic on  Clinics 
XML. 

• WEB-INTERFACE-PROVIDER.xsd file – For more information, see the topic on 
Providers XML. 
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4. Sample Files 

4.1. Sample Header Files 
Examples of the XML files that can be exported from the GPRO Web Interface can be 
downloaded from the online help content. The sample header files may only be downloaded 
from the online version of this XML Specification; they are not downloadable from the PDF file. 
The files do not contain any Protected Health Information or Personally Identifiable Information. 
All Medicare IDs, Tax Identifications Numbers, National Provider Identifier contain test data and 
do not reflect real identifiers. 

For more information, see Patient XML File Header. 

For more information, see Patient Medications XML File Header. 

For a sample Patient XML Header File or a sample Patient Medications XML Header File, 
please refer to the online content. 

4.2. Sample XML Files 
Examples of the XML files are contained in the zip file. The sample XML files may only be 
downloaded from the online version of this XML Specification, they are not downloadable from 
the PDF file. The files do not contain any Protected Health Information or Personally Identifiable 
Information. All Medicare IDs, Tax Identifications Numbers, National Provider Identifier contain 
test data and do not reflect real identifiers. 

Right click to download all the Sample XML Files: XML Files 2016.zip 
 

The XML Files 2016 zip file contains the following files: 

• Clinics XML file - The WEB-INTERFACE-CLINIC.xsd file defines the format for the 
sample Clinics XML file. 

• Providers XML File - The WEB-INTERFACE-PROVIDER.xsd file defines the format for 
the sample Providers XML file. 

• Patient Ranking XML file - The WEB-INTERFACE-PATIENT-RANKING.xsd file defines 
the format for the sample Patient Ranking XML file. 

• Patients XML file - That contains only the data prepopulated in the database before the 
submission period starts. The WEB-INTEFACE-PATIENT.xsd file defines the format for 
either sample Patient XML file. 

• Patients Medications XML file - That contains only the data prepopulated in the 
databasebefore the submission period starts for patients ranked in CARE-3. The WEB-
INTERFACE-PATIENT-MEDICATIONS.xsd file defines the format for the sample Patient 
Medications XML file. 

For sample XSD files, please refer to the online content. 
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5. Patient Status and Rank 
The six disease modules, Coronary Artery Disease (CAD), Diabetes Mellitus (DM), Heart 
Failure (HF), Hypertension (HTN), Ischemic Vascular Disease (IVD), and Mental Health (MH) 
are collectively referred to as disease modules. The two individually sampled Care 
Coordination/Patient Safety measures (CARE-2 and CARE-3) are collectively referred to as 
CARE measures. The nine individually sampled Preventive Care measures (PREV-5, PREV-6, 
PREV-7, PREV-8, PREV-9, PREV-10, PREV-11, PREV-12, and PREV-13) are collectively 
referred to as PREV measures. The CARE measures and the PREV measures are referred to 
as Patient Care Measures. 

5.1. Patient Status 
The patient’s status in a disease module or patient care measure is set by the system and will 
have one of four values: 

• Complete 

• Incomplete 

• Skipped 

• Not Ranked 

The system will set the status for the patient based on the data that has been entered and 
saved in the GPRO Web Interface or a successful XML upload. The XML uploads for the 
Patients XML and the Patient Medications XML can cause the system to change the status to 
Complete, Incomplete, or Skipped based on the uploaded values. The Not Ranked status is 
set at the time the data is loaded and cannot be changed. 

5.1.1. Marking a Patient as Complete 
The Medical Record Found value must be provided for all patients. The system will mark a 
patient as Complete when the Medical Record Found value is Yes, and the other required 
information is provided. 

For the CAD (see Coronary Artery Disease), DM (see Diabetes Mellitus), HF (see Heart 
Failure), HTN (see Hypertension), IVD (see Ischemic Vascular Disease), and MH (see Mental 
Health) disease modules, in addition to the Medical Record Found value, the other required 
information needed for the system to mark a patient as Complete in a module includes 
confirmation of the diagnosis and all required quality measure components. The information on 
the disease confirmation and required quality measure components is detailed in the referenced 
sections. 

For the CARE measures (see CARE and CARE-3) and the PREV measures (see Preventive 
Care), in addition to the Medical Record Found value, the other required information needed 
for the system to mark a patient as Complete in the measure includes confirmation that the 
patient is qualified for the measure and all required measure components. The information on 
the measure confirmation and required measure components is detailed in the referenced 
sections. 
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The required measure components for the disease modules, individually sampled CARE 
measures, or PREV measures are detailed in the sections for the measures below. 

5.1.2. Marking a Patient as Incomplete 
The system will mark a patient as Incomplete in a disease module, CARE measure, or PREV 
measure for one of the following reasons: 

• The default status for a patient ranked in a disease module, CARE measure, or 
individually sampled PREV measure is Incomplete. 

• Patient is ranked in a disease module, CARE measure, or PREV measure and a value 
has not been provided for Medical Record Found. 

• Patient is ranked in a disease module, CARE measure, or PREV measure, Medical 
Record Found is set to Yes, but required confirmation and/or quality measure 
components do not have a value. 

5.1.3. Marking a Patient as Skipped 

5.1.3.1. Skipping the Patient in All Modules 

The Medical Record Found value must be provided for all patients. The system will mark a 
patient as Skipped in all modules in which the patient is ranked when the Medical Record 
Found value is set to one of the valid skip reasons, and the other required information is 
provided. 

A patient may be skipped in all disease modules, CARE measures, or PREV measures in which 
they are ranked for the following reasons: 

• Patient medical record is not found 

• Patient is deceased 

• Patient is in hospice 

• Patient moved out of the country 

• Patient was enrolled in a Health Maintenance Organization (HMO) during the 
measurement period 

If the medical record was not found, the patient will be skipped in all disease modules, CARE 
measures, or individually sampled PREV measures in which they are ranked. When setting the 
value for Medical Record Found to Medical Record Not Found, no other values are required 
for the system to set the patient to Skipped.  

If the medical record was found, but the patient is not qualified for the sample because they are 
deceased, in hospice, moved out of the country, or enrolled in an HMO, the patient will be 
skipped in all disease modules or patient care measures in which they are ranked. When setting 
the value for Medical Record Found to Not Qualified for Sample, the reason the patient is not 
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qualified for the sample and the date they became ineligible are required for the system to set 
the patient to Skipped. 

5.1.3.2. Skipping the Patient in Individuals Modules 

After setting the Medical Record Found to Yes, a patient may be skipped in an individual 
disease module, CARE measure, or PREV measure in which they are ranked for the following 
reasons: 

• Patient diagnosis not confirmed by patient records. 

• Denominator Exclusions (HTN, MH, PREV-5, PREV-6, PREV-9, PREV-11, and PREV-
12). 

• Other CMS approved reason (Allowed on a case by case basis. This option may only be 
selected when an approval has been received from CMS in the form of a response to a 
QualityNet Help Desk inquiry.). 

• If the medical record was found, but the diagnosis is not confirmed by the patient 
records, the patient meets the denominator exclusion criteria, or the patient is not 
qualified for other CMS approved reasons, the system will set the patient to Skipped 
only in the disease or measure modules where the skip reason is set. The Medical 
Record Found must be set to Yes, and the skip reason must be set in the confirmation 
of the disease module, CARE measure, or PREV measure. 

If the group must skip one or more patients in a disease module or an individually sampled 
CARE or PREV measure, then they are required to complete the data for an equal number of 
additional, consecutively ranked patients within the disease module, CARE measure, or PREV 
measure. A PQRS group practice or an ACO must report on 248 consecutively confirmed and 
completed patients, unless the sample of eligible patients is exhausted. 

5.1.3.3. Automatic Skip Reasons 

A patient may be automatically marked as Skipped by the system based on values input for the 
patient. 

• If the Medical Record Found is set to Yes and the patient is ranked in PREV-5, the 
patient’s gender is changed on the Demographics screen of the GPRO Web Interface, 
and the resulting gender due to the change makes the patient ineligible for PREV-5, the 
system will automatically mark the patient as Skipped. The system will automatically set 
the PREV-5 Confirmed value to Not Confirmed – Gender. 

• If Medical Record Found is set to Yes and the patient’s date of birth is changed on the 
Demographics screen of the GPRO Web Interface and the resulting age due to the 
change makes them ineligible for modules in which they are ranked, the system will 
automatically mark the patient as Skipped in the appropriate disease or measure 
module. The system will automatically set the confirmed value for the module to Not 
Confirmed – Age.  

• If Medical Record Found is set to Yes and all responses for Patient Seen on This 
Date in the visit confirmation table of CARE-3 are set to No - Visit Outside Practice, 
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the system will automatically mark the patient as skipped for CARE-3 Documentation 
of Current Medications in the Medical Record. The system will automatically set the 
confirmed value for the module to Not Confirmed – No Qualifying Visits.  

• If Medical Record Found is set to Yes, CAD Confirmed to Yes, and Has Diabetes or 
LVSD is set to No in CAD-7, the system will automatically mark the patient as skipped 
for CAD. The system will automatically set the confirmed value to Not Confirmed – 
Additional Denominator Criteria. 

• If Medical Record Found is set to Yes, HF Confirmed to Yes, and Has LVSD is set to 
No in HF-6, the system will automatically mark the patient as skipped for HF. The 
system will automatically set the confirmed value to Not Confirmed – Additional 
Denominator Criteria. 

• If Medical Record Found is set to Yes, MH Confirmed to Yes and PHQ-9 Test 
Performed? is set to No, the system will automatically mark the patient as skipped for 
MH. The system will automatically set the confirmed value to Not Confirmed – 
Additional Denominator Criteria. 

• Medical Record Found is set to Yes, MH Confirmed to Yes and PHQ-9 Test 
Performed? is set to Yes but the PHQ-9 Index Test > 9 is set to No, the system will 
automatically mark the patient as skipped for MH. The system will automatically set the 
confirmed value to Not Confirmed – Additional Denominator Criteria. 

5.1.3.4. Automatic Skip Processing 

• The XML values for the automatic skips are available in exported XML files to provide a 
complete record of the patient’s data. 

• If the new values for the automatic skip reasons are included in an uploaded XML file, 
the file will pass format validation, but the value will be ignored and the confirmation 
associated with the value will not be set to the automatic skip reason. The automatic skip 
reasons may only be set by the system based on input values for date of birth, gender, 
visit confirmation, CAD, HF, or MH measures. 

• The automatic skip reasons for gender, age, visit confirmation, CAD, HF, or MH may not 
be overwritten in an XML upload once the system has set the value. 

5.1.4. Marking a Patient as Not Ranked 
The system will mark a patient as Not Ranked when they are not selected for the disease or 
measure module sample. The Not Ranked status is set by the system during the initial data 
load and cannot be changed during the submission period. 

5.2. Disease Module or Patient Care Measure Rank 
The patient’s rank in a disease module, CARE measure, or PREV measure provides the 
patient’s assigned order in the module or patient care measure and is provided in the exported 
files for information only. The rank cannot be changed from the value assigned to the patient 
during the patient sampling. If the patient has not been selected for the disease module sample, 
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CARE measure sample, or PREV measure sample, the associated rank will not be included in 
the XML files exported from the GPRO Web Interface. 

The rank is included in the exported Patient XML file to assist in determining which patients are 
necessary to complete in order to meet the 248 consecutively confirmed and completed patients 
for a PQRS group practice or ACO.  

The patient’s rank is not required in the XML files to be uploaded. If the rank is included in the 
file, the XML element for the rank and associated rank value will be ignored. 

The tags for all the disease modules or patient care measures are listed in the following table. 
When used in an XML file, the tags for the disease module, CARE measure, or PREV measure 
must be used in the order specified in Appendix A – XML Elements for Patients XML File. 

The table below shows the available values and XML format for the Disease Module or CARE 
or PREV Measure Ranks. 

Available 
Values 

Sample XML Tag Other Parameters 

1 – 616 <caremeddoc-rank>12<caremeddoc-
rank> 

Ignored on Upload, provided for 
information on Export. 

1 – 616 <carefalls-rank>68</carefalls-rank> Ignored on Upload, provided for 
information on Export. 

1 – 616 <cad-rank>221</cad-rank> Ignored on Upload, provided for 
information on Export. 

1 – 616 <dm-rank>221</dm-rank> Ignored on Upload, provided for 
information on Export. 

1 – 616 <hf-rank>221</hf-rank> Ignored on Upload, provided for 
information on Export. 

1 – 616 <htn-rank>221</htn-rank> Ignored on Upload, provided for 
information on Export. 

1 – 616 <ivd-rank>15</ivd-rank> Ignored on Upload, provided for 
information on Export. 

1 - 616 <mh-rank>45</mh-rank> Ignored on Upload, provided for 
information on Export. 

1 – 616 <pcmammogram-
rank>499</pcmammogram-rank> 

Ignored on Upload, provided for 
information on Export. 

1 – 616 <pccolorectal-rank>6</pccolorectal-rank> Ignored on Upload, provided for 
information on Export. 
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Available 
Values 

Sample XML Tag Other Parameters 

1 – 616 <pcflushot-rank>482</pcflushot-rank> Ignored on Upload, provided for 
information on Export. 

1 – 616 <pcpneumoshot-rank>12</pcpneumoshot-
rank> 

Ignored on Upload, provided for 
information on Export. 

1 – 616 <pcbmiscreen-rank>99</pcbmiscreen-
rank> 

Ignored on Upload, provided for 
information on Export. 

1 – 616 <pctobaccouse-rank>110</pctobaccouse-
rank> 

Ignored on Upload, provided for 
information on Export. 

1 – 616 <pcbloodpressure-
rank>616</pcbloodpressure-rank> 

Ignored on Upload, provided for 
information on Export. 

1 – 616 <pcdepression-rank>616</pcdepression-
rank> 

Ignored on Upload, provided for 
information on Export. 

1 – 750 <pcstatin-rank>750</pcstatin-rank> Ignored on Upload, provided for 
information on Export. 

6. File Processing 
In this topic, learn about the following: 

XML Element Processing 

XML Element Order 

6.1. XML Element Processing 
Only the XML elements for the disease modules or patient care measures in which the patient is 
ranked should be used. Using an element for a disease module, CARE measure, or PREV 
measure in which the patient is not ranked will not generate a format validation error, but the 
data in the XML file for that element will not be stored in the database. 

Any value uploaded in the XML file will overwrite existing values in the database. 

If an XML element is included in the file, but the element is an empty tag, the tag will not be 
processed, and data associated with the tag will not be updated in the database. 

Inclusion of XML elements for fields that do not require a tag is optional. All required data must 
be provided for satisfactory reporting, but the data does not need to be provided in a single XML 
file. This allows for flexibility when creating the XML files. Examples of options include: 

• Uploading data using one XML file per disease module, CARE measure, or PREV 
measure. 
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• Uploading data using one XML file per measure component, such as the blood pressure 
date taken. 

• Uploading only data available in the electronic health record system in an XML file. 

6.2. XML Element Order 
If an optional XML element is included in the file, the elements must be listed in the specified 
order. Failure to include the XML elements in the order specified will prevent the file from being 
processed. 

Appendix A – XML Elements for Patients XML File, lists all possible XML elements, along with 
the allowable values for each element, in the Patient file in the required order. 

Appendix B – XML Elements for Patient Medications XML File, lists all possible XML elements, 
along with the allowable values for each element, in the Patient Medications file in the required 
order 

7. XML Specifications 
The measurement period for the 2016 Program Year is from 01/01/2016 through 12/31/2016, 
unless otherwise indicated for a specific measure. 

The GPRO Web Interface enables exporting data for five types of files: 

1. Patient Ranking 

2. Patients 

3. Patient Medications 

4. Clinics 

5. Providers 

The Patients XML and Patient Medications XML files may also be uploaded to update the 
patient’s data. Patients XML files and Patient Medications XML file that are to be uploaded into 
the GPRO Web Interface that contain Byte Order Mark (BOM) will be rejected, so it is 
imperative that an editor that allows saving the file without BOM is used. 

Dates specified throughout the document are in the format of MM/DD/YYYY. Months and dates 
containing a single digit may be entered with or without a leading zero (0). For example, July 4, 
2015 may be entered as 07/04/2015 or as 7/4/2015. 
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7.1. Patient Ranking XML 
The Patient Ranking XML file is used to export a group’s patients whose data is reported in the 
Patient XML and the Patient Medications XML. The information in the file cannot be updated by 
uploading a file. When exporting the data, the GPRO Web Interface allows the selection of one 
or more disease modules or measure modules on the Export Data page. 

The XML file generated by the GPRO Web Interface will only include the patients ranked in the 
selected disease modules or measure modules. An option is provided to allow the patient data 
to be exported in one of two ways. 

1. Export only selected disease module or measure module data for the patient. If a patient 
is ranked in multiple modules, only the XML rank elements associated with the selected 
modules will be included for that patient. If a patient is ranked in a module that has been 
selected and is also ranked in a module that has not been selected, the rank for the 
unselected module will not be included in the file. This option prevents duplicate data for 
a patient when data is exported one module at a time. 

2. Export all module ranks for the patient. If a patient is ranked in multiple modules, all XML 
rank elements for any module in which the patient is ranked will be included for the 
patient. If a patient is ranked in a module that has been selected and is also ranked in a 
module that has not been selected, the rank for the unselected modules will also be 
included in the file. This option allows exporting all ranks for all modules for a patient 
when rank is exported one module at a time. 

The opening <patient> element and closing </patient> element are repeated for each patient. 
The demographics data will be included for each patient, and the module rank XML element will 
be included for each selected module in which the patient is ranked. 

The table below shows all the Patient Ranking XML elements and associated data. 

XML 
Element Description Data 

Type 
Field 
Size Valid Values 

N/A XML Declaration String 38 <?xml version=”1.0” 
encoding=”UTF-8”?> 

<web-
interface-
export> 

Opening tag for data String 200 <web-interface-export 
xmlns:xsi=”http://www.w3.
org/2001/XMLSchema-
instance” 
xmlns:noNamespaceSche
maLocation=”WEB-
INTERFACE-PATIENT-
RANKING.xsd” 
xmlns=”gov/cms/pqrs/patie
ntRanking/v1”> 
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XML 
Element Description Data 

Type 
Field 
Size Valid Values 

<group-tin> ACO: Primary Taxpayer 
Identification Number 

PQRS group practice: Taxpayer 
Identification Number 

String 9 Number 

<patient> Opening tag for the patient data, 
repeats for each patient in the file. 

N/A N/A N/A 

<medicare-
id> 

Medicare HIC number – unique 
identifier for the patient. 

String 15 Character 

<patient-
first-name> 

First name of the patient String 25 Character 

<patient-last-
name> 

Last name of the patient String 20 Character 

<gender> Indicator for the gender of the 
patient 

String 1 1 = Male 

2 = Female 

3 = Unknown 

<birth-date> Birth date of the patient String 10 MM/DD/YYYY 

<provider-
npi> 

Provider’s NPI String 10 Number 

<provider-
first-name> 

First name of a provider String 30 Character 

<provider-
last-name> 

Last name of a provider String 30 Character 

<provider-
npi-two> 

Provider’s NPI String 10 Number 

<provider-
two-first-
name> 

First name of a provider String 30 Character 

<provider-
two-last-
name> 

Last name of a provider String 30 Character 

<provider-
npi-three> 

Provider’s NPI String 10 Number 
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XML 
Element Description Data 

Type 
Field 
Size Valid Values 

<provider-
three-first-
name> 

First name of a provider String 30 Character 

<provider-
three-last-
name> 

Last name of a provider String 30 Character 

<clinic-
identifier> 

Identifier associated with the clinic 

ACO: The identifier may be a 
participating TIN, a CMS 
Certification Number (CCN), or a 
user entered identifier. This will be 
the top TIN for the patient. 

PQRS group practices: The TIN or 
user entered identifier. 

String 9 Number 

<caremeddo
c-rank> 

Patient’s rank within the CARE-3 
measure 

This element is only used if the 
patient has been selected for the 
CARE-3 sample. 

String 3 1 – 616 

<carefalls-
rank> 

Patient’s rank within the CARE-2 
measure 

This element is only used if the 
patient has been selected for the 
CARE-2 sample. 

String 3 1 – 616 

<cad-rank> Patient’s rank within the CAD 
module 

This element is only used if the 
patient has been selected for the 
CAD sample. 

String 3 1 – 616 

<dm-rank> Patient’s rank within the DM 
module 

This element is only used if the 
patient has been selected for the 
DM sample. 

String 3 1 – 616 
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XML 
Element Description Data 

Type 
Field 
Size Valid Values 

<hf-rank> Patient’s rank within the HF 
module 

This element is only used if the 
patient has been selected for the 
HF sample. 

String 3 1 – 616 

<htn-rank> Patient’s rank within the HTN 
module 

This element is only used if the 
patient has been selected for the 
HTN sample. 

String 3 1 – 616 

<ivd-rank> Patient’s rank within the IVD 
module 

This element is only used if the 
patient has been selected for the 
IVD sample. 

String 3 1 – 616 

<mh-rank> Patient’s rank within the MH 
module 

This element is only used if the 
patient has been selected for the 
MH sample. 

String 3 1 – 616 

<pcmammog
ram-rank> 

Patient’s rank within the PREV-5 
measure 

This element is only used if the 
patient has been selected for the 
PREV-5 sample. 

String 3 1 – 616 

<pccolorecta
l-rank> 

Patient’s rank within the PREV-6 
measure 

This element is only used if the 
patient has been selected for the 
PREV-6 sample. 

String 3 1 – 616 

<pcflushot-
rank> 

Patient’s rank within the PREV-7 
measure 

This element is only used if the 
patient has been selected for the 
PREV-7 sample. 

String 3 1 – 616 
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XML 
Element Description Data 

Type 
Field 
Size Valid Values 

<pcpneumos
hot-rank> 

Patient’s rank within the PREV-8 
measure 

This element is only used if the 
patient has been selected for the 
PREV-8 sample. 

String 3 1 – 616 

<pcbmiscree
n-rank> 

Patient’s rank within the PREV-9 
measure 

This element is only used if the 
patient has been selected for the 
PREV-9 sample. 

String 3 1 – 616 

<pctobaccou
se-rank> 

Patient’s rank within the PREV-10 
measure 

This element is only used if the 
patient has been selected for the 
PREV-10 sample. 

String 3 1 – 616 

<pcbloodpre
ssure-rank> 

Patient’s rank within the PREV-11 
measure 

This element is only used if the 
patient has been selected for the 
PREV-11 sample. 

String 3 1 – 616 

<pcdepressi
on-rank> 

Patient’s rank within the PREV-12 
measure 

This element is only used if the 
patient has been selected for the 
PREV-12 sample. 

String 3 1 – 616 

<pcstatin-
rank> 

Patient’s rank within the PREV-13 
measure 

This element is only used if the 
patient has been selected for the 
PREV-13 sample. 

String 3 1 – 750 

</web-
interface-
export> 

Closing tag for data N/A N/A N/A 

7.2. Patients XML 
The Patients XML can be used to export all currently stored data for the patients or to update 
the patient data by uploading an XML file. The Patients XML contains the patient’s demographic 
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information and all disease module, CARE measure (CARE-2), or PREV measure data. The 
CARE-3 Medication Reconciliation quality measure data is in the Patient Medications XML file. 

When exporting the data for the Patients XML, the GPRO Web Interface allows the selection of 
one or more disease modules or patient care measures on the Export Data page. If a patient is 
ranked in a disease module, CARE measure, or PREV measure, but data has not been stored 
in the database for the associated XML elements, the elements will be included, but the element 
will be an empty tag. 

In total, the Patients XML file has 16 modules/patient care measures which have XML data: 
seven disease modules, and nine Preventive Care measures: 

• Care Coordination/Patient Safety (CARE) 

• Coronary Artery Disease (CAD) 

• Diabetes Mellitus (DM) 

• Heart Failure (HF) 

• Hypertension (HTN) 

• Ischemic Vascular Disease (IVD) 

• Mental Health (MH) 

• Breast Cancer Screening (PREV-5) 

• Colorectal Cancer Screening (PREV-6) 

• Preventive Care and Screening: Influenza Immunization (PREV-7) 

• Pneumonia Vaccination Status for Older Adults (PREV-8) 

• Preventive Care and Screening: Body Mass Index (BMI) Screening and Follow-Up Plan 
(PREV-9) 

• Preventive Care and Screening: Tobacco Use: Screening and Cessation Intervention 
(PREV-10) 

• Preventive Care and Screening: Screening for High Blood Pressure and Follow-Up 
Documented (PREV-11) 

• Preventive Care and Screening: Screening for Clinical Depression and Follow-Up Plan 
(PREV-12) 

• Statin Therapy for the Prevention and Treatment of Cardiovascular Disease (PREV-13) 

The XML file generated by the GPRO Web Interface will only include the patients ranked in the 
selected module or measure. An option is provided to allow the patient data to be exported in 
one of two ways. 
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1. Export only selected module or patient care measure data for the patient. If a patient is 
ranked in multiple modules or patient care measures, only the XML data elements 
associated with the selected modules or patient care measures will be included for that 
patient. If a patient is ranked in a module or measure that has been selected and is also 
ranked in a module or patient care measure that has not been selected, the data for the 
unselected module or patient care measure will not be included in the file. This option 
prevents duplicate data for a patient when data is exported one module or patient care 
measure at a time. 

2. Export all module or measure data for the patient. If a patient is ranked in multiple 
modules or patient care measures, all XML data elements for any module or patient care 
measure in which the patient is ranked will be included for the patient. If a patient is 
ranked in a module or patient care measure that has been selected and is also ranked in 
a module or patient care measure that has not been selected, the data for the 
unselected modules or patient care measures will also be included in the file. This option 
allows exporting all data for all modules or patient care measures for a patient when data 
is exported one module or patient care measure at a time. 

Note that CARE-3 data will not be included in the Patients XML file when using either of 
the export options. All CARE-3 data must be exported in the Patient Medications XML 
file. 

7.2.1. XML Declaration and Submission Header 
The XML Declaration must meet the following three requirements or the file will be rejected as 
an invalid file: 

1. The XML Declaration must be on the first line. 

2. The XML Declaration may not contain any other XML elements. 

3. The XML Declaration must be an exact match for the valid value specified in Appendix A 
– XML Elements for Patients XML File. 

A Submission Header is required at the beginning of each Patients XML file. The opening tag 
for the Submission Header must be the first XML element in the file, and the closing tag for the 
submission header must be the last XML element in the file. The submission opening element 
<web-interface-submission> and submission closing element </web-interface-submission> may 
only occur once in the file, and all submission data must be between the opening and closing 
elements. The data in the opening submission element should match the text exactly or the file 
will be rejected for invalid format. 

7.2.2. Group Identification 
The Group Identification indicates the start of the patient data and includes the Primary 
Taxpayer Identification Number for ACOs or the Taxpayer Identification Number for PQRS 
group practice. All data for the patients in the group must follow the identification number and 
must be included between the opening <web-interface> element and the closing </web-
interface> element. 
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ACOs: The Primary Taxpayer Identification Number in the file must match the Primary Taxpayer 
Identification Number associated to the identity management account of the user submitting the 
file. 

PQRS group practices: The Taxpayer Identification Number in the file must match the Taxpayer 
Identification Number associated to the identity management account of the user submitting the 
file. 

The opening <patient> element and the closing </patient> element are used for each patient in 
the file. All data for each patient must be between an opening <patient> and closing </patient> 
element, but the <patient> elements may be repeated as often as necessary for additional 
patients. 

The <web-interface>, </web-interface>, <patient>, and </patient> tags are opening and closing 
tags and do not contain data. 

The table below shows the appropriate XML format with a sample TIN for the Group 
Identification TIN. The TIN in the sample must be changed to your TIN in order to upload the 
XML file. 

Available Values Sample XML Tag Other Parameters 

Character <group-tin>0000000000</group-tin> Include XML elements for patient data. 

7.2.3. Patient Demographics 
Patient Demographics is provided on export to aid in locating the patient’s medical record. 

The Medicare ID is the unique identifier for the patient, so it is required for each patient. The 
Medicare ID may only be used once for each patient in a Patients XML file. 

The Medical Record Number, Other Identifier, National Provider Identifiers (NPIs), Clinic 
Identifier, and General Comments may be provided to update the existing information or to 
provide additional information not available during the patient sampling. 

The patient’s First Name, Last Name, Gender, and Date of Birth cannot be updated using XML 
uploads. These values may only be modified using the GPRO Web Interface. 

The Patient Demographics XML includes elements for: 

• Medicare ID 

• Patient First Name 

• Patient Last Name 

• Patient Gender 

• Patient Birth Date 

• Medical Record Number 



XML Specifications 

GPRO Web Interface XML Specification V1.0 25 PQRS PY2016 

• Other Identifier 

• National Provider Identifiers (NPIs) 

• Clinic Identifier 

• General Comments 

7.2.3.1. Medicare ID 

The Medicare ID must be provided in the patient data. The Medicare ID may only be used once 
per patient in the Patients XML file. If the Medicare ID is not in the database for the ACO’s 
Primary Taxpayer Identification Number or the PQRS group practice's Taxpayer Identification 
Number provided in the XML file, the file will pass format validation, but the data associated to 
the invalid Medicare ID will not be processed. The Medicare ID is the unique identifier for the 
patient and as such is the primary key. 

The table below shows the appropriate XML format with a sample Medicare ID for the Medicare 
ID. 

Available 
Values 

Sample XML Tag Other Parameters 

Character <medicare-
id>000000000Z</medicare-id> 

Include XML elements for the disease module 
or patient care measure in which the patient is 
ranked. 

7.2.3.2. Patient First Name 

The patient’s First Name as it appears in CMS’ records during the sampling process will be pre-
populated during the initial load of patient data. The XML element containing the First Name will 
be provided when exporting the patient data, but does not need to be provided in the XML 
upload. If the XML element for the First Name is used, the tag will be ignored and the patient’s 
First Name will not be updated. 

The table below shows the appropriate XML format with a sample name for the First Name. 

Available Values Sample XML Tag Other Parameters 

Character <patient-first-name>First</patient-first-name> None, Export Only 

7.2.3.3. Patient Last Name 

The patient’s Last Name as it appears in CMS’ records during the sampling process will be pre-
populated during the initial load of patient data. The XML element containing the Last Name will 
be provided when exporting the patient data, but does not need to be provided in the XML 
upload. If the XML element for the Last Name is used, the tag will be ignored and the patient’s 
Last Name will not be updated. 
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The table below shows the appropriate XML format with a sample name for the Last Name. 

Available Values Sample XML Tag Other Parameters 

Character <patient-last-name>Last</patient-last-name> None, Export Only 

7.2.3.4. Patient Gender 

The patient’s Gender as it appears in CMS’ records during the sampling process will be pre-
populated during the initial load of patient data. The XML element containing the Gender will be 
provided when exporting the patient data, but does not need to be provided in the XML upload. 
If the XML element for the Gender is used, the tag will be ignored and the patient’s Gender will 
not be updated. 

The table below shows the available values and appropriate XML format for the Gender. 

Available Values Sample XML Tag Other Parameters 

1 = Male <gender>1</gender> None, Export Only 

2 = Female <gender>2</gender> None, Export Only 

3 = Unknown <gender>3</gender> None, Export Only 

7.2.3.5. Patient Birth Date 

The patient’s Birth Date as it appears in CMS’ records during the sampling process will be pre-
populated during the initial load of patient data. The XML element containing the Birth Date will 
be provided when exporting the patient data, but does not need to be provided in the XML 
upload. If the XML element for the Birth Date is used, the tag will be ignored and the patient’s 
Birth Date will not be updated. 

The table below shows the appropriate XML format for the Birth Date. 

Available Values Sample XML Tag Other 
Parameters 

Valid date between 01/01/1900 and 
6/30/[current program year] 

<birth-date>10/15/1935</birth-
date> 

None, Export 
Only 

7.2.3.6. Medical Record Number 

The Medical Record Number will not be pre-populated during the sampling process. The value 
may be added during the submission period. The Medical Record Number may be any value 
used by the group to identify the patient. 

The table below shows the appropriate XML format for the Medical Record Number. 
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Available 
Values 

Sample XML Tag Other 
Parameters 

Character <medical-record-number>123XYZ</medical-record-
number> 

None 

7.2.3.7. Other Identifier 

The Other Identifier will not be pre-populated during the sampling process. The value may be 
added during the submission period. The Other Identifier may be any value used by the group 
to identify the patient. 

The table below shows the appropriate XML format for the Other Identifier. 

Available Values Sample XML Tag Other Parameters 

Character <other-id>A0001</other-id> None 

7.2.3.8. Provider NPIs 

Up to three Provider NPIs (National Provider Identifiers) may be pre-populated during the 
sampling process. NPIs may be updated during the submission period. The NPI in the XML file 
must currently exist in the database. The list of existing NPIs may be obtained by exporting the 
Provider XML file or the list may be viewed on the GPRO Web Interface. If the NPI does not 
exist in the group, the XML file will pass format validation, but the patient’s NPI data will not be 
updated and an error message will be generated. 

The table below shows the appropriate XML format for the Provider NPIs. 

Available Values Sample XML Tag Other Parameters 

Numeric <provider-npi>1111111111</provider-npi> None 

Numeric <provider-npi-two>2222222222</provider-npi-two> None 

Numeric <provider-npi-three>3333333333</provider-npi-three> None 

7.2.3.9. Clinic Identifier 

The Clinic Identifier will be pre-populated during the sampling process with the TIN for PQRS 
group practices. The Clinic Identifier will be pre-populated during the sampling process with 
the Participating TIN or the CMS Certification Number (CCN) for ACOs. The Clinic Identifier for 
the patient may be updated during the submission period. The Clinic Identifier in the XML file 
must currently exist in the database. The list of existing Clinic Identifiers may be obtained by 
exporting the Clinic XML file. If the Clinic Identifier does not exist in the group, the XML file will 
pass format validation, but the patient’s Clinic Identifier data will not be updated and an error 
message will be generated. 
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The table below shows the appropriate XML format for the Clinic Identifier. 

Available Values Sample XML Tag Other Parameters 

Numeric <clinic-identifier>45226</clinic-identifier> None 

7.2.3.10. General Comments 

The General Comments will not be pre-populated during the sampling process. The text is 
optional and may be added during the submission period. 

The table below shows the appropriate XML format for the General Comments. 

Available Values Sample XML Tag Other 
Parameters 

Text up to 140 
characters 

<general-comments>Text for general 
comments</general-comments> 

None 

7.2.4. Medical Record Found 
The Medical Record Found and if the patient is Not Qualified for Sample due to patient In 
Hospice, Moved out of Country, Deceased, or HMO Enrollment, the Reason and Date they 
were no longer qualified, is answered only once per patient. Medical Record Found contains 
three types of information: 

• Medical Record Found 

• Reason a patient is not qualified for the sample, if not qualified 

• Date the patient became ineligible for the sample, if not qualified 

The Medical Record Found value must be provided for all patients in order to mark the patient 
as either skipped or complete. 

If the patient is ranked in CARE-3, the values for the Medical Record Found, Reason and 
Date may also be set in the Patient Medications XML file. If the patient is ranked in any disease 
module, CARE measure, or PREV measure other than CARE-3, the values for the Medical 
Record Found, Reason and Date are set in the Patients XML file. It should be noted that the 
values should be the same for a patient ranked in both CARE-3 and any other disease module, 
CARE measure, or PREV measure if used in both files. If the values are different, the value in 
the last uploaded file will overwrite any previous values. 

7.2.4.1. Confirm Medical Record Found 

Determine if you are able to find the patient’s medical record. If the Medical Record Found is 
set to Yes, data must be provided for all required measures for the disease modules or patient 
care measures in which the patient is ranked. In addition to setting the Medical Record Found 
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value, confirmation that the patient is qualified for the disease modules or patient care measures 
must be provided. 

If the medical record was not found for the patient, the patient will be skipped in all disease 
modules or patient care measures in which the patient is ranked. When the Medical Record 
Found is set to Medical Record Not Found, abstraction is complete for this patient and no 
other XML elements should be provided for this patient. 

If the medical record was found, but the patient is not qualified for the sample because they are 
in hospice, moved out of the country, are deceased, or enrolled in an HMO, the patient will be 
skipped in all disease modules or patient care measures in which the patient is ranked. The 
reason the patient is not qualified for the sample and the date they became ineligible must be 
provided. When the Medical Record Found is set to Not Qualified for Sample, and the 
Reason and Date have been provided, abstraction is complete for this patient and no other 
XML elements should be provided for this patient. 

The table below shows the available values and appropriate XML tags for Medical Record 
Found. 

Available 
Values 

Sample XML Tag Other Parameters 

2 = Yes <medical-record-
found>2</medical-record-
found> 

Include required confirmation and required measure 
elements for all disease modules, CARE measures, 
or PREV measures in which the patient is ranked to 
complete the patient’s data. 

Do not include Medical Record Found Reason 
value and Medical Record Found Date value. 

3 = Medical 
Record Not 
Found 

<medical-record-
found>3</medical-record-
found> 

Do not include Medical Record Found Reason 
value and Medical Record Found Date value or 
measure elements for this patient. 

Patient is skipped in all disease modules, CARE 
measures, or PREV measures in which the patient 
is ranked. 

9 = Not 
Qualified for 
Sample 

<medical-record-
found>9</medical-record-
found> 

Include Medical Record Found Reason value and 
Medical Record Found Date value 

Do not include measure elements for this patient. 

Patient is skipped in all disease modules, CARE 
measures, or PREV measures in which the patient 
is ranked. 

7.2.4.2. Provide the Reason the Patient is Not Qualified for Sample 

If the Medical Record Found value is set to Not Qualified for Sample, the reason must be 
provided for the patient to be marked as skipped. 
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The table below shows the available values and appropriate XML format for the Not Qualified 
for Sample reasons. 

Available 
Values 

Sample XML Tag Other Parameters 

10 = In 
Hospice 

<medical-not-qualified-
reason>10</medical-not-qualified-
reason> 

Include the Medical Record Found value 
and Medical Record Found Date value. 

Patient is skipped in all disease modules, 
CARE measures, or PREV measures in 
which the patient is ranked. 

11 = Moved out 
of Country 

<medical-not-qualified-
reason>11</medical-not-qualified-
reason> 

Include the Medical Record Found value 
and Medical Record Found Date value. 

Patient is skipped in all disease modules, 
CARE measures, or PREV measures in 
which the patient is ranked. 

12 = Deceased <medical-not-qualified-
reason>12</medical-not-qualified-
reason> 

Include the Medical Record Found value 
and Medical Record Found Date value. 

Patient is skipped in all disease modules, 
CARE measures, or PREV measures in 
which the patient is ranked. 

16 = HMO 
Enrollment 

<medical-not-qualified-
reason>16</medical-not-qualified-
reason> 

Include the Medical Record Found value 
and Medical Record Found Date value. 

Patient is skipped in all disease modules, 
CARE measures, or PREV measures in 
which the patient is ranked. 

7.2.4.3. Provide the Date the Patient Became Ineligible for the Sample 

If the patient is not qualified for the sample and the reason is in hospice, moved out of the 
country, or deceased, the date must be provided for the patient to be marked as skipped. Enter 
the date in MM/DD/YYYY format the patient became ineligible for the sample during the 
measurement period (if date unknown enter 12/31/[current program year]). 

The table below shows the available values and appropriate XML format for the Not Qualified 
for Sample date. 
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Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/[current program 
year] and 12/31/[current 
program year] 

<medical-not-qualified-
date>12/01/2015</medical-not-
qualified-date> 

Include the Medical Record 
Found value and Medical 
Record Found Reason value. 

Patient is skipped in all 
disease modules, CARE 
measures, or PREV measures 
in which the patient is ranked. 

7.2.5. Care Coordination/Patient Safety (CARE) 
There are two, separately sampled Care Coordination/Patient Safety measures: CARE-2: Falls: 
Screening for Future Fall Risks, and CARE-3: Documentation of Current Medications in the 
Medical Record. The XML elements for CARE-2 appear in the Patient XML, and the XML 
elements for CARE-3 appear in the Patient Medications XML. 

The Patients XML CARE measures include elements for: 

• CARE-2: Falls 

• CARE-2 Confirmation 

• CARE-2 Help Desk Ticket # 

• CARE-2 Screening for Future Fall Risk 

• CARE-2 Comments 

Additional details and codes for the measure confirmation and the individual measures can be 
found here: (https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-
Instruments/PQRS/GPRO_Web_Interface.html) 

7.2.5.1. CARE-2: Falls 

Two values for abstraction are included in the CARE-2 measure: 

• Confirmation that the patient is qualified for the CARE-2 measure (CARE-2 
Confirmation) 

• Indicator if the screening was performed if the patient is qualified (CARE-2: Screening 
for Future Fall Risk) 

Not all values may be required for the CARE-2 measure to be marked complete. Confirmation 
that the patient is qualified for the measure must be provided. If the patient is qualified for the 
measure, all required values for the CARE-2 measure must be provided before the system can 
mark the patient as complete in the CARE-2 measure. If the patient is not qualified for the 
measure, the patient is skipped in the measure and the measure data should not be provided. 

https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
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7.2.5.2. CARE-2 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the CARE-2 measure is required. If the patient is qualified for the 
measure, all required values for the CARE-2 measure must be provided before the system can 
mark the patient as Complete in the CARE-2 measure module. 

CARE-2 Confirmation provides a way to skip the patient in the CARE-2 measure on a case by 
case basis. If the patient is ranked in any other disease module, CARE measure, or PREV 
measure, the patient is only skipped in the CARE-2 measure, not in all modules or patient care 
measures in which they are ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for CARE-2 is done on a case by case basis, and this option 
may only be selected when an approval has been received from CMS in the form of a response 
to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be provided when this 
answer is selected, to complete the patient. 

The table below shows the available values and appropriate XML format for CARE-2 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <carefalls-
confirmed>2</carefalls-
confirmed> 

Provide the Screening for Future Fall 
Risk value to complete the measure for 
this patient. 

15 = No - Other CMS 
Approved Reason 

<carefalls-
confirmed>15</carefalls-
confirmed> 

Do not provide the Screening for 
Future Fall Risk value, patient is 
skipped for this measure; however, 
selecting this option requires including 
a Help Desk ticket number. 

19 = Not Confirmed - 
Age. 

<carefalls-
confirmed>19</carefalls-
confirmed>  

This value is only used for export. 
The system will automatically set the 
value if the patient’s date of birth is 
changed in the GPRO Web Interface 
and the age makes the patient ineligible 
for the measure. If the age exclusion 
value is included in an uploaded XML 
file, the value will be ignored and 
CARE-2 Confirmed will not be set to 
this value. 

7.2.5.2.1. CARE-2 Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for the CARE-2 Confirmed question. 
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The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<carefalls-rm-
ticket>Text for ticket 
number</carefalls-rm-
ticket> 

None 

7.2.5.3. CARE-2: Screening for Future Fall Risk 

Determine if the patient was screened for future fall risk at least once during the measurement 
period. 

The table below shows the available values and appropriate XML format for Screening for 
Future Falls Risk. 

Available Values Sample XML Tag Other Parameters 

1 = No <falls-screening>1</falls-
screening> 

None, measure is complete for 
this patient. 

2 = Yes <falls-screening>2</falls-
screening> 

None, measure is complete for 
this patient. 

4 = No - Denominator 
Exception - Medical Reasons 

<falls-screening>4</falls-
screening> 

None, measure is complete for 
this patient. 

7.2.5.4. Comments for the CARE-2 Measure 

The Comments for the CARE-2 measure can be used to provide additional information for the 
patient related to CARE-2. 

The table below the available values and appropriate XML format for the CARE Comments. 

Available Values Sample XML Tag Other 
Parameters 

Text up to 140 
characters 

<carefalls-comments>Text for comment</carefalls-
comments> 

None 

7.2.6. Coronary Artery Disease (CAD) 
The Coronary Artery Disease (CAD) module includes elements for: 

• CAD Confirmed 
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• CAD Help Desk Ticket # 

• CAD-7: Diabetes or LVSD and ACE-I/ARB 

• CAD Comments 

Additional details and codes for the measure confirmation and the individual measures can be 
found here: (https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-
Instruments/PQRS/GPRO_Web_Interface.html) 

7.2.6.1. CAD Confirmed 

Determine if the patient has a documented diagnosis of CAD (active or history of) at any time 
history up through the last day of the measurement period. 

In addition to indicating the medical record was found for the patient, the diagnosis of coronary 
artery disease must be confirmed. If the diagnosis can be confirmed for the patient, all required 
values for the CAD measures must be provided before the system can mark the patient as 
complete in the CAD disease module. 

CAD Confirmed also provides a way to skip the patient in the CAD module. If the patient is 
ranked in any other disease module, CARE measure, or PREV measure, the patient is only 
skipped in the CAD module, not in all modules or patient care measures in which they are 
ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the CAD module is done on a case by case basis, and this 
option may only be selected when an approval has been received from CMS in the form of a 
response to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be provided 
when this answer is selected, to complete the patient. 

If the diagnosis of CAD cannot be confirmed, or the patient is not qualified for the sample for a 
CMS approved reason, the values for the CAD measures should not be provided. 

The table below shows the available values and appropriate XML tags for CAD Confirmed. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <cad-confirmed>2</cad-
confirmed> 

Include required CAD measure elements to 
complete the patient’s data for CAD. 

8 = Not Confirmed - 
Diagnosis 

<cad-confirmed>8</cad-
confirmed> 

Do not include CAD measure elements for this 
patient; patient is skipped in this module. 

15 = No - Other 
CMS Approved 
Reason 

<cad-confirmed>15</cad-
confirmed> 

Do not include CAD measure elements for this 
patient; patient is skipped in this module; 
however, selecting this option requires 
including a Help Desk ticket number. 

https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
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Available Values Sample XML Tag Other Parameters 

19 = Not Confirmed 
- Age 

<cad-confirmed>19</cad-
confirmed> 

This value is only used for export. The 
system will automatically set the value if the 
patient’s date of birth is changed in the GPRO 
Web Interface and the age makes the patient 
ineligible for the measure. If the age exclusion 
value is included in an uploaded XML file, the 
value will be ignored and CAD Confirmed will 
not be set to this value. 

22 = Not Confirmed 
– Additional 
Denominator 
Criteria 

<cad-confirmed>22</cad-
confirmed> 

This value is only used for export. The 
system will automatically set the value when 
Has Diabetes or LVSD = No. If this value is 
included in an uploaded file, the value will be 
ignored and CAD Confirmed will not be set to 
this value. 

7.2.6.1.1. CAD Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for the CAD Confirmed question. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<cad-rm-ticket>Text for 
ticket number</cad-rm-
ticket> 

None 

7.2.6.2. CAD-7: Angiotensin-Converting Enzyme (ACE) Inhibitor or Angiotensin Receptor Blocker 
(ARB) Therapy – Diabetes or Left Ventricular Systolic Dysfunction (LVEF < 40%) 

Two values for abstraction are included in the CAD-7 measure: 

• Confirmation that the patient has Diabetes or LVSD 

• Indicator that the patient was prescribed ACE-I/ARB Therapy 

Not all values may be required for the CAD-7 measure to be marked complete. The Has 
Diabetes or LVSD values must be provided. If the value for Has Diabetes or LVSD is Yes, a 
value for ACE-I/ARB must be provided. If Has Diabetes or LVSD is No, a value is not required 
for ACE-I/ARB. 
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7.2.6.2.1. Determine if the Patient Has Diabetes or LVSD 

Determine if the patient has LVSD (current or prior LVEF < 40% or documented as moderate or 
severe) OR has diabetes. 

Note: LVSD is defined as the patient ever having an LVEF < 40% or having an LVEF 
documented as moderate or severe. 

The table below shows the available values and appropriate XML format for Has Diabetes or 
LVSD. 

Available 
Values 

Sample XML Tag Other Parameters 

1 = No <cad-diabetes-lvsd>1</cad-
diabetes-lvsd> 

Do not provide the ACE-I/ARB value, measure 
is complete for this patient. 

2 = Yes <cad-diabetes-lvsd>2</cad-
diabetes-lvsd> 

Provide the ACE-I/ARB value to complete the 
measure for this patient. 

7.2.6.2.2. Determine if the Patient was Prescribed ACE-I/ARB 

If the patient has LVSD and/or diabetes, determine if ACE inhibitor or ARB therapy was 
prescribed at any time during the measurement period. Prescribed may include prescription 
given to the patient for ACE inhibitor or ARB therapy at one or more visits in the measurement 
period OR patient is already taking ACE inhibitor or ARB therapy as documented in the current 
medication list. 

The table below shows the available values and appropriate XML format for ACE-I/ARB. 

Available Values Sample XML Tag Other Parameters 

1 = No <cad-acearb>1</cad-
acearb> 

Provide the Has Diabetes or LVSD value 
to complete the measure for this patient. 

2 = Yes <cad-acearb>2</cad-
acearb> 

Provide the Has Diabetes or LVSD value 
to complete the measure for this patient. 

4 = No - Denominator 
Exception - Medical Reasons 

<cad-acearb>4</cad-
acearb> 

Provide the Has Diabetes or LVSD value 
to complete the measure for this patient. 

5 = No - Denominator 
Exception - Patient Reasons 

<cad-acearb>5</cad-
acearb> 

Provide the Has Diabetes or LVSD value 
to complete the measure for this patient. 

6 = No - Denominator 
Exception - System Reasons 

<cad-acearb>6</cad-
acearb> 

Provide the Has Diabetes or LVSD value 
to complete the measure for this patient. 
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7.2.6.3. Comments for the CAD Module 

The Comments for the CAD module can be used to provide additional information for the 
patient related to CAD. 

The table below shows the available values and appropriate XML format for the CAD 
Comments. 

Available Values Sample XML Tag Other 
Parameters 

Text up to 140 
characters 

<cad-comments>Text for comment</cad-
comments> 

None 

7.2.7. Diabetes Mellitus (DM) 
The Diabetes Mellitus (DM) module includes elements for: 

• DM Confirmed 

• DM Help Desk Ticket # 

• DM-2: Diabetes: Hemoglobin A1c Poor Control 

• DM-7: Diabetes: Eye Exam 

• DM Comments 

Additional details and codes for the measure confirmation and the individual measures can be 
found here: (https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-
Instruments/PQRS/GPRO_Web_Interface.html) 

7.2.7.1. DM Confirmed 

Determine if the patient has a documented history of DM during the measurement period or 
year prior to the measurement period. 

In addition to indicating the medical record was found for the patient, the diagnosis of diabetes 
mellitus must be confirmed. If the diagnosis can be confirmed for the patient, all required values 
for the DM measures must be provided before the system can mark the patient as complete in 
the DM module. 

DM Confirmed also provides a way to skip the patient in the DM module. If the patient is ranked 
in any other disease module, CARE measure, or PREV measure, the patient is only skipped in 
the DM module, not in all modules or patient care measures in which they are ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, HMO Enrollment, or Medical 
Reasons. The use of No – Other CMS Approved Reason for the DM module is done on a 
case by case basis, and this option may only be selected when an approval has been received 

https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
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from CMS in the form of a response to a QualityNet Help Desk inquiry. That Help Desk Ticket 
number must be provided when this answer is selected, to complete the patient. 

If the diagnosis of DM cannot be confirmed, the diagnosis cannot be confirmed for medical 
reasons, or the patient is not qualified for the sample for a CMS approved reason, the values for 
the DM measures should not be provided. 

The table below shows the available values and appropriate XML tags for DM Confirmed. 

Available 
Values 

Sample XML Tag Other Parameters 

2 = Yes <dm-
confirmed>2</dm-
confirmed> 

Include required DM measure elements to complete the 
patient’s data for DM. 

8 = Not 
Confirmed - 
Diagnosis 

<dm-
confirmed>8</dm-
confirmed> 

Do not include DM measure elements for this patient; 
patient is skipped in this module. 

15 = No – 
Other CMS 
Approved 
Reason 

<dm-
confirmed>15</dm-
confirmed> 

Do not include DM measure elements for this patient; 
patient is skipped in this module; however, selecting this 
option requires including a Help Desk ticket number. 

19 = Not 
Confirmed - 
Age 

<dm-
confirmed>19</dm-
confirmed> 

This value is only used for export. The system will 
automatically set the value if the patient’s date of birth is 
changed in the GPRO Web Interface and the age makes 
the patient ineligible for the measure. If the age 
exclusion value is included in an uploaded XML file, the 
value will be ignored and DM Confirmed will not be set 
to this value. 

7.2.7.1.1. DM Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for the DM Confirmed question. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<dm-rm-ticket>Text for 
ticket number</dm-rm-
ticket> 

None 
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7.2.7.2. DM-2: Diabetes: Hemoglobin A1c Poor Control 

Three values for abstraction are included the DM-2 measure: 

• Confirmation that HbA1c test was performed 

• The most recent date the blood was drawn for the HbA1c 

• The most recent HbA1c value 

Not all values may be required for the DM-2 measure to be marked as complete. The HbA1c 
Test value must be provided. If an HbA1c test was not performed, a value should not be 
provided for the date and test result. If an HbA1c test was performed, the date and test result 
must have a value provided. The DM-2 measure will be marked as complete for the patient 
when all required fields have a value provided. 

7.2.7.2.1. Determine if an HbA1c Test was Performed 

Determine if the patient had one or more HbA1c tests performed during the measurement 
period. 

The table below shows the available values and appropriate XML format for HbA1c Test. 

Available 
Values 

Sample XML Tag Other Parameters 

1 = No <dm-hba1c-
test>1</dm-hba1c-
test> 

Do not provide the HbA1c Date value and HbA1c 
Result value. The measure is complete for this patient. 

2 = Yes <dm-hba1c-
test>2</dm-hba1c-
test> 

Provide the HbA1c Date value and HbA1c Result value 
to complete the measure for this patient. 

7.2.7.2.2. Determine Date Blood was Drawn for the HbA1c 

If the HbA1c test was performed, provide the most recent date the blood was drawn for the 
HbA1c. 

The table below shows the available values and appropriate XML format for the date the most 
recent date the blood was drawn for the HbA1c. 

Available Values Sample XML Tag Other Parameters 

Valid date between 01/01/[current 
program year] and 12/31/[current 
program year] in format 
MM/DD/YYYY 

<dm-hba1c-
date>02/14/2015</dm-
hba1c-date> 

Provide the HbA1c Test value 
and HbA1c Result value to 
complete the measure for this 
patient. 
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7.2.7.2.3. Determine HbA1c Test Result 

If the HbA1c test was performed, provide the most recent HbA1c value OR if test was 
performed but result is not documented, provide a 0 (zero) for the value. 

The table below shows the available values and appropriate XML format for the HbA1c test 
result value. 

Available Values Sample XML Tag Other Parameters 

0-25 with one or two 
optional decimal places 
(XX.XX) 

<dm-hba1c-
value>6.8</dm-hba1c-
value> 

Provide the HbA1c Test value and 
HbA1c Date value to complete the 
measure for this patient. 

7.2.7.3. DM-7: Diabetes: Eye Exam 

Determine if patient was screened for diabetic retinal disease identified by one of the following: 

• A retinal or dilated eye exam by an eye care professional during the measurement 
period  

OR 

• A negative retinal exam (no evidence of retinopathy) by an eye care professional in the 
year prior to the measurement period 

Note: The eye exam must be performed by an ophthalmologist or optometrist. 

Available Values Sample XML Tag Other Parameters 

1 = No <dm-eye-
exam>1</dm-eye-
exam> 

None. Measure is complete for this patient. 

2 = Yes <dm-eye-
exam>2</dm-eye-
exam> 

None. Measure is complete for this patient. 

7.2.7.4. Comments for the DM Module 

The Comments for the DM module can be used to provide additional information for the patient 
related to DM. 

The table below shows the available values and appropriate XML format for the DM 
Comments. 
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Available Values Sample XML Tag Other 
Parameters 

Text up to 140 
characters 

<dm-comments>Text for comment</dm-
comments> 

 None 

7.2.8. Heart Failure (HF) 
The Heart Failure (HF) module includes elements for: 

• HF Confirmed 

• HF Help Desk Ticket # 

• HF-6: Beta Blocker Therapy for Left Ventricular Systolic Dysfunction (LVSD) 

• HF Comments 

Additional details and codes for the measure confirmation and the individual measures can be 
found here: (https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-
Instruments/PQRS/GPRO_Web_Interface.html) 

7.2.8.1. HF Confirmed 

Determine if the patient has an active diagnosis of HF at any time up through the last day of the 
measurement period. 

In addition to indicating the medical record was found for the patient, the diagnosis of heart 
failure must be confirmed. If the diagnosis can be confirmed for the patient, all required values 
for the HF measures must be provided before the system can mark the patient as complete in 
the HF module. 

HF Confirmed also provides a way to skip the patient in the HF module. If the patient is ranked 
in any other disease module, CARE measure, or PREV measure, the patient is only skipped in 
the HF module, not in all modules or patient care measures in which they are ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the HF module is done on a case-by-case basis, and this 
option may only be selected when an approval has been received from CMS in the form of a 
response to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be provided 
when this answer is selected, to complete the patient. 

If the diagnosis of HF cannot be confirmed, or the patient is not qualified for the sample for a 
CMS approved reason, the values for the HF measures should not be provided. 

https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
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Available Values Sample XML Tag Other Parameters 

2 = Yes <hf-confirmed>2</hf-
confirmed> 

Include required HF measure elements to 
complete the patient’s data for HF. 

8 = Not Confirmed - 
Diagnosis 

<hf-confirmed>8</hf-
confirmed> 

Do not include HF measure elements for this 
patient, patient is skipped in this module. 

15 = No - Other 
CMS Approved 
Reason 

<hf-confirmed>15</hf-
confirmed> 

Do not include HF measure elements for this 
patient, patient is skipped in this module; 
however, selecting this option requires 
including a Help Desk ticket number. 

19 = Not Confirmed - 
Age 

<hf-confirmed>19</hf-
confirmed>  

This value is only used for export. The 
system will automatically set the value if the 
patient’s date of birth is changed in the GPRO 
Web Interface and the age makes the patient 
ineligible for the measure. If the age exclusion 
value is included in an uploaded XML file, the 
value will be ignored and HF Confirmed will 
not be set to this value.  

22 = Not Confirmed 
– Additional 
Denominator Criteria 

<hf-confirmed>22</hf-
confirmed> 

This value is only used for export. The 
system will automatically set the value when 
Has LVSD = No. If this value is included in an 
uploaded file, the value will be ignored and HF 
Confirmed will not be set to this value. 

7.2.8.1.1. HF Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for the HF Confirmed question. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<hf-rm-ticket>Text for 
ticket number</hf-rm-
ticket> 

None 

7.2.8.2. HF-6: Beta-Blocker Therapy for Left Ventricular Systolic Dysfunction (LVSD) 

Two values for abstraction are included in the HF-6 measure: 

• Confirmation that the patient has LVSD 

• Indicator that the patient was prescribed beta-blocker therapy 
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Not all values may be required for the HF-6 measures to be marked complete. The Has LVSD 
value must be provided. If the patient has LVSD, a value for Beta-Blocker must be provided. If 
the patient does not have LVSD, a value should not be provided for Beta-Blocker. The HF-6 
measure will be marked as complete for the patient when all required values are provided. 

7.2.8.2.1. Determine if the Patient has LVSD 

Determine if the patient has LVSD (LVEF < 40% or documented as moderate or severe). LVSD 
is defined as the patient ever having an LVEF < 40% or having an LVEF documented as 
moderate or severe.  

The table below shows the available values and appropriate XML format for Has LVSD. 

Available Values Sample XML Tag Other Parameters 

1 = No <hf-lvsd>1</hf-
lvsd> 

Do not provide the Beta-Blocker value, measure is 
complete for this patient. 

2 = Yes <hf-lvsd>2</hf-
lvsd> 

Provide the Beta Blocker value to complete the 
measure for this patient. 

7.2.8.2.2. Determine if Beta Blocker was Prescribed 

If the patient has LVSD, determine if beta-blocker therapy was prescribed at any time during the 
measurement period. 

The table below shows the available values and appropriate XML format for Beta-Blocker 
Therapy. 

Available Values Sample XML Tag Other Parameters 

1 = No <hf-beta-blocker>1</hf-
beta-blocker> 

Provide the Has LVSD value to complete the 
measure for this patient. 

2 = Yes <hf-beta-blocker>2</hf-
beta-blocker> 

Provide the Has LVSD value to complete the 
measure for this patient. 

4 = No – 
Denominator 
Exception - Medical 
Reasons 

<hf-beta-blocker>4</hf-
beta-blocker> 

Provide the Has LVSD value to complete the 
measure for this patient. 

5 = No – 
Denominator 
Exception - Patient 
Reasons 

<hf-beta-blocker>5</hf-
beta-blocker> 

Provide the Has LVSD value to complete the 
measure for this patient. 
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Available Values Sample XML Tag Other Parameters 

6 = No – 
Denominator 
Exception - System 
Reasons 

<hf-beta-blocker>6</hf-
beta-blocker> 

Provide the Has LVSD value to complete the 
measure for this patient. 

7.2.8.3. Comments for the HF Module 

The Comments for the HF module can be used to provide additional information for the patient 
related to hypertension. 

The table below shows the available values and appropriate XML format for the HF Comments. 

Available Values Sample XML Tag Other Parameters 

Text up to 140 characters <hf-comments>Text for comment</hf-comments> None 

7.2.9. Hypertension (HTN) 
The HTN module includes elements for: 

• HTN Confirmed 

• HTN Help Desk Ticket # 

• HTN-2: Controlling High Blood Pressure 

• HTN Comments 

Additional details and codes for the measure confirmation and the individual measures can be 
found here: (https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-
Instruments/PQRS/GPRO_Web_Interface.html) 

7.2.9.1. HTN Confirmed 

Determine if the patient has a documented diagnosis of essential HTN within the first six months 
of the measurement period or any time prior to the measurement period but does not end before 
the start of the measurement period. 

In addition to indicating the medical record was found for the patient, the diagnosis of 
hypertension must be confirmed. If the diagnosis can be confirmed for the patient, all required 
values for the HTN measures must be provided before the system can mark the patient as 
complete in the HTN module. 

HTN Confirmed also provides a way to skip the patient in the HTN module. If the patient is 
ranked in any other disease module, CARE measure, or PREV measure, the patient is only 
skipped in the HTN module, not in all modules or patient care measures in which they are 
ranked. 

https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
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Denominator Exclusion may be used if there is a denominator exclusion for patient 
disqualification from the module. Applicable denominator exclusions for HTN include: End Stage 
Renal Disease (ESRD), patients undergoing dialysis, history of renal transplant, pregnancy, and 
chronic kidney disease (CKD), stage 5. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the HTN module is done on a case by case basis, and this 
option may only be selected when an approval has been received from CMS in the form of a 
response to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be provided 
when this answer is selected, to complete the patient. 

If the diagnosis of HTN cannot be confirmed, there is a Denominator Exclusion, or the patient is 
not qualified for the sample for a CMS approved reason, the values for the HTN measures 
should not be provided. 

The table below shows the available values and appropriate XML tags for HTN Confirmed. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <htn-confirmed>2</htn-
confirmed> 

Include required HTN measure elements to 
complete the patient’s data for HTN. 

8 = Not Confirmed - 
Diagnosis 

<htn-confirmed>8</htn-
confirmed> 

Do not include HTN measure elements for 
this patient, patient is skipped in this module. 

17 = Denominator 
Exclusion 

<htn-confirmed>17</htn-
confirmed>  

Do not include HTN measure elements for 
this patient, patient is skipped in this module. 

15 = No - Other CMS 
Approved Reason 

<htn-confirmed>15</htn-
confirmed> 

Do not include HTN measure elements for 
this patient, patient is skipped in this module; 
however, selecting this option requires 
including a Help Desk ticket number. 

19 = Not Confirmed - 
Age 

<htn-confirmed>19</htn-
confirmed>  

This value is only used for export. The 
system will automatically set the value if the 
patient’s date of birth is changed in the 
GPRO Web Interface and the age makes the 
patient ineligible for the measure. If the age 
exclusion value is included in an uploaded 
XML file, the value will be ignored and HTN 
Confirmed will not be set to this value.  

7.2.9.1.1. HTN Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for the HTN Confirmed question. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 



XML Specifications 

GPRO Web Interface XML Specification V1.0 46 PQRS PY2016 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<htn-rm-ticket>Text for 
ticket number</htn-rm-
ticket> 

None 

7.2.9.2. HTN-2: Controlling High Blood Pressure 

Four values for abstraction are included in the HTN-2 measure: 

• Confirmation that the blood pressure measurement was documented 

• The date the most recent blood pressure measurement was documented 

• The systolic value 

• The diastolic value 

Not all values may be required for the HTN-2 measure to be marked as complete. The Blood 
Pressure Documented value must be provided. If the patient’s blood pressure was not 
documented, a value should not be provided for the date, systolic, and diastolic values. If 
patient’s blood pressure was documented, the date, systolic, and diastolic values must be 
provided. The HTN-2 measure will be marked as complete for the patient when all required 
fields have a value provided. 

7.2.9.2.1. Determine if the Blood Pressure was Documented 

Determine if the patient’s most recent BP was documented during the measurement period. 

The table below shows the available values and appropriate XML format for Blood Pressure 
Documented. 

Available Values Sample XML Tag Other Parameters 

1 = No <htn-recent-
bp>1</htn-recent-bp> 

Do not provide the Blood Pressure Date value, 
Systolic value, and Diastolic value, measure is 
complete for this patient. 

2 = Yes <htn-recent-
bp>2</htn-recent-bp> 

Provide the Blood Pressure Date value, Systolic 
value, and Diastolic value to complete the 
measure for this patient. 

7.2.9.2.2. Determine Date Blood Pressure Measurement was Documented 

If the blood pressure measurement was documented, provide the date of the most recent blood 
pressure date. 

The table below shows the available values and appropriate XML format for the Blood 
Pressure Date. 
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Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/[current program year] 
and 12/31/[current program 
year] in format MM/DD/YYYY 

<htn-bp-
date>02/15/2015</htn-bp-
date> 

Provide the Blood Pressure 
Documented value, Systolic 
value, and Diastolic value to 
complete the measure for this 
patient. 

7.2.9.2.3. Determine Systolic Value for Most Recent Blood Pressure Measurement 

If the blood pressure measurement was documented, provide the systolic blood pressure 
recorded in mmHg. 

The table below shows the available values and appropriate XML format for the Blood 
Pressure Systolic. 

Available 
Values Sample XML Tag Other Parameters 

0 to 350 <htn-bp-
systolic>120</htn-bp-
systolic> 

Provide the Blood Pressure Documented value, Blood 
Pressure Date value, and Diastolic value to complete the 
measure for this patient. 

Note: If both Systolic and Diastolic are greater than zero, the 
Systolic value must be greater than the Diastolic value in 
order for the system to mark the patient as complete. If the 
Systolic is less than or equal to the Diastolic, the patient will 
be marked as incomplete by the system. 

7.2.9.2.4. Determine Diastolic Value for Most Recent Blood Pressure Measurement 

If the blood pressure measurement was documented, provide the diastolic blood pressure 
recorded in mmHg. 

The table below shows the available values and appropriate XML format for the Blood 
Pressure Diastolic. 
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Available 
Values Sample XML Tag Other Parameters 

0 to 200 <htn-bp-diastolic>80</htn-
bp-diastolic> 

Provide the Blood Pressure Documented value, 
Blood Pressure Date value, and Systolic value to 
complete the measure for this patient. 

Note: If both Systolic and Diastolic are greater than 
zero, the Diastolic value must be less than the Systolic 
value in order for the system to mark the patient as 
complete. If the Diastolic is greater than or equal to the 
Systolic, the patient will be marked as incomplete by 
the system. 

7.2.9.3. Comments for the HTN Module 

The Comments for the HTN module can be used to provide additional information for the 
patient related to hypertension. 

The table below shows the available values and appropriate XML format for the HTN 
Comments. 

Available Values Sample XML Tag Other 
Parameters 

Text up to 140 
characters 

<htn-comments>Text for comment</htn-
comments> 

None 

7.2.10. Ischemic Vascular Disease (IVD) 
The Ischemic Vascular Disease (IVD) module contains elements for: 

• IVD Confirmed 

• IVD Help Desk Ticket # 

• IVD-2: Use of Aspirin or Another Antithrombotic 

• IVD Comments 

Additional details and codes for the measure confirmation and the individual measures can be 
found here: (https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-
Instruments/PQRS/GPRO_Web_Interface.html) 

7.2.10.1. IVD Confirmed 

Determine if the patient was discharged alive for acute myocardial infarction (AMI), coronary 
artery bypass graft (CABG) or percutaneous coronary interventions (PCI) in the 12 months prior 

https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
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to the measurement period, or who had an active diagnosis of ischemic vascular disease (IVD) 
during the measurement period. 

In addition to indicating the medical record was found for the patient, the diagnosis of ischemic 
vascular disease must be confirmed. If the diagnosis can be confirmed for the patient, all 
required values for the IVD measures must be provided before the system can mark the patient 
as complete in the IVD module. 

IVD Confirmed also provides a way to skip the patient in the IVD module. If the patient is 
ranked in any other disease module, CARE measure, or PREV measure, the patient is only 
skipped in the IVD module, not in all modules or patient care measures in which they are 
ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the IVD module is done on a case by case basis, and this 
option may only be selected when an approval has been received from CMS in the form of a 
response to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be provided 
when this answer is selected, to complete the patient. 

If the diagnosis of IVD cannot be confirmed, or the patient is not qualified for the sample for a 
CMS approved reason, the values for the IVD measures should not be provided. 

The table below shows the available values and appropriate XML tags for IVD Confirmed. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <ivd-confirmed>2</ivd-
confirmed> 

Include required IVD measure elements to 
complete the patient’s data for IVD. 

8 = Not Confirmed - 
Diagnosis 

<ivd-confirmed>8</ivd-
confirmed> 

Do not include IVD measure elements for this 
patient, patient is skipped in this module. 

15 = No - Other 
CMS Approved 
Reason 

<ivd-
confirmed>15</ivd-
confirmed> 

Do not include IVD measure elements for this 
patient, patient is skipped in this module; 
however, selecting this option requires including a 
Help Desk ticket number. 

19 = Not Confirmed 
- Age 

<ivd-
confirmed>19</ivd-
confirmed> 

This value is only used for export. The system 
will automatically set the value if the patient’s 
date of birth is changed in the GPRO Web 
Interface and the age makes the patient ineligible 
for the measure. If the age exclusion value is 
included in an uploaded XML file, the value will 
be ignored and IVD Confirmed will not be set to 
this value. 

7.2.10.1.1. IVD Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for the IVD Confirmed question. 
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The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<ivd-rm-ticket>Text for 
ticket number</ivd-rm-
ticket> 

None 

7.2.10.2. IVD-2: Use of Aspirin or Other Antithrombotic 

Determine if the patient has documented use of aspirin or another antithrombotic during the 
measurement period. 

The table below shows the available values and appropriate XML format for Aspirin or Other 
Antithrombotic. 

Available Values Sample XML Tag Other Parameters 

1 = No <ivd-antithrombotic>1</ivd-
antithrombotic> 

None, measure is complete for this 
patient. 

2 = Yes <ivd-antithrombotic>2</ivd-
antithrombotic> 

None, measure is complete for this 
patient. 

7.2.10.3. Comments for the IVD Module 

The Comments for the IVD module can be used to provide additional information for the patient 
related to IVD. 

The table below shows the available values and appropriate XML format for the IVD 
Comments. 

Available Values Sample XML Tag Other Parameters 

Text up to 140 
characters 

<ivd-comments>Text for comment</ivd-
comments> 

None 

7.2.11. Mental Health (MH) 
The Mental Health disease module contains elements for: 

• MH Confirmation 

• MH Help Desk Ticket # 

• MH-1: Depression Remission at Twelve Months 
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 PHQ-9 Test Performed? 

 PHQ-9 Index Test > 9 

 PHQ-9 Index Date 

 PHQ-9 Index Score 

 PHQ-9 Follow-Up Test Performed? 

 PHQ-9 Follow-Up < 5 

 PHQ-9 Follow-Up Date 

 PHQ-9 Follow-Up Score 

• MH Comments 

Additional details and codes for the measure confirmation and the individual measures can be 
found here: (https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-
Instruments/PQRS/GPRO_Web_Interface.html) 

7.2.11.1. MH Confirmation 

• Determine if the patient has an active diagnosis of major depression including remission 
or dysthymia during the denominator identification measurement period (12/1/2014 
through 11/30/2015). 

• In addition to indicating the medical record was found for the patient, the diagnosis of 
major depression or dysthymia must be confirmed. If the diagnosis can be confirmed for 
the patient, all required values for the MH measures must be provided before the system 
can mark the patient as complete in the MH module. 

• MH Confirmed also provides a way to skip the patient in the MH module. If the patient is 
ranked in any other disease module, CARE measure, or PREV measure, the patient is 
only skipped in the MH module, not in all modules or patient care measures in which 
they are ranked. 

• Denominator Exclusion may be used if there is a denominator exclusion for patient 
disqualification from the module. Applicable denominator exclusions include: patients 
who were permanent nursing home residents (> 1 year any time before the start of the 
measurement period), active diagnosis of bipolar disorder, active diagnosis of 
personality disorder. 

• The No – Other CMS Approved Reason may be used if the patient is not qualified for a 
reason other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. 
The use of No – Other CMS Approved Reason for the MH module is done on a case 
by case basis, and this option may only be selected when an approval has been 
received from CMS in the form of a response to a QualityNet Help Desk inquiry. That 
Help Desk Ticket number must be provided when this answer is selected, to complete 
the patient. 

https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
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• If the diagnosis of MH cannot be confirmed, or the patient is not qualified for the sample 
for a CMS approved reason, the values for the MH measures should not be provided. 

• The table below shows the available values and appropriate XML tags for MH 
Confirmed. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <mh-
confirmed>2</mh-
confirmed> 

Include required MH measure elements to 
complete the patient’s data for MH. 

8 = Not Confirmed - 
Diagnosis 

<mh-
confirmed>8</mh-
confirmed> 

Do not include MH measure elements for this 
patient; patient is skipped in this module. 

15 = No - Other 
CMS Approved 
Reason 

<mh-
confirmed>15</mh-
confirmed> 

Do not include MH measure elements for this 
patient; patient is skipped in this module; 
however, selecting this option requires including a 
Help Desk ticket number. 

17 = Denominator 
Exclusion 

<mh-
confirmed>17</mh-
confirmed> 

Do not include MH measure elements for this 
patient; patient is skipped in this module. 

19 = Not Confirmed 
- Age 

<mh-
confirmed>19</mh-
confirmed> 

This value is only used for export. The system 
will automatically set the value if the patient’s 
date of birth is changed in the GPRO Web 
Interface and the age makes the patient ineligible 
for the measure. If the age exclusion value is 
included in an uploaded XML file, the value will 
be ignored and MH Confirmed will not be set to 
this value. 

22 = Not Confirmed 
– Additional 
Denominator 
Criteria 

<mh-
confirmed>22</mh-
confirmed> 

This value is only used for export. The system 
will automatically set the value if the patients 
Initial PHQ-9 Administered is set to Yes and the 
PHQ-9 Initial Test Score is less than or equal to 9 
OR the Initial PHQ-9 Administered? is set to No. 
If the Not Confirmed – Additional Denominator 
Criteria is included in an uploaded XML file, the 
value will be ignored and MH Confirmed will not 
be set to this value. 

7.2.11.1.1. MH Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for the MH Confirmed question. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 
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Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<mh-rm-ticket>Text for 
ticket number</mh-rm-
ticket> 

None 

7.2.11.2. MH-1: Depression Remission at Twelve Months 

7.2.11.2.1. PHQ-9 Test Performed? 

Determine if the patient had one or more PHQ-9s administered during the denominator 
identification measurement period (Index Date) between 12/1/2014 and 11/30/2015. 

Index Date = the first instance of elevated PHQ-9 greater than 9 (12/1/2014 to 11/30/2015) and 
diagnosis of depression or dysthymia to identify the denominator of eligible patients for follow-up 
for remission during the assessment period (11/1/2015 to 12/31/2016) to determine if the patient 
is in remission. The table below shows the available values and appropriate XML tags for PHQ-
9 Test Performed?. 

Available Values Sample XML Tag Other Parameters 

1 = No <mh-index-
performed>1</mh-
index-performed> 

Do not provide the PHQ-9 Test > 9 value, PHQ-9 
Index Date value, PHQ-9 Index Test Score value, 
PHQ-9 Follow-Up Test Performed value, PHQ-9 
Follow-Up < 5 value or PHQ-9 Follow-Up Date 
value. Patient is skipped and measure is complete 
for this patient. 

2 = Yes <mh-index-
performed>2</mh-
index-performed> 

Provide the PHQ-9 Test > 9 value, PHQ-9 Index 
Date value, PHQ-9 Index Test Score value, PHQ-
9 Follow-Up Test Performed value, PHQ-9 
Follow-Up < 5 value or PHQ-9 Follow-Up Date 
value to complete the measure for this patient. 

7.2.11.2.2. PHQ-9 Index Test > 9 

Determine if the patient had a PHQ-9 score greater than 9 during an outpatient encounter 
between 12/1/2014 and 11/30/2015. 

The index date marks the start of the measurement assessment period for each patient which is 
13 months (12 months +/- 30 days) in length to allow for a follow-up PHQ-9 between 11 and 13 
months following the index date. This assessment period is fixed and does not “start over” with 
a higher PHQ-9 that may occur after the index date. 

Patients must be aged 18 years and older on the index date. 
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Available Values Sample XML Tag Other Parameters 

1 = No <mh-index-
test>1</mh-index-
test> 

Do not provide the PHQ-9 Index Date value, PHQ-
9 Index Test Score value, PHQ-9 Follow-Up Test 
Performed value, PHQ-9 Follow-Up < 5 value or 
PHQ-9 Follow-Up Date value. Patient is skipped 
and measure is complete for this patient. 

2 = Yes <mh-index-
test>2</mh-index-
test> 

Provide the PHQ-9 Test > 9 value, PHQ-9 Index 
Date value, PHQ-9 Index Test Score value, PHQ-
9 Follow-Up Test Performed value, PHQ-9 
Follow-Up < 5 value or PHQ-9 Follow-Up Date 
value to complete the measure for this patient. 

7.2.11.2.3. PHQ-9 Index Date 

Enter the date of the index PHQ-9 score greater than 9 in MM/DD/YYYY format. 

Enter the first instance of PHQ-9 greater than 9 that is also associated with a diagnosis of major 
depression or dysthymia during the time period of 12/1/2014 and 11/30/2015. 

This is the Index Date for this patient and marks the start of the 13 month assessment period 
(12 months +/- 30 days). 

Available Values Sample XML Tag Other Parameters 

Record the date 
of the PHQ-9 
score greater 
than 9 in 
MM/DD/YYYY 
format  

 <mh-index-date>valid 
date</mh-index-date> 

The PHQ-9 Index Date marks the start of the 
measurement assessment period for each patient 
which is 13 months (12 months +/- 30 days) in 
length to allow for a follow-up PHQ-9 between 11 
and 13 months following the index date. 

Provide the PHQ-9 Follow-Up Score value to 
complete the measure for this patient. 

7.2.11.2.4. PHQ-9 Index Score 

Enter the score of the PHQ-9 associated with the Index Date. 

Available Values Sample XML Tag Other Parameters 

Valid value of the 
PHQ-9 score 
associated with 
the Index Date 

<mh-index-score>valid 
value</mh-index-
score> 

Valid values for the PHQ-9 Index Score are > 9 
and <= 27. 

Provide the PHQ-9 Follow-Up Test Performed 
value, PHQ-9 Follow-Up < 5 value or PHQ-9 
Follow-Up Date value to complete the measure for 
this patient. 



XML Specifications 

GPRO Web Interface XML Specification V1.0 55 PQRS PY2016 

7.2.11.2.5. PHQ-9 Follow-Up Test Performed? 

Determine if the patient had one or more PHQ-9s administered during the Measurement 
Assessment Period (12 months +/- 30 days from the Index Date). 

Available Values Sample XML Tag Other Parameters 

1 = No <mh-followup-
performed>1</mh-
followup-performed> 

Do not provide the PHQ-9 Follow-Up < 5 value or 
PHQ-9 Follow-Up Date value. Patient is skipped 
and measure is complete for this patient. 

2 = Yes <mh-followup-
performed>2</mh-
followup-performed> 

Provide the PHQ-9 Follow-Up < 5 value or PHQ-9 
Follow-Up Date value to complete the measure for 
this patient. 

7.2.11.2.6. PHQ-9 Follow-Up < 5 

Determine if the patient achieved remission with a follow-up PHQ-9 performed and a score less 
than 5 at 12 months (+/- 30 days) of the initial (index date) PHQ-9 score greater than 9. 

If more than one PHQ-9 score was obtained between the 11 and 13 month window, select the 
most recent PHQ-9 date and score within that window. 

Remission is defined as a PHQ-9 score of less than five. 

Available Values Sample XML Tag Other Parameters 

1 = No <mh-followup-
test>1</mh-followup-
test> 

Do not provide the PHQ-9 Follow-Up Date value. 
Patient is skipped and measure is complete for this 
patient. 

2 = Yes <mh-followup-test-
met>2</mh-followup-
test-met> 

Provide the PHQ-9 Follow-Up Date value to 
complete the measure for this patient. 

7.2.11.2.7. PHQ-9 Follow-Up Date 

Record the date of the PHQ-9 score less than 5 in MM/DD/YYYY format.  

Available Values Sample XML Tag Other Parameters 

Record the date 
of the PHQ-9 
score less than 5 
in MM/DD/YYYY 
format  

<mh-followup-
date>valid date</mh-
followup-date> 

The Follow-Up Date must be 12 months (+/- 30 
days) of the initial (index date) PHQ-9 score greater 
than 9 and <= 27.  

Provide the PHQ-9 Follow-Up Score value to 
complete the measure for this patient 
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7.2.11.2.8. PHQ-9 Follow-Up Score 

Enter the score of the PHQ-9 associated with the 12 month (+/- 30 days) assessment. 

Available Values Sample XML Tag Other Parameters 

Enter the PHQ-9 
score less than 5  

<mh-followup-
score>3</mh-followup-
score> 

Valid values for the PHQ-9 Follow-Up Score are < 
5. 

The PHQ-9 Follow-Up Score value completes the 
measure for this patient 

7.2.11.3. MH Comments 

The Comments for the MH module can be used to provide additional information for the patient 
related to MH. 

The table below shows the available values and appropriate XML format for the MH 
Comments. 

Available Values Sample XML Tag Other Parameters 

Text up to 140 
characters 

<mh-comments>Text for comment</mh-
comments> 

None 

7.2.12. Preventive Care (PREV) 
There are nine, separately sampled Preventive Care measures. Because they share a common 
screen on the GPRO Web Interface and are documented in one Supporting Document, the XML 
elements are in a common section. 

The PREV measures include elements for: 

• PREV-5: Breast Cancer Screening 

 PREV-5 Confirmation 

 PREV-5 Help Desk Ticket # 

 PREV-5 Screening Performed 

 PREV-5 Comments 

• PREV-6: Colorectal Cancer Screening 

 PREV-6 Confirmation 

 PREV-6 Help Desk Ticket # 

 PREV-6 Screening is Current 
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 PREV-6 Comments 

• PREV-7: Preventive Care and Screening: Influenza Immunization 

 PREV-7 Confirmation 

 PREV-7 Help Desk Ticket # 

 PREV-7 Immunization Received 

 PREV-7 Comments 

• PREV-8: Pneumonia Vaccination Status for Older Adults 

 PREV-8 Confirmation 

 PREV-8 Help Desk Ticket # 

 PREV-8 Vaccination Received 

 PREV-8 Comments 

• PREV-9: Preventive Care and Screening: Body Mass Index (BMI) Screening and Follow-
Up 

 PREV-9 Confirmation 

 PREV-9 Help Desk Ticket # 

 PREV-9 BMI Calculated 

 PREV-9 Comments 

• PREV-10: Preventive Care and Screening: Tobacco Use: Screening and Cessation 
Intervention 

 PREV-10 Confirmation 

 PREV-10 Help Desk Ticket # 

 PREV-10 Tobacco Use 

 PREV-10 Comments 

• PREV-11: Preventive Care and Screening: Screening for High Blood Pressure and 
Follow-Up Documented 

 PREV-11 Confirmation 

 PREV-11 Help Desk Ticket # 

 PREV-11 Blood Pressure Screening 
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 PREV-11 Comments 

• PREV-12: Preventive Care and Screening: Screening for Clinical Depression and 
Follow-Up Plan 

 PREV-12 Confirmation 

 PREV-12 Help Desk Ticket # 

 PREV-12 Clinical Depression Screening 

 PREV-12 Comments 

• PREV-13: Statin Therapy for the Prevention and Treatment of Cardiovascular Disease 

 PREV-13 ASCVD Diagnosed 

 PREV-13 LDL-C > or = 190 mg/dL 

 PREV-13 Type 1 or 2 Diabetes 

 PREV-13 LDL-C Between 70-189 mg/dL 

 PREV-13 Help Desk Ticket # 

 PREV-13 Statin Used or Prescribed 

 PREV-13 Comments 

Additional details and codes for the measure confirmation and the individual measures can be 
found here: (https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-
Instruments/PQRS/GPRO_Web_Interface.html) 

7.2.12.1. PREV-5: Breast Cancer Screening 

Four values for abstraction are included in the PREV-5 measure: 

• Confirmation 

• Help Desk Ticket # 

• Screening Performed 

• Comments 

Not all values may be required for the PREV-5 measure to be marked complete. Confirmation 
that the patient is qualified for the measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-5 measure must be provided before the system can 
mark the patient as complete in the PREV-5 measure. If the patient is not qualified for the 
measure, the patient is skipped in the measure and the measure quality data should not be 
provided. 

https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
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7.2.12.1.1. PREV-5 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-5 measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-5 measure must be provided before the system can 
mark the patient as complete in the PREV-5 measure module. 

PREV-5 Confirmation provides a way to skip the patient in the PREV-5 measure on a case by 
case basis. If the patient is ranked in any other disease module, CARE measure, or PREV 
measure, the patient is only skipped in the PREV-5 measure, not in all modules or patient care 
measures in which they are ranked. 

The Denominator Exclusion may be used if there is documentation of bilateral mastectomy or 
two unilateral mastectomies. Note: If there is evidence of two separate mastectomies, this 
patient may be excluded from the measure. The bilateral mastectomy must have occurred by 
the end of the measurement period.  

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the PREV-5 measure is done on a case by case basis, 
and this option may only be selected when an approval has been received from CMS in the 
form of a response to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be 
provided when this answer is selected, to complete the patient. 

The table below shows the available values and appropriate XML format for PREV-5 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pcmammogram-
confirmed>2</pcmammogram-
confirmed> 

Include required PREV-5 measure 
elements to complete the patient’s data for 
PREV-5. 

15 = No – Other 
CMS Approved 
Reason 

<pcmammogram-
confirmed>15</pcmammogram-
confirmed> 

Do not include PREV-5 measure elements 
for this patient; patient is skipped in this 
measure; however, selecting this option 
requires including a Help Desk ticket 
number. 

17 = Denominator 
Exclusion 

<pcmammogram-
confirmed>17</pcmammogram-
confirmed> 

Do not include PREV-5 measure elements 
for this patient; patient is skipped in this 
measure. 
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Available Values Sample XML Tag Other Parameters 

18 = Not 
Confirmed - 
Gender 

<pcmammogram-
confirmed>18</pcmammogram-
confirmed> 

This value is only used for export. The 
system will automatically set the value if 
the patient’s gender is changed in the 
GPRO Web Interface and the updated 
gender makes the patient ineligible for the 
measure. If the gender exclusion value is 
included in an uploaded XML file, the value 
will be ignored and PREV-5 Confirmed will 
not be set to this value.  

19 = Not 
Confirmed - Age 

<pcmammogram-
confirmed>19</pcmammogram-
confirmed> 

This value is only used for export. The 
system will automatically set the value if 
the patient’s date of birth is changed in the 
GPRO Web Interface and the age makes 
the patient ineligible for the measure. If the 
age exclusion value is included in an 
uploaded XML file, the value will be 
ignored and PREV-5 Confirmed will not be 
set to this value. 

7.2.12.1.2. PREV-5 Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for any of the PREV-5 questions. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<pcmammogram-rm-
ticket>Text for ticket 
number</pcmammogram-
rm-ticket> 

None 

7.2.12.1.3. PREV-5 Screening Performed 

Determine if a mammogram to screen for breast cancer was performed during the 
measurement period or within the 27 months prior to the measurement period end date. The 
measure’s 27-month look back period applies to women ages 52-74 (the numerator looks for a 
mammogram any time on or between October 1, 27 months prior to the measurement period, 
and December 31 of the measurement period in order to capture women who have had a 
mammogram every 24 months per clinical guidelines, with a 3-month grace period). Therefore, 
women ages 50-52 are included in the measure if they had a visit and a mammogram since age 
50, but the look back only applies to patients age 52-74. 
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The table below shows the available values and appropriate XML format for Screening 
Performed. 

Available 
Values 

Sample XML Tag Other Parameters 

1 = No <pcmammogram>1</pcmammogram> None, measure is complete for this 
patient. 

2 = Yes <pcmammogram>2</pcmammogram> None, measure is complete for this 
patient. 

7.2.12.1.4. PREV-5 Comments 

The Comments for PREV-5 can be used to provide additional information for the patient related 
to the PREV-5 measure. 

The table below shows the available values and appropriate XML format for the PREV-5 
Comments. 

Available Values Sample XML Tag Other Parameters 

Text up to 140 
characters 

<pcmammogram-comments>Text for 
comment</pcmammogram-comments>  

None 

7.2.12.2. PREV-6: Colorectal Cancer Screening 

Four values for abstraction are included in the PREV-6 measure: 

• Confirmation 

• Help Desk Ticket # 

• Screening is Current 

• Comments 

Not all values may be required for the PREV-6 measure to be marked complete. Confirmation 
that the patient is qualified for the measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-6 measure must be provided before the system can 
mark the patient as complete in the PREV-6 measure. If the patient is not qualified for the 
measure, the patient is skipped in the measure and the measure quality data should not be 
provided. 

7.2.12.2.1. PREV-6 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-6 measure must be provided. If the patient is qualified for the 
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measure, all required values for the PREV-6 measure must be provided before the system can 
mark the patient as complete in the PREV-6 measure module. 

PREV-6 Confirmation provides a way to skip the patient in the PREV-6 measure on a case by 
case basis. If the patient is ranked in any other disease module, CARE measure, or PREV 
measure, the patient is only skipped in the PREV-6 module, not in all modules or patient care 
measures in which they are ranked. 

The Denominator Exclusion may be used if there is diagnosis or past history of total 
colectomy or diagnosis or past history of colorectal cancer. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the PREV-6 measure is done on a case by case basis, 
and this option may only be selected when an approval has been received from CMS in the 
form of a response to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be 
provided when this answer is selected, to complete the patient. 

The table below shows the available values and appropriate XML format for PREV-6 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pccolorectal-
confirmed>2</pccolorectal-
confirmed> 

Include required PREV-6 measure elements to 
complete the patient’s data for PREV-6. 

15 = No - Other 
CMS Approved 
Reason 

<pccolorectal-
confirmed>15</pccolorectal-
confirmed> 

Do not include PREV-6 measure elements for 
this patient; patient is skipped in this measure; 
however, selecting this option requires 
including a Help Desk ticket number. 

17 = Denominator 
Exclusion 

<pccolorectal-
confirmed>17</pccolorectal-
confirmed> 

Do not include PREV-6 measure elements for 
this patient; patient is skipped in this measure. 

19 = Not 
Confirmed - Age 

<pccolorectal-
confirmed>19</pccolorectal-
confirmed> 

This value is only used for export. The 
system will automatically set the value if the 
patient’s date of birth is changed in the GPRO 
Web Interface and the age makes the patient 
ineligible for the measure. If the age exclusion 
value is included in an uploaded XML file, the 
value will be ignored and PREV-6 Confirmed 
will not be set to this value. 

7.2.12.2.2. PREV-6 Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for any of the PREV-6 questions. 
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The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<pccolorectal-rm-
ticket>Text for ticket 
number</pccolorectal-
rm-ticket> 

None 

7.2.12.2.3. PREV-6 Screening is Current 

Determine if colorectal cancer screening is current during the measurement period. Note, 
current colorectal cancer screening is determined as performing any of the following: 

• Fecal occult blood test (FOBT) within 12 months 

• Flexible sigmoidoscopy during the reporting period or the four years prior to the reporting 
period 

• Colonoscopy during the reporting period or the nine years prior to the reporting period 

The table below shows the available values and appropriate XML format for Screening is 
Current. 

Available Values Sample XML Tag Other Parameters 

1 = No <pccolorectal>1</pccolorectal> None, measure is complete for this patient. 

2 = Yes <pccolorectal>2</pccolorectal> None, measure is complete for this patient. 

7.2.12.2.4. PREV-6 Comments 

The Comments for PREV-6 can be used to provide additional information for the patient related 
to the PREV-6 measure. 

The table below shows the available values and appropriate XML format for the PREV-6 
Comments. 

Available Values Sample XML Tag Other Parameters 

Text up to 140 
characters 

<pccolorectal-comments>Text for 
comment</pccolorectal-comments>  

None 

7.2.12.3. PREV-7: Preventive Care and Screening: Influenza Immunization 

Four values for abstraction are included in the PREV-7 measure: 
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• Confirmation 

• Help Desk Ticket # 

• Immunization Received 

• Comments 

Not all values may be required for the PREV-7 measure to be marked complete. Confirmation 
that the patient is qualified for the measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-7 measure must be provided before the system can 
mark the patient as complete in the PREV-7 measure. If the patient is not qualified for the 
measure, the patient is skipped in the measure and the measure quality data should not be 
provided. 

7.2.12.3.1. PREV-7 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-7 measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-7 measure must be provided before the system can 
mark the patient as complete in the PREV-7 measure module. 

PREV-7 Confirmation provides a way to skip the patient in the PREV-7 measure on a case by 
case basis. If the patient is ranked in any other all disease module, CARE measure, or PREV 
measure, the patient is only skipped in the PREV-7 measure, not in all modules or patient care 
measures in which they are ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the PREV-7 measure is done on a case by case basis, 
and this option may only be selected when an approval has been received from CMS in the 
form of a response to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be 
provided when this answer is selected, to complete the patient. 

The table below shows the available values and appropriate XML format for PREV-7 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pcflushot-
confirmed>2</pcflushot-
confirmed> 

Include required PREV-7 measure 
elements to complete the patient’s data for 
PREV-7. 

15 = No – Other 
CMS Approved 
Reason 

<pcflushot-
confirmed>15</pcflushot-
confirmed> 

Do not include PREV-7 measure elements 
for this patient; patient is skipped in this 
measure; however, selecting this option 
requires including a Help Desk ticket 
number. 
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Available Values Sample XML Tag Other Parameters 

19 = Not 
Confirmed - Age 

<pcflushot-
confirmed>19</pcflushot-
confirmed> 

This value is only used for export. The 
system will automatically set the value if 
the patient’s date of birth is changed in the 
GPRO Web Interface and the age makes 
the patient ineligible for the measure. If the 
age exclusion value is included in an 
uploaded XML file, the value will be 
ignored and PREV-7 Confirmed will not be 
set to this value.  

7.2.12.3.2. PREV-7 Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for any of the PREV-7 questions. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<pcflushot-rm-
ticket>Text for ticket 
number</pcflushot-rm-
ticket> 

None 

7.2.12.3.3. PREV-7 Immunization Received 

Determine if the patient was seen for a visit between October 1 and March 31 and received an 
influenza immunization OR reported previous receipt of an influenza immunization. The flu 
season includes visits from October through December of the year prior to the measurement 
period or January through March of the measurement period. 

The table below shows the available values and appropriate XML format for Influenza 
Immunization. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcflushot>1</pcflushot> None, measure is complete for 
this patient. 

2 = Yes <pcflushot>2</pcflushot> None, measure is complete for 
this patient. 

4 = No – Denominator 
Exception - Medical 
Reasons 

<pcflushot>4</pcflushot> None, measure is complete for 
this patient. 
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Available Values Sample XML Tag Other Parameters 

5 = No – Denominator 
Exception - Patient 
Reasons 

<pcflushot>5</pcflushot> None, measure is complete for 
this patient. 

6 = No – Denominator 
Exception - System 
Reasons 

<pcflushot>6</pcflushot> None, measure is complete for 
this patient. 

7.2.12.3.4. PREV-7 Comments 

The Comments for PREV-7 can be used to provide additional information for the patient related 
to the PREV-7 measure. 

The table below shows the available values and appropriate XML format for the PREV-7 
Comments. 

Available Values Sample XML Tag Other 
Parameters 

Text up to 140 
characters 

<pcflushot-comments>Text for 
comment</pcflushot-comments>  

None 

7.2.12.4. PREV-8: Pneumonia Vaccination Status for Older Adults 

Four values for abstraction are included in the PREV-8 measure: 

• Confirmation 

• Help Desk Ticket # 

• Vaccination Received 

• Comments 

Not all values may be required for the PREV-8 measure to be marked complete. Confirmation 
that the patient is qualified for the measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-8 measure must be provided before the system can 
mark the patient as complete in the PREV-8 measure. If the patient is not qualified for the 
measure, the patient is skipped in the measure and the measure quality data should not be 
provided. 

7.2.12.4.1. PREV-8 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-8 measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-8 measure must be provided before the system can 
mark the patient as complete in the PREV-8 measure module. 
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PREV-8 Confirmation provides a way to skip the patient in the PREV-8 measure on a case by 
case basis. If the patient is ranked in any other disease module, CARE measure, or PREV 
measure, the patient is only skipped in the PREV-8 module, not in all modules or patient care 
measures in which they are ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the PREV-8 measure is done on a case by case basis, 
and this option may only be selected when an approval has been received from CMS in the 
form of a response to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be 
provided when this answer is selected, to complete the patient. 

The table below shows the available values and appropriate XML format for PREV-8 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pcpneumoshot-
confirmed>2</pcpneumosh
ot-confirmed> 

Include required PREV-8 measure 
elements to complete the patient’s data 
for PREV-8. 

15 = No - Other 
CMS Approved 
Reason 

<pcpneumoshot-
confirmed>15</pcpneumos
hot-confirmed> 

Do not include PREV-8 measure 
elements for this patient; patient is 
skipped in this measure; however, 
selecting this option requires including a 
Help Desk ticket number. 

19 = Not Confirmed 
- Age 

<pcpneumoshot-
confirmed>19</pcpneumos
hot-confirmed> 

This value is only used for export. The 
system will automatically set the value if 
the patient’s date of birth is changed in 
the GPRO Web Interface and the age 
makes the patient ineligible for the 
measure. If the age exclusion value is 
included in an uploaded XML file, the 
value will be ignored and PREV-8 
Confirmed will not be set to this value. 

7.2.12.4.2. PREV-8 Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for any of the PREV-8 questions. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 
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Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<pcpneumoshot-rm-
ticket>Text for ticket 
number</pcpneumoshot-
rm-ticket> 

None 

7.2.12.4.3. PREV-8 Vaccination Received 

Determine if the patient has ever received a pneumococcal vaccination. 

The table below shows the available values and appropriate XML format for Vaccination 
Received. 

Available 
Values 

Sample XML Tag Other Parameters 

1 = No <pcpneumoshot>1</pcpneumoshot> None, measure is complete for this 
patient. 

2 = Yes <pcpneumoshot>2</pcpneumoshot> None, measure is complete for this 
patient. 

7.2.12.4.4. PREV-8 Comments 

The Comments for PREV-8 can be used to provide additional information for the patient related 
to the PREV-8 measure. 

The table below shows the available values and appropriate XML format for the PREV-8 
Comments. 

Available Values Sample XML Tag Other Parameters 

Text up to 140 
characters 

<pcpneumoshot-comments>Text for 
comment</pcpneumoshot-comments>  

None 

7.2.12.5. PREV-9: Preventive Care and Screening: Body Mass Index (BMI) Screening and Follow-Up 
Plan 

Six values for abstraction are included in the PREV-9 measure: 

• Confirmation 

• Help Desk Ticket # 

• BMI Calculated 

• BMI Normal 
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• BMI Follow Up 

• Comments 

Not all values may be required for the PREV-9 measure to be marked complete. The PREV-9 
Confirmation must be provided. If the patient is qualified for the measure, the BMI Calculated 
value is required. 

If the BMI was calculated, the BMI Normal value must be provided. If the BMI was not 
calculated, the BMI Normal value should not be provided. 

If the BMI is not normal, the Follow-Up Plan value must be provided. If the BMI is normal, the 
Follow-Up Plan value should not be provided. 

If the patient is not qualified for the measure, the patient is skipped in the measure and the 
measure data should not be provided. The PREV-9 measure will be marked as complete for the 
patient when all required fields have a value provided. 

7.2.12.5.1. PREV-9 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-9 measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-9 measure must be provided before the system can 
mark the patient as complete in the PREV-9 measure module. 

PREV-9 Confirmation provides a way to skip the patient in the PREV-9 measure on a case by 
case basis. If the patient is ranked in any other disease module, CARE measure, or PREV 
measure, the patient is only skipped in the PREV-9 measure, not in all modules or patient care 
measures in which they are ranked. 

The Denominator Exclusion may be used for pregnancy. Note: Pregnancy cannot end before 
start of the measurement period. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the PREV-9 measure is done on a case by case basis, 
and this option may only be selected when an approval has been received from CMS in the 
form of a response to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be 
provided when this answer is selected, to complete the patient. 

The table below shows the available values and appropriate XML format for PREV-9 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pcbmiscreen-
confirmed>2</pcbmiscreen-
confirmed>  

Include required PREV-9 measure 
elements to complete the patient’s data for 
PREV-9. 
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Available Values Sample XML Tag Other Parameters 

15 = No - Other 
CMS Approved 
Reason 

<pcbmiscreen-
confirmed>15</pcbmiscreen-
confirmed>  

Do not include PREV-9 measure elements 
for this patient; patient is skipped in this 
measure; however, selecting this option 
requires including a Help Desk ticket 
number. 

17 = Denominator 
Exclusion 

<pcbmiscreen-
confirmed>17</pcbmiscreen-
confirmed>  

Do not include PREV-9 measure elements 
for this patient; patient is skipped in this 
measure. 

19 = Not 
Confirmed - Age 

<pcbmiscreen-
confirmed>19</pcbmiscreen-
confirmed>  

This value is only used for export. The 
system will automatically set the value if 
the patient’s date of birth is changed in the 
GPRO Web Interface and the age makes 
the patient ineligible for the measure. If the 
age exclusion value is included in an 
uploaded XML file, the value will be 
ignored and PREV-9 Confirmed will not be 
set to this value. 

7.2.12.5.2. PREV-9 Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for any of the PREV-9 questions. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<pcbmiscreen-rm-
ticket>Text for ticket 
number</pcbmiscreen-
rm-ticket> 

None 

7.2.12.5.3. PREV-9: BMI Calculated 

There are three determinations to be made with respect to calculating a BMI: 

• Determine if a BMI was Calculated 

• Determine if BMI is Normal 

• Determine if Follow-Up Plan is Documented 
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7.2.12.5.3.1. Determine if a BMI was Calculated 

Determine if the patient had a Body Mass Index (BMI) calculated during the most recent visit or 
in the last six months prior to the most recent visit. 

Calculated BMI requires an eligible professional or their staff to measure both the height and 
weight. Self-reported values cannot be used. 

The table below shows the available values and appropriate XML format for BMI Calculated. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcbmicalculated>1</pcbmicalc
ulated>  

Do not provide the BMI Normal value 
and Follow-Up Plan value, measure 
is complete for this patient. 

2 = Yes <pcbmicalculated>2</pcbmicalc
ulated>  

Provide the BMI Normal value and 
conditionally the Follow-Up Plan 
value to complete the measure for this 
patient. 

7.2.12.5.3.2. Determine if BMI is Normal 

If the BMI was calculated, determine if the patient’s most recent BMI is within normal 
parameters. Normal parameters for BMI: 

• Age 65 and older BMI ≥ 23 and < 30 

• Age 18-64 BMI ≥ 18.5 and < 25 

The table below shows the available values and appropriate XML format for BMI Normal. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcbminormal>1</pcbminor
mal> 

Provide the BMI Calculated value and 
Follow-Up Plan value to complete the 
measure for this patient. 

2 = Yes <pcbminormal>2</pcbminor
mal> 

Provide the BMI Calculated value to 
complete the measure for this patient. 

Do not provide the Follow-Up Plan value 

7.2.12.5.3.3. Determine if Follow-Up Plan is Documented 

If the BMI is outside of parameters, determine if a follow-up plan is documented during the 
encounter or during the previous six months of the encounter. The documentation of a follow-up 
plan must be based on the most recent documented BMI within the previous six months. 
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The table below shows the available values and appropriate XML format for PREV-9 Follow-Up 
Plan. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcbmiplan>1</pcbmipl
an> 

Provide the BMI Calculated value and BMI 
Normal value to complete the measure for 
this patient. 

2 = Yes <pcbmiplan>2</pcbmipl
an> 

Provide the BMI Calculated value and BMI 
Normal value to complete the measure for 
this patient. 

7.2.12.5.4. PREV-9 Comments 

The Comments for PREV-9 can be used to provide additional information for the patient related 
to the PREV-9 measure. 

The table below shows the available values and appropriate XML format for the PREV-9 
Comments. 

Available Values Sample XML Tag Other Parameters 

Text up to 140 
characters 

<pcbmi-comments>Text for 
comment</pcbmi-comments>  

None 

7.2.12.6. PREV-10: Preventive Care and Screening: Tobacco Use: Screening and Cessation 
Intervention 

Five values for abstraction are included in the PREV-10 measure: 

• Confirmation 

• Help Desk Ticket # 

• Patient Screened for Tobacco Use 

• Cessation Counseling Intervention 

• Comments 

Not all values may be required for the PREV-10 measure to be marked complete. The PREV-10 
Confirmation must be provided. If the patient is not qualified for the measure, the patient is 
skipped in the measure and the measure quality data should not be provided. 

If the patient is qualified for the measure, the Tobacco Use value is required. 

If the patient was screened for tobacco use and identified as a tobacco user, a value for 
Cessation Counseling must be provided. If the patient was screened for tobacco use and 
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identified as a tobacco non-user or the patient was not screened for tobacco use or status is 
unknown, a value for Cessation Counseling should not be provided. 

The PREV-10 measure will be marked as complete for the patient when all required fields have 
a value provided. 

7.2.12.6.1. PREV-10 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-10 measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-10 measure must be provided before the system can 
mark the patient as complete in the PREV-10 measure module. 

PREV-10 Confirmation provides a way to skip the patient in the PREV-10 measure on a case 
by case basis. If the patient is ranked in any other disease module, CARE measure, or PREV 
measure, the patient is only skipped in the PREV-10 measure, not in all modules or patient care 
measures in which they are ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the PREV-10 is done on a case by case basis, and this 
option may only be selected when an approval has been received from CMS in the form of a 
response to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be provided 
when this answer is selected, to complete the patient. 

The table below shows the available values and appropriate XML format for PREV-10 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pctobaccouse-
confirmed>2</pctobaccouse-
confirmed> 

Include required PREV-10 measure 
elements to complete the patient’s data 
for PREV-10. 

15 = No - Other 
CMS Approved 
Reason 

<pctobaccouse-
confirmed>15</pctobaccouse-
confirmed> 

Do not include PREV-10 measure 
elements for this patient; patient is 
skipped in this measure; however, 
selecting this option requires including 
a Help Desk ticket number. 

19 = Not Confirmed 
- Age 

<pctobaccouse-
confirmed>19</pctobaccouse-
confirmed> 

This value is only used for export. 
The system will automatically set the 
value if the patient’s date of birth is 
changed in the GPRO Web Interface 
and the age makes the patient ineligible 
for the measure. If the age exclusion 
value is included in an uploaded XML 
file, the value will be ignored and 
PREV-10 Confirmed will not be set to 
this value.  
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7.2.12.6.2. PREV-10 Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for any of the PREV-10 questions. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<pctobaccouse-rm-
ticket>Text for ticket 
number</pctobaccouse-
rm-ticket> 

None 

7.2.12.6.3. PREV-10 Tobacco Use 

Once tobacco use has been confirmed, the following must be indicated: 

• Determine if the Patient Screened for Tobacco Use 

• Determine Cessation Counseling Intervention 

7.2.12.6.3.1. Determine if the Patient was Screened for Tobacco Use 

Determine if the patient was screened for tobacco use at least once within 24 months AND 
identified as a tobacco user. 

Note: If tobacco use status of “unknown” is recorded but the patient has an allowable medical 
exception, then report as a valid exception. 

Note: If there is more than 1 patient query regarding tobacco use, use the most recent. 

The table below shows the available values and appropriate XML format for Tobacco Use. 

Available Values Sample XML Tag Other Parameters 

1 = No 

(Screened for tobacco use 
and identified as a 
tobacco non-user) 

<pctobaccoscreen>1</pctobaccoscr
een> 

Do not provide the Cessation 
Intervention value, measure 
is complete for this patient 

2 = Yes 

(Screened for tobacco use 
and identified as a 
tobacco user) 

<pctobaccoscreen>2</pctobaccoscr
een> 

Provide the Cessation 
Counseling value 
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Available Values Sample XML Tag Other Parameters 

4 = No – Denominator 
Exception - Medical 
Reasons 

<pctobaccoscreen>4</pctobaccoscr
een> 

Do not provide the Cessation 
Intervention value, measure 
is complete for this patient 

14 = Not 
Screened/Unknown 

(Not screened for tobacco 
use or tobacco use status 
unknown) 

<pctobaccoscreen>14</pctobaccos
creen> 

Do not provide the Cessation 
Intervention value, measure 
is complete for this patient 

7.2.12.6.3.2. Determine Cessation Counseling Intervention 

Determine if tobacco cessation counseling intervention was received if the patient was identified 
as a tobacco user. 

The table below shows the available values and appropriate XML format for Cessation 
Counseling Intervention. 

Available Values Sample XML Tag Other Parameters 

1 = No <pctobaccocounsel>1</pctobaccoc
ounsel> 

Provide the Tobacco Use value 
to complete the measure for this 
patient 

2 = Yes <pctobaccocounsel>2</pctobaccoc
ounsel> 

Provide the Tobacco Use value 
to complete the measure for this 
patient 

7.2.12.6.4. PREV-10 Comments 

The Comments for PREV-10 can be used to provide additional information for the patient 
related to the PREV-10 measure. 

The table below shows the available values and appropriate XML format for the PREV-10 
Comments. 

Available Values Sample XML Tag Other Parameters 

Text up to 140 
characters 

<pctobaccouse-comments>Text for 
comment</pctobaccouse-comments>  

None 

7.2.12.7. PREV-11: Preventive Care and Screening: Screening for High Blood Pressure and Follow-
Up Documented 

Six values for abstraction are included in the PREV-11 individually sampled measure: 
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• Confirmation 

• Help Desk Ticket # 

• High Blood Pressure Screening 

• Normal Blood Pressure 

• Blood Pressure not Normal / Follow-Up Plan 

• Comments 

Not all values may be required for the PREV-11 measure to be marked complete. Confirmation 
that the patient is qualified for the measure must be provided. If the patient is not qualified for 
the measure or has denominator exclusion, the patient is skipped in the measure, and the 
measure quality data should not be provided. 

If the patient is qualified, an indicator that the patient was screened for high blood pressure must 
be provided. 

If the patient was screened, the indicator of blood pressure within normal parameters must be 
provided. If the patient was not screened, the indicator of blood pressure within normal 
parameters should not be provided. 

If the blood pressure is not within normal parameters, an indicator of documentation of a follow-
up plan must be provided. If the blood pressure is within normal parameters, indicator of 
documentation of a follow-up plan should not be provided. 

The PREV-11 measure will be marked as complete for the patient when all required fields have 
a value provided. 

7.2.12.7.1. PREV-11 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-11 measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-11 measure must be provided before the system can 
mark the patient as complete in the PREV-11 measure module. 

PREV-11 Confirmation provides a way to skip the patient in the PREV-11 measure on a case 
by case basis. If the patient is ranked in any other disease module, CARE measure, or PREV 
measure, the patient is only skipped in the PREV-11 measure, not in all modules or patient care 
measures in which they are ranked. 

The Denominator Exclusion may be used if there is an active diagnosis of hypertension. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the PREV-11 measure is done on a case by case basis, 
and this option may only be selected when an approval has been received from CMS in the 
form of a response to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be 
provided when this answer is selected, to complete the patient. 
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The table below shows the available values and appropriate XML format for PREV-11 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pcbloodpressure-
confirmed>2</pcbloodpressure-
confirmed> 

Include required PREV-11 measure 
elements to complete the patient’s 
data for PREV-11. 

15 = No – Other CMS 
Approved Reason 

<pcbloodpressure-
confirmed>15</pcbloodpressure-
confirmed> 

Do not include PREV-11 measure 
elements for this patient; patient is 
skipped in this measure; however, 
selecting this option requires 
including a Help Desk ticket number. 

17 = Denominator 
Exclusion 

<pcbloodpressure-confirmed>-
17</pcbloodpressure-confirmed> 

Do not include PREV-11 measure 
elements for this patient; patient is 
skipped in this measure. 

19 = Not Confirmed - 
Age 

<pcbloodpressure-confirmed>-
19</pcbloodpressure-confirmed> 

This value is only used for export. 
The system will automatically set the 
value if the patient’s date of birth is 
changed in the GPRO Web Interface 
and the age makes the patient 
ineligible for the measure. If the age 
exclusion value is included in an 
uploaded XML file, the value will be 
ignored and PREV-11 Confirmed will 
not be set to this value. 

7.2.12.7.2. PREV-11 Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for any of the PREV-11 questions. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<pcbloodpressure-rm-
ticket>Text for ticket 
number</pcbloodpressure-
rm-ticket> 

None 

7.2.12.7.3. PREV-11 Blood Pressure Screening 

Determine if the patient was screened for high blood pressure during the measurement period. 
Note: Use most recent blood pressure. 
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The table below shows the available values and appropriate XML format for Blood Pressure 
Screening. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcbloodpressure>1</pcbloodpres
sure> 

None, measure is complete for 
this patient. 

2 = Yes <pcbloodpressure>2</pcbloodpres
sure> 

Provide the Blood Pressure 
Normal value and conditionally, 
the Follow-up Plan value to 
complete the measure for this 
patient. 

4 = No – Denominator 
Exception - Medical 
Reasons 

<pcbloodpressure>4</pcbloodpres
sure> 

None, measure is complete for 
this patient. 

5 = No - Denominator 
Exception - Patient 
Reasons 

<pcbloodpressure>5</pcbloodpre
ssure> 

None, measure is complete for 
this patient. 

7.2.12.7.4. PREV-11 Blood Pressure within Normal Parameters 

Determine if the most recent blood pressure is within normal parameters [<120 (systolic) AND < 
80 (diastolic)]. 

Note: Although recommended screening interval for a normal BP reading is every 2 years, to 
meet the intent of this measure, a BP screening must be performed once per measurement 
period. The intent of this measure is to screen patients for high blood pressure. 

The Normal Blood Pressure follow-up is not recommended for patients with clinical or 
symptomatic hypotension. 

The table below shows the available values and appropriate XML format for Blood Pressure 
Normal. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcbpnormal>1</pcbpnorm
al>  

Provide the Blood Pressure Screening 
value and the Follow-up Plan value to 
complete the measure for this patient. 

2 = Yes <pcbpnormal>2</pcbpnorm
al>  

Provide the Blood Pressure Screening 
value to complete the measure for this 
patient. 



XML Specifications 

GPRO Web Interface XML Specification V1.0 79 PQRS PY2016 

7.2.12.7.5. PREV-11 Recommended Follow-Up Plan is Documented 

If patient’s most recent blood pressure was not within normal parameters, determine if a 
recommended follow-up plan was documented. 

The table below shows the available values and appropriate XML format for Follow-Up Plan. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcbpfollowup>1</pcbpfoll
owup> 

Provide the Blood Pressure Screening 
value and the Blood Pressure Normal 
value to complete the measure for this 
patient. 

2 = Yes <pcbpfollowup>2</pcbpfoll
owup> 

Provide the Blood Pressure Screening 
value and the Blood Pressure Normal 
value to complete the measure for this 
patient. 

5 = No – 
Denominator 
Exception - Patient 
Reasons 

<pcbpfollowup>5</pcbpfoll
owup> 

Provide the Blood Pressure Screening 
value and the Blood Pressure Normal 
value to complete the measure for this 
patient. 

7.2.12.7.6. PREV-11 Comments 

The Comments for PREV-11 can be used to provide additional information for the patient 
related to the PREV-11 measure. 

The table below shows the available values and appropriate XML format for the PREV-11 
Comments. 

Available Values Sample XML Tag Other 
Parameters 

Text up to 140 
characters 

<pcbp-comments>Text for comment</pcbp-
comments>  

None 

7.2.12.8. PREV-12: Preventive Care and Screening: Screening for Clinical Depression and Follow-Up 
Plan 

Six values for abstraction are included in the PREV-12 measure: 

• Confirmation 

• Help Desk Ticket # 

• Patient Screened for Clinical Depression 
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• Patient Positive for Clinical Depression 

• Follow-Up Plan for Clinical Depression Documented 

• Comments 

Not all values may be required for the PREV-12 measure to be marked complete. The PREV-12 
Confirmation must be provided. If the patient is not qualified for the measure or has a 
denominator exclusion, the patient is skipped in the measure and the measure quality data 
should not be provided. 

If the patient is qualified for the PREV-12 measure, the Clinical Depression Screening value 
must be provided. 

If the patient was screened for Clinical Depression, a value for Positive for Clinical 
Depression must be provided. If the patient was not screened for clinical depression, the 
Positive for Clinical Depression value should not be provided. 

If the patient is positive for clinical depression, a value for Follow-Up Plan must be provided. If 
patient is not positive for clinical depression, a value for Follow-Up Plan should not be 
provided. 

7.2.12.8.1. PREV-12 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-12 measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-12 measure must be provided before the system can 
mark the patient as complete in the PREV-12 measure module. 

PREV-12 Confirmation provides a way to skip the patient in the PREV-12 measure on a case 
by case basis. If the patient is ranked in any other disease module, CARE measure, PREV 
measure, the patient is only skipped in the PREV-12 module, not in all modules or patient care 
measures in which they are ranked. 

The Denominator Exclusion may be used if there is an active diagnosis for depression or 
bipolar disorder. Note: Diagnosed prior to the first day of the measurement period. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the PREV-12 measure is done on a case by case basis, 
and this option may only be selected when an approval has been received from CMS in the 
form of a response to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be 
provided when this answer is selected, to complete the patient. 

The table below shows the available values and appropriate XML format for PREV-12 
Confirmation. 
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Available Values Sample XML Tag Other Parameters 

2 = Yes <pcdepression-
confirmed>2</pcdepression-
confirmed> 

Include required PREV-12 measure 
elements to complete the patient’s data 
for PREV-12 

15 = No - Other 
CMS Approved 
Reason 

<pcdepression-
confirmed>15</pcdepression-
confirmed> 

Do not include PREV-12 measure 
elements for this patient; patient is 
skipped in this measure; however, 
selecting this option requires including a 
Help Desk ticket number. 

17 = Denominator 
Exclusion 

<pcdepression-
confirmed>17</pcdepression-
confirmed> 

Do not include PREV-12 measure 
elements for this patient; patient is 
skipped in this measure.  

19 = Not 
Confirmed - Age 

<pcdepression-
confirmed>19</pcdepression-
confirmed> 

This value is only used for export. The 
system will automatically set the value if 
the patient’s date of birth is changed in the 
GPRO Web Interface and the age makes 
the patient ineligible for the measure. If 
the age exclusion value is included in an 
uploaded XML file, the value will be 
ignored and PREV-12 Confirmed will not 
be set to this value.  

7.2.12.8.2. PREV-12 Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have selected the No - Other CMS 
Approved Reason option for any of the PREV-12 questions. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<pcdepression-rm-
ticket>Text for ticket 
number</pcdepression-
rm-ticket> 

None 

7.2.12.8.3. Determine if the Patient was Screened for Clinical Depression 

Determine if the patient was screened for clinical depression using an age appropriate 
standardized tool during the measurement period. Note: Use most recent screening for 
depression 

Note: Although the patient may have access to the depression screening tool in advance of the 
appointment, the depression screening results must be documented on the date of the 
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encounter (date of appointment). The results must be reviewed/verified and documented by the 
eligible professional in the medical record on the date of the encounter to meet the screening 
portion of this measure. 

The table below shows the available values and appropriate XML format for Clinical 
Depression Screening. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcdepression>1</pcdepression> Do not provide the Positive for 
Clinical Depression value and 
Follow-Up Plan value, measure is 
complete for this patient. 

2 = Yes <pcdepression>2</pcdepression> Provide the Positive for Clinical 
Depression and conditionally provide 
the Follow-Up Plan value to complete 
the measure for this patient. 

4 = No – 
Denominator 
Exception - Medical 
Reasons 

<pcdepression>4</pcdepression> Do not provide the Positive for 
Clinical Depression value and 
Follow-Up Plan value, measure is 
complete for this patient. 

5 = No – 
Denominator 
Exception - Patient 
Reasons 

<pcdepression>5</pcdepression> Do not provide the Positive for 
Clinical Depression value and 
Follow-Up Plan value, measure is 
complete for this patient. 

7.2.12.8.4. Determine if the Patient was Positive for Clinical Depression 

If the patient was screened, determine if the screen was positive for clinical depression during 
the measurement period. 

The table below shows the available values and appropriate XML format for Positive for 
Clinical Depression. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcdepression-
positive>1</pcdepression-
positive> 

Provide the Clinical Depression 
Screening value. 

Do not provide the Follow-Up Plan 
value, measure is complete for this 
patient. 

2 = Yes <pcdepression-
positive>2</pcdepression-
positive> 

Provide the Clinical Depression 
Screening value and Follow-Up Plan 
value to complete the measure for this 
patient. 
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7.2.12.8.5. Determine if Follow-Up Plan is Documented 

If the patient had a positive screen for clinical depression, determine if a follow-up plan for 
depression was documented during the measurement period. 

The table below shows the available values and appropriate XML format for depression Follow-
Up Plan. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcdepression-
plan>1</pcdepression-
plan> 

Provide the Clinical Depression Screening value 
and Positive for Clinical Depression value to 
complete the measure for this patient. 

2 = Yes <pcdepression-
plan>2</pcdepression-
plan> 

Provide the Clinical Depression Screening value 
and Positive for Clinical Depression value to 
complete the measure for this patient. 

7.2.12.8.6. PREV-12 Comments 

The Comments for PREV-12 can be used to provide additional information for the patient 
related to the PREV-12 measure. 

The table below shows the available values and appropriate XML format for the PREV-12 
Comments. 

Available Values Sample XML Tag Other Parameters 

Text up to 140 
characters 

<pcdepression-comments>Text for 
comment</pcdepression-comments> 

None 

7.2.12.9. PREV-13: Statin Therapy for the Prevention and Treatment of Cardiovascular Disease 

Seven values for abstraction are included in the PREV-13 measure: 

• ASCVD Diagnosed 

• LDL-C > or = 190 mg/dL 

• Type 1 or 2 Diabetes 

• LDL-C Between 70-189 mg/dL 

• Help Desk Ticket # 

• Statin Used or Prescribed 

• Comments 
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Not all values may be required for the PREV-13 measure to be marked complete. If the patient 
is not qualified for the measure or has a denominator exception, the patient is skipped in the 
measure and the measure quality data should not be provided. 

7.2.12.9.1. ASCVD Diagnosed 

Determine if the patient has an active diagnosis of ASCVD or a history of ASCVD at any time up 
through the last day of the measurement period. 

The table below shows the available values and appropriate XML format for ASCVD 
Diagnosed. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pcstatin-ascvd>2</ pcstatin-
ascvd> 

Answering Yes requires answering the 
Statin Used or Prescribed question. 

15 = No - Other 
CMS Approved 
Reason 

<pcstatin-
ascvd>15</pcstatin-ascvd> 

This value causes the patient to be 
skipped; however, selecting this option 
requires including a Help Desk ticket 
number.  

19 = Not 
Confirmed - Age 

<pcstatin-
ascvd>19</pcstatin-ascvd> 

This value is only used for export. The 
system will automatically set the value if 
the patient’s date of birth is changed in the 
GPRO Web Interface and the age makes 
the patient ineligible for the measure. If 
the age exclusion value is included in an 
uploaded XML file, the value will be 
ignored. 

23 = No – 
Diagnosis 

<pcstatin-
ascvd>23</pcstatin-ascvd> 

Answering No – Diagnosis requires 
answering the LDL-C > or = 190 mg/dL 
question. 

7.2.12.9.2. LDL-C > or = 190 mg/dL 

Determine if the patient has ever had a fasting or direct LDL-C reading of 190 mg/dL or higher. 

Note: Answering this question requires having answered the ASCVD Diagnosed question with 
a value of 23 (No – Diagnosis). 

The table below shows the available values and appropriate XML format for LDL-C > or = 190 
mg/dL. 
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Available 
Values Sample XML Tag Other Parameters 

1 = No <pcstatin-
ldlc>1</pcstatin-
ldlc> 

Answering No requires answering the Type 1 or 2 
Diabetes question. 

2 = Yes <pcstatin-
ldlc>2</pcstatin-
ldlc> 

Answering Yes requires answering the Statin Used or 
Prescribed question. 

15 = No - Other 
CMS Approved 
Reason 

<pcstatin-
ldlc>15</pcstatin-
ldlc> 

This value causes the patient to be skipped; however, 
selecting this option requires including a Help Desk ticket 
number. 

19 = Not 
Confirmed – 
Age 

<pcstatin-
ldlc>19</pcstatin-
ldlc> 

This value is only used for export. The system will 
automatically set the value if the patient’s date of birth is 
changed in the GPRO Web Interface and the age makes 
the patient ineligible for the measure. If the age exclusion 
value is included in an uploaded XML file, the value will 
be ignored. 

7.2.12.9.3. Type 1 or 2 Diabetes 

Determine if the patient is both: 

1) Diagnosed with Type 1 or 2 diabetes AND 

2) Age 40-75 

Note: Answering this question requires having answered both the ASCVD Diagnosed question 
with a value of 23 (No – Diagnosis) and the LDL-C > or = 190 mg/dL question with a value of 
1 (No). 

The table below shows the available values and appropriate XML format for Type 1 or 2 
Diabetes. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcstatin-diabetes>1</pcstatin-
diabetes> 

Answering No marks the patient as 
skipped for this measure. No other 
questions are required. 

2 = Yes <pcstatin-diabetes>2</pcstatin-
diabetes> 

Answering Yes requires answering the 
LDL-C Between 70-189 mg/dL 
question. 
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Available Values Sample XML Tag Other Parameters 

15 = No - Other 
CMS Approved 
Reason 

<pcstatin-diabetes>15</pcstatin-
diabetes> 

This value causes the patient to be 
skipped; however, selecting this option 
requires including a Help Desk ticket 
number. 

19 = Not Confirmed 
- Age 

<pcstatin-diabetes>19</pcstatin-
diabetes> 

This value is only used for export. 
The system will automatically set the 
value if the patient’s date of birth is 
changed in the GPRO Web Interface 
and the age makes the patient 
ineligible for the measure. If the age 
exclusion value is included in an 
uploaded XML file, the value will be 
ignored. 

7.2.12.9.4. LDL-C Between 70-189 mg/dL 

Determine if patient’s highest LDL-C reading within the last three years is between 70-189 
mg/dL.  

Note: Answering this question requires having answered prior questions as follows: 

• ASCVD Diagnosed with a value of 23 (No – Diagnosis)  

• LDL-C > or = 190 mg/dL with a value of 1 (No) 

• Type 1 or 2 Diabetes with a value of 2 (Yes) 

The table below shows the available values and appropriate XML format for LDL-C Between 
70-189 mg/dL. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcstatin-ldlc-
reading>1</pcstatin-
ldlc-reading> 

Answering No marks the patient as skipped for this 
measure. No other questions are required. 

2 = Yes <pcstatin-ldlc-
reading>2</pcstatin-
ldlc-reading> 

Answering Yes requires answering the Statin Used 
or Prescribed question. 

15 = No - Other 
CMS Approved 
Reason 

<pcstatin-ldlc-
reading>15</pcstatin-
ldlc-reading> 

This value causes the patient to be skipped; 
however, selecting this option requires including a 
Help Desk ticket number. 
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7.2.12.9.5. PREV-13 Help Desk Ticket # 

Note: The Help Desk Ticket # field is only required if you have entered a value of 15 (No - 
Other CMS Approved Reason) for any of the PREV-13 questions where 15 is a valid value. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<pcstatin-rm-
ticket>Text for ticket 
number</pcstatin-rm-
ticket> 

None 

7.2.12.9.6. Statin Used or Prescribed 

Determine if the patient is currently using or is prescribed a statin. 

Note: Answering this question requires having answered prior questions as follows: 

• ASCVD Diagnosed with a value of 2 (Yes) 

OR 

• LDL-C > or = 190 mg/dL with a value of 2 (Yes) AND ASCVD Diagnosed with a value 
of 23 (No - Diagnosis) 

OR 

• LDL-C Between 70-189 mg/dL with a value of 2 (Yes) AND Type 1 or 2 Diabetes with 
a value of 2 (Yes) AND LDL-C > or = 190 mg/dL with a value of 1 (No) AND ASCVD 
Diagnosed with a value of 23 (No - Diagnosis) 

The table below shows the available values and appropriate XML format for Statin Used or 
Prescribed. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcstatin-
prescribed>1</pcstatin- 
prescribed> 

None, measure is complete for this patient. 

2 = Yes <pcstatin-
prescribed>2</pcstatin- 
prescribed> 

None, measure is complete for this patient. 
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Available Values Sample XML Tag Other Parameters 

4 = No - 
Denominator 
Exception - 
Medical Reasons 

<pcstatin-
prescribed>4</pcstatin- 
prescribed> 

None, measure is complete for this patient. 

7.2.12.9.7. PREV-13 Comments 

The Comments for PREV-13 can be used to provide additional information for the patient 
related to the PREV-13 measure. 

The table below shows the available values and appropriate XML format for the PREV-13 
Comments. 

Available Values Sample XML Tag Other Parameters 

Text up to 140 
characters 

<pcstatin-comments>Text for 
comment</pcstatin-comments> 

None 

7.3. Patient Medications XML 
The Patient Medications XML can be used to export currently stored data for the patients 
ranked in the CARE-3 measure or to update the patient data for CARE-3 by uploading an XML 
file. 

The Patient Medications XML file generated by the GPRO Web Interface will only include the 
patients ranked in CARE-3. If a patient is ranked in the measure, but data has not been stored 
in the database for the associated XML elements, the elements will be included, but the element 
will be an empty tag. The visit dates are pre-populated during the sampling. Visit dates cannot 
be modified, added, or deleted during the submission period. 

Appendix B – XML Elements for Patient Discharge Medications XML File, lists all possible XML 
elements for the Patient Medications file in the required order.  

7.3.1. XML Declaration and Submission Header 
The XML Declaration must meet the following three requirements or it will be rejected as an 
invalid file: 

1. The XML Declaration must be on the first line 

2. The XML Declaration may not contain any other XML elements 

3. The XML Declaration must be an exact match for the valid value specified in Appendix B 
– XML Elements for Patient Medications XML File 
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A Submission Header is required at the beginning of each Patient Medications XML file. The 
opening tag for the Submission Header should be the first XML element in the file, and the 
closing tag for the submission header should be the last XML element in the file. The 
submission opening element <web-interface-submission> and submission closing element 
</web-interface-submission> may occur once in the file, and all submission data must be 
between the opening and closing elements. The data in the opening submission element should 
match the text exactly or the file will be rejected for invalid format. 

7.3.2. Group Identification 
The Group Identification provides the type of submission data and the Primary Taxpayer 
Identification Number for ACOs or the Taxpayer Identification Number for PQRS group 
practices. The Group Identification XML elements are sub elements of the <submission> 
element. All data for the patients in the group must be included between the opening <web-
interface> element and the closing </web-interface> element. For ACOs, the Primary Taxpayer 
Identification Number in the file must match the Primary Taxpayer Identification Number 
associated to the identity management account of the user submitting the file. For PQRS group 
practices, the Taxpayer Identification Number in the file must match the Taxpayer Identification 
Number associated to the identity management account of the user submitting the file. 

The table below shows the appropriate XML format with a sample TIN for the Group 
Identification TIN. 

Available Values Sample XML Tag Other Parameters 

Character <group-tin>0000000000</group-tin> Include XML elements for patient data. 

7.3.3. Patient Demographics 
The opening <patient> element and the closing </patient> element are used for each patient in 
the file. Data for a patient must be between an opening <patient> and closing </patient> 
element, but the <patient> elements may be repeated as often as necessary for a patient with 
multiple visits. The Medicare ID is the unique identifier for the patient and as such is the primary 
key. 

The Medicare ID is the unique identifier for the patient and is required for each patient. 

The Medical Record Number, Other Identifier, National Provider Identifiers (NPIs), Clinic 
Identifier, and General Comments may be provided to update the existing information or to 
provide additional information not available during the patient sampling. 

The patient’s First Name, Last Name, Gender, and Date of Birth are for export only and cannot 
be updated using XML uploads. These values may only be modified using the GPRO Web 
Interface. 

The Demographics portion of the Patient Medications XML includes elements for: 

• Medicare ID 

• Patient First Name 
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• Patient Last Name 

• Patient Gender 

• Patient Birth Date 

• Medical Record Number 

• Other Identifier 

• National Provider Identifiers (NPIs) 

• Clinic Identifier 

• General Comments 

7.3.3.1. Medicare ID 

The Medicare ID must be provided in the patient data. The Medicare ID may be repeated for a 
patient in the Patient Medications XML file if the patient has multiple visits. If the Medicare ID is 
not in the database for the ACO’s Primary Taxpayer Identification Number or the PQRS group 
practice’s Taxpayer Identification Number provided in the XML file, the file will pass format 
validation, but the data associated to the invalid Medicare ID will not be processed. The 
Medicare ID is the unique identifier for the patient and as such is the primary key. 

The table below shows the appropriate XML format with a sample Medicare ID for the Medicare 
ID. 

Available Values Sample XML Tag Other Parameters 

Character <medicare-
id>000000000Z</medicare-id> 

Include XML elements for the 
measures in which the 
patient is ranked. 

7.3.3.2. Patient First Name 

The patient’s First Name as it appears in CMS’ records during the sampling process will be pre-
populated during the initial load of patient data. The XML element containing the First Name will 
be provided when exporting the patient medications data, but does not need to be provided in 
the XML upload. If the XML element for the First Name is used, the tag will be ignored and the 
patient’s First Name will not be updated. 

The table below shows the appropriate XML format with a sample name for the First Name. 

Available Values Sample XML Tag Other Parameters 

Character <patient-first-
name>First</patient-first-name> 

None, Export Only 
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7.3.3.3. Patient Last Name 

The patient’s Last Name as it appears in CMS’ records during the sampling process will be pre-
populated during the initial load of patient data. The XML element containing the Last Name will 
be provided when exporting the patient medications data, but does not need to be provided in 
the XML upload. If the XML element for the Last Name is used, the tag will be ignored and the 
patient’s Last Name will not be updated. 

The table below shows the appropriate XML format with a sample name for the Last Name. 

Available Values Sample XML Tag Other Parameters 

7.3.3.4. Patient Gender 

The patient’s Gender as it appears in CMS’ records during the sampling process will be pre-
populated during the initial load of patient data. The XML element containing the Gender will be 
provided when exporting the patient medications data, but does not need to be provided in the 
XML upload. If the XML element for the Gender is used, the tag will be ignored and the patient’s 
Gender will not be updated. 

The table below shows the available values and appropriate XML format for the Gender. 

Available Values Sample XML Tag Other Parameters 

7.3.3.5. Patient Birth Date 

The patient’s Birth Date as it appears in CMS’ records during the sampling process will be pre-
populated during the initial load of patient data. The XML element containing the Birth Date will 
be provided when exporting the patient medications data, but does not need to be provided in 
the XML upload. If the XML element for the Birth Date is used, the tag will be ignored and the 
patient’s Birth Date will not be updated. 

The table below shows the appropriate XML format for the Birth Date. 

Character <patient-last-name>Last</patient-
last-name> 

None, Export Only 

1 = Male <gender>1</gender> None, Export Only 

2 = Female <gender>2</gender> None, Export Only 

3 = Unknown <gender>3</gender> None, Export Only 
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Available Values Sample XML Tag Other Parameters 

7.3.3.6. Medical Record Number 

The Medical Record Number will not be pre-populated during the sampling process. The value 
may be added during the submission period. The Medical Record Number may be any value 
used by the group to identify the patient. 

The table below shows the appropriate XML format for the Medical Record Number. 

Available Values Sample XML Tag Other Parameters 

Character <medical-record-
number>123XYZ</medical-record-
number> 

None 

7.3.3.7. Other Identifier 

The Other Identifier will not be pre-populated during the sampling process. The value may be 
added during the submission period. The Other Identifier may be any value used by the group 
to identify the patient. 

The table below shows the appropriate XML format for the other identifier. 

Available Values Sample XML Tag Other Parameters 

7.3.3.8. Provider NPIs 

Up to three Provider NPIs (National Provider Identifiers) may be pre-populated during the 
sampling process. NPIs may be updated during the submission period. The NPI in the XML file 
must currently exist in the database. The list of existing NPIs may be obtained by exporting the 
Provider XML file or the list may be viewed on the GPRO Web Interface. If the NPI does not 
exist in the group, the XML file will pass format validation, but the patient’s NPI data will not be 
updated and an error message will be generated. 

The table below shows the appropriate XML format for the Provider NPIs. 

Valid date between 
01/01/1900 and 
6/30/[current program 
year] 

<birth-date>10/15/1935</birth-date> None, Export Only 

Character <other-id>A0001</other-id> None 
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Available Values Sample XML Tag Other Parameters 

Numeric <provider-npi>1111111111</provider-
npi> 

None 

Numeric <provider-npi-
two>2222222222</provider-npi-two> 

None 

Numeric <provider-npi-
three>3333333333</provider-npi-three> 

None 

7.3.3.9. Clinic Identifier 

The Clinic Identifier will be pre-populated during the sampling process with the TIN for PQRS 
group practices. The Clinic Identifier will be pre-populated during the sampling process with 
the Participating TIN or the CMS Certification Number (CCN) for ACOs. The Clinic Identifier for 
the patient may be updated during the submission period. The Clinic Identifier in the XML file 
must currently exist in the database. The list of existing Clinic Identifiers may be obtained by 
exporting the Clinic XML file. If the Clinic Identifier does not exist in the group, the XML file will 
pass format validation, but the patient’s Clinic Identifier data will not be updated and an error 
message will be generated. 

The table below shows the appropriate XML format for the Clinic Identifier. 

Available Values Sample XML Tag Other Parameters 

Numeric <clinic-identifier>45226</clinic-
identifier> 

None 

7.3.3.10. General Comments 

The General Comments will not be pre-populated during the sampling process. The text may 
be added during the submission period. 

The table below shows the appropriate XML format for the General Comments. 

Available Values Sample XML Tag Other 
Parameters 

Text up to 140 
characters 

<general-comments>Text for general 
comments</general-comments> 

None 
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7.3.4. CARE-3 Documentation of Current Medications in the Medical 
Records 

The CARE-3 measure includes elements for: 

• Medical Record Found 

• Rank 

• Confirmation 

• Help Desk Ticket # 

• Documentation of Current Medications in the Medical Record 

• Comments 

7.3.4.1. CARE-3 Medical Record Found 

The Medical Record Found contains three types of information: 

• Confirm Medical Record Found 

• Reason patient not qualified for sample 

• Date patient became ineligible for sample 

If the medical record can be found for the patient, values for the CARE-3 measure must be 
provided for the patient to be considered complete in the associated CARE-3 measure. 

If the patient’s medical record cannot be found, or the patient is not qualified for the sample, the 
values for the CARE measures should not be provided. 

If the patient is ranked in other disease modules or patient care measures uploaded in the 
Patients XML file, the medical record found value should be the same for the patient in both the 
Patients XML and the Patient Medications XML. If the values are different, the value in the last 
uploaded file will overwrite any previously uploaded values. 

If the patient is not qualified for the sample, the reason they are ineligible and the date they 
became ineligible must be provided in order for the patient to be considered skipped in the 
CARE measures. 

7.3.4.1.1. Confirm Medical Record Found 

Determine if you are able to find the patient’s medical record. 

The table below shows the available values and appropriate XML format for the Medical 
Record Found. 
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Available Values Sample XML Tag Other Parameters 

2 = Yes <medical-record-
found>2</medical-record-
found> 

Include required confirmation and required 
measure elements for all disease 
modules, CARE measures, or PREV 
measures in which the patient is ranked to 
complete the patient’s data. 

Do not include Medical Record Found 
Reason value and Medical Record 
Found Date value. 

3 = Medical 
Record Not Found 

<medical-record-
found>3</medical-record-
found> 

Do not include Medical Record Found 
Reason value and Medical Record 
Found Date value or measure elements 
for this patient. 

Patient is skipped in all disease modules, 
CARE measures, or PREV measures in 
which the patient is ranked. 

9 = Not Qualified 
for Sample 

<medical-record-
found>9</medical-record-
found> 

Include Medical Record Found Reason 
value and Medical Record Found Date 
value. 

Do not include measure elements for this 
patient. 

Patient is skipped in all disease modules, 
CARE measures, or PREV measures in 
which the patient is ranked. 

7.3.4.1.2. Provide the Reason the Patient is Not Qualified for Sample 

If the Medical Record Found value is set to Not Qualified for Sample, the reason and date 
must be provided for the patient to be marked as skipped. 

The table below shows the available values and appropriate XML format for the Not Qualified 
for Sample reasons. 

Available Values Sample XML Tag Other Parameters 

10 = In Hospice <medical-not-qualified-
reason>10</medical-not-
qualified-reason> 

Include the Medical Record Found value 
and Medical Record Found Date value. 

Patient is skipped in all disease modules, 
CARE measures, or PREV measures in 
which the patient is ranked. 
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Available Values Sample XML Tag Other Parameters 

11 = Moved out of 
Country 

<medical-not-qualified-
reason>11</medical-not-
qualified-reason> 

Include the Medical Record Found value 
and Medical Record Found Date value. 

Patient is skipped in all disease modules, 
CARE measures, or PREV measures in 
which the patient is ranked. 

12 = Deceased <medical-not-qualified-
reason>12</medical-not-
qualified-reason> 

Include the Medical Record Found value 
and Medical Record Found Date value. 

Patient is skipped in all disease modules, 
CARE measures, or PREV measures in 
which the patient is ranked. 

16 = HMO 
Enrollment 

<medical-not-qualified-
reason>16</medical-not-
qualified-reason> 

Include the Medical Record Found value 
and Medical Record Found Date value. 

Patient is skipped in all disease modules, 
CARE measures, or PREV measures in 
which the patient is ranked. 

7.3.4.1.3. Provide the Date the Patient Became Ineligible for the Sample 

If the patient is not qualified for the sample and the reason is any of the following: 

• In hospice 

• Moved out of the country 

• Deceased, OR 

• HMO Enrollment 

the date must be provided for the patient to be marked as Skipped. Enter the date, in 
MM/DD/YYYY format, that the patient became ineligible for the sample during the measurement 
period (if date unknown enter 12/31/[current program year]). 

The table below shows the available values and appropriate XML format for the Not Qualified 
for Sample date. 

Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/[current program 
year] and 12/31/[current 
program year] 

<medical-not-qualified-
date>12/01/2015</medical-not-
qualified-date> 

Include the Medical Record 
Found value and Medical 
Record Found Reason value. 

Patient is skipped in all 
disease modules, CARE 
measures, or PREV measures 
in which the patient is ranked. 
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7.3.4.1.4. CARE-3 Rank 

The CARE-3 Rank provides the patient’s assigned order in the CARE-3 measure, and is 
provided in the exported files for information only. The rank cannot be changed from the value 
assigned to the patient during the patient sampling. 

The patient’s CARE-3 Rank is not required in the XML files to be uploaded. If the CARE-3 
Rank is included in the file, the XML element and associated data will be ignored. 

The table below shows the available values and appropriate XML format for the CARE-3 Rank. 

Available Values Sample XML Tag Other Parameters 

1 – 616 <caremeddoc-
rank>27<caremeddoc-rank> 

Ignored on Upload, provided for 
information on Export. 

7.3.4.1.5. CARE-3 Confirmation 

The CARE-3 Confirmation provides a way to skip the patient in the CARE-3 measure on a 
case-by-case basis. If the patient is ranked in any other disease module, CARE measure, or 
PREV measure, the patient is only skipped in the CARE-3 measure, not in all modules or 
patient care measures in which they are ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for CARE-3 is done on a case-by-case basis and this option 
may only be selected when an approval has been received from CMS in the form of a response 
to a QualityNet Help Desk inquiry. That Help Desk Ticket number must be provided when this 
answer is selected, to complete the patient. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <caremeddoc-
confirmed>2<caremeddoc-
confirmed> 

Include required CARE-3 measure 
elements to complete the patient’s 
data for CARE-3 

15 = No – Other CMS 
Approved Reason 

<caremeddoc-
confirmed>15<caremeddoc-
confirmed> 

Do not include CARE-3 measure 
elements for this patient, patient is 
skipped in this measure; however, 
selecting this option requires including 
a Help Desk ticket number. 
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Available Values Sample XML Tag Other Parameters 

19 = Not Confirmed - 
Age 

<caremeddoc-
confirmed>19<caremeddoc-
confirmed> 

This value is only used for export. 
The system will automatically set the 
value if the patient’s date of birth is 
changed in the GPRO Web Interface 
and the age makes the patient 
ineligible for the measure. If the age 
exclusion value is included in an 
uploaded XML file, the value will be 
ignored and CARE-3 Confirmed will 
not be set to this value.  

7 = Not Confirmed – 
No Qualifying Visits 

<caremeddoc-
confirmed>7<caremeddoc-
confirmed> 

This value is only used for export. 
The system will automatically set the 
value if the response No - Visit 
Outside Practice for all dates for a 
patient seen. If this response is 
included in an uploaded XML file, the 
value will be ignored and CARE-3 
Confirmed will not be set to this value. 

7.3.4.1.6. CARE-3 Help Desk Ticket # 

The Help Desk Ticket # field is only required if you have entered the No - Other CMS 
Approved Reason option for any of the CARE-3 questions. 

The table below shows the available values and appropriate XML format for Help Desk Ticket 
#. 

Available Values Sample XML Tag Other Parameters 

Text up to 15 
characters 

<caremeddoc-rm-
ticket>Text for ticket 
number</caremeddoc-
rm-ticket> 

None 

7.3.4.2. CARE-3: Documentation of Current Medications in the Medical Record 

Three types of information are required to complete the CARE-3 measure: 

• Visit Date 

• Patient seen in group on date 

• Patient Medications Documented, Updated, or Reviewed 

All information may not be required for the CARE-3 measure to be marked complete. A value for 
confirmation that the patient’s visit is within the group practice’s TIN or one of the ACO’s 
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participating TINs must be provided for all visit dates. If the visit is not within the TIN, the 
remaining values for that visit are not required. 

7.3.4.2.1. Visit Date 

The Visit Date field will be pre-populated from claims during the sampling for CARE-3. The 
Visit Date field cannot be modified, added or deleted. If a date in the XML file does not exist for 
the patient, the XML file will pass format validation, but the measure data for that date will not be 
updated. When the file is processed, an error message will be provided indicating that the Visit 
Date date does not exist for the patient. 

The Visit Date element may be repeated for each visit associated to a patient, but only one set 
of date elements for a patient may be between the opening <patient> element and the closing 
</patient> element. 

Note: The valid Visit Date dates are 01/01/[current program year] through 10/31/[current 
program year]. Since the dates are pre-populated with dates falling within the range, the XML 
validation checks for a valid date in the current program year, without limiting the date range. 
However, if a date outside the date range is provided, the XML processing will reject the date 
and the associated tags because the date will not exist. 

The table below shows the available values and appropriate XML format for the Visit Date. 

Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/[current program 
year] and 10/31/[current 
program year] in format 
MM/DD/YYYY 

See note above on date 
range validation. 

<caremeddoc-visit-
date>02/20/2015</caremeddoc-
visit-date> 

Provide the Patient Seen on 
This Date value and 
conditionally the Medications 
Documented, Updated, or 
Reviewed value. 

7.3.4.2.2. Determine if Patient Seen on This Date 

Determine if the patient was seen on the date within the group practice’s TIN or one of the 
ACO’s participating TINs. 

The table below shows the available values and appropriate XML format for the office visit. 

Available Values Sample XML Tag Other Parameters 

21 = No – Visit 
Outside Practice 

<caremeddoc-visit-
confirmation>21</ 
caremeddoc-visit-
confirmation> 

Do not provide the Medication Documented, 
Updated, or Reviewed value, this visit is 
complete. 
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Available Values Sample XML Tag Other Parameters 

2 = Yes < caremeddoc-visit-
confirmation >2</ 
caremeddoc-visit-
confirmation > 

Provide the Medication Documented, Updated, 
or Reviewed value to complete this visit. 

7.3.4.2.3. Determine if the Patient Medications have been Documented, Updated, or Reviewed 

The Medications Documented, Updated, or Reviewed value must be provided for each Patient 
Seen on This Date value that is set to Yes.  

The table below shows the available values and appropriate XML format for the Medications 
Documented, Updated, or Reviewed confirmation. 

Available Values Sample XML Tag Other Parameters 

1 = No <medications-
documented>1</medications-
documented> 

Provide the Medication 
Documented, Updated, or 
Reviewed value to complete this 
review. 

2 = Yes <medications- 
documented>2</medications-
documented> 

Provide the Medication 
Documented, Updated, or 
Reviewed value to complete this 
review. 

4 = No – Denominator 
Exception – Medical 
Reasons 

<medications- 
documented>4</medications-
documented> 

Provide the Medication 
Documented, Updated, or 
Reviewed value to complete this 
review. 

7.3.4.3. Comments for CARE 3 

The Comments for CARE-3 can be used to provide additional information for the patient related 
to the CARE-3 measure. 

The table below shows the available values and appropriate XML format for the CARE-3 
Comments. 

Available Values Sample XML Tag Other 
Parameters 

Text up to 140 
characters 

<caremeddoc-comments>Text for 
comment</caremeddoc-comments>  

None 
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7.4. Clinics XML 
The Clinics XML file is used to export the list of clinics for a group. The information in the file 
cannot be updated by uploading a file, but clinics may be added or updated using the GPRO 
Web Interface. 

The database will be pre-populated with one or more clinics during the initial load. The address 
for the clinic will not be pre-populated, but will be included if the XML file is exported after the 
clinic has been updated on the GPRO Web Interface. 

The table below shows the Clinics XML elements and associated data. 

XML 
Element Description Data 

Type 
Field 
Size Valid Values 

N/A XML Declaration String 38 <?xml version=”1.0” 
encoding=”UTF-8”?> 

<web-
interface-
export> 

Opening Tag for data String 180 <web-interface-export 
xmlns:xsi=”http://www.w3.
org/2001/XMLSchema-
instance” 
xmlns:noNamespaceSche
maLocation=”WEB-
INTERFACE-CLINIC.xsd” 
xmlns=”gov/cms/pqrs/clini
c/v1”> 

<group-tin> ACO: Primary Taxpayer 
Identification Number 

PQRS Group Practice: Taxpayer 
Identification Number 

String 9 Number 

<clinic> Opening element clinic data, 
repeats for each clinic 

N/A N/A N/A 

<clinic-
identifier> 

ACO: Participating Taxpayer 
Identification Number, CMS 
Certification Number, or user 
provided number 

PQRS Group Practice: Taxpayer 
Identification Number or user 
provided number. 

May be used in the Patients XML 
to associate a clinic to a patient. 

String 9 Number 

<clinic-
name> 

Name of the clinic String 100 Character 
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XML 
Element Description Data 

Type 
Field 
Size Valid Values 

<clinic-
address1> 

First line of the clinic address String 50 Character 

<clinic-
address2> 

Second line of the clinic address String 50 Character 

<clinic-city> City for the clinic address String 50 Character 

<clinic-
state> 

State for the clinic address String 2 Two digit state codes 

<clinic-
zipcode> 

ZIP code for the clinic address String 10 Five digit (11111) or nine 
digit (11111-1111) ZIP 
code 

<clinic-is-
original> 

Indicator if the clinic was pre-
populated during the initial data 
load or added during the 
submission period using the 
GPRO Web Interface 

String 1 1 = User added, not 
original 

2 = Pre-populated, original 

</clinic> Closing tag for the Clinic data, 
repeats for each clinic 

N/A N/A N/A 

</web-
interface-
export> 

Closing tag for data N/A N/A N/A 

7.5. Providers XML 
The Provider XML file is used to export the list of providers for the group. The information in the 
file cannot be updated by uploading a file, but providers may be added or updated using the 
GPRO Web Interface. 

The database will be pre-populated with providers during the initial load. The pre-populated data 
includes the provider’s first and last name, and the Employer Identification Number, which is 
defaulted to the Primary Taxpayer Identification Number for ACOs and to the Taxpayer 
Identification Number for PQRS Group Practices. The pre-populated providers will have the flag 
set to indicate they are original providers. Providers added using the GPRO Web Interface will 
have the flag set to indicate they are not original providers. 

The Provider Credentials will not be pre-populated, but will be included if the XML file is 
exported after the provider has been updated on the Web Interface. 

The table below shows the Providers XML elements and associated data. 
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XML 
Element Description Data 

Type 
Field 
Size Valid Values 

N/A XML Declaration String 38 <?xml version=”1.0” 
encoding=”UTF-8”?> 

<web-
interface-
export> 

Opening tag for data String 180 <web-interface-export 
xmlns:xsi=”http://www.w3.
org/2001/XMLSchema-
instance” 
xmlns:noNamespaceSche
maLocation=”WEB-
INTERFACE-
PROVIDER.xsd” 
xmlns=”gov/cms/pqrs/provi
der/v1”>  

<group-tin> ACO: Primary Taxpayer 
Identification Number 

PQRS Group Practice: Taxpayer 
Identification Number 

String 9 Number 

<provider> Opening element for the Provider 
data 

N/A N/A N/A 

<provider-
npi> 

Provider’s NPI String 10 Number 

<provider-
first-name> 

First name of a provider String 30 Character 

<provider-
last-name> 

Last name of a provider String 30 Character 

<provider-
ein> 

Employer Identification Number 
for a provider 

String 15 Character 

<provider-
credentials> 

Credentials for a provider String 100 Character 

<provider-is-
original> 

Indicator if the provider was pre-
populated during the initial data 
load or added during the 
submission period using the 
GPRO Web Interface 

String 1 1 = User added, not 
original 

2 = Pre-populated, original 

</provider> Closing tag for the Provider data N/A N/A N/A 

</web-
interface-
export> 

Closing tag for data N/A N/A N/A 
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8. XML to Excel Processing 
The Patient, Patient Medications, Patient Ranking, Clinic and Provider XML files exported for 
the GPRO Web Interface may be imported into an Excel file. The Excel file may also be used to 
create the Patients XML and Patient Medications XML files in the format required to upload into 
the GPRO Web Interface. 

This section contains instructions on how to import/export files in Microsoft Excel, as well as 
instructions on how to edit an exported XML file. The versions of Microsoft Excel that are 
discussed are: 

• Microsoft Excel 2013 

• Microsoft Excel 2010 

• Microsoft Excel 2007 

• Microsoft Excel 2003 

8.1. Microsoft Excel 2013 
The following content explains the steps necessary to complete XML to Excel processing with 
Microsoft Excel 2013. In this section, you will learn how to: 

• Add the Developer Tab to Excel 

• Create an Excel Workbook for Patient XML 

• Create an Excel Workbook for the Patient Medications XML 

• Import the XML File 

• Export the Modified Data 

8.1.1. Add the Developer Tab to Excel 
If the Developer Tab is not shown on the Excel Ribbon it can be added. The following figure 
shows the Excel 2013 ribbon with the Developer Tab displayed. 
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Steps to display the Developer Tab: 

1. Click the File tab. 

2. Click Options. 

3. Click Customize Ribbon on the Excel Options window. 

4. Select the Developer checkbox under the Main Tabs list if not already checked. 

5. Click OK to apply the setting. 

The following figure shows the Excel 2013 File Tab with the Options at the bottom of the list. 

 

The following figure shows the Excel 2013 Options screen with the Customize Ribbon and the 
Developer checkbox highlighted. 
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8.1.2. Create an Excel Workbook for Patient XML 
Once the Developer tab is available, the Patient XSD Mapping can be added to a new 2013 
Excel Workbook. The XSD file for the Patient mapping is the WEB-INTERFACE-PATIENT.xsd 
file. 

To add the XSD Mapping: 

1. Select the File tab. 

2. Select New. 

3. Select Blank workbook. 

4. Select the Developer tab. 

5. Select Source in the Developer tab. The XML Source is added to the workbook. 

6. Select the XML Maps… button. 

7. Select the Add… button on the XML Maps screen. 

8. Select the WEB-INTERFACE-PATIENT.xsd file in the Select XML Source window. 
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9. Select OK in the XML Maps window. 

10. Select the ns1:patient line on the XML Source with the left mouse button. 

11. Hold the left mouse button down and drag the ns1:patient line to the A1 cell in the 
workbook, then release the mouse button. 

12. Close the XML Source by selecting the Source option in the Developer tab, or selecting 
the “X” in the upper right corner of the XML Source. 

The following figure shows the File tab with New Blank Excel 2013 workbook selection 
highlighted. 

 

The following figure shows the Source option highlighted with the associated hint displayed. 
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The figure below shows the blank Excel 2013 workbook with the XML Source. 

 

The following figure shows the XML Maps window before adding the Patient XSD to the maps. 
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The figure below shows the Select XML Source window. 
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The following figure shows the XML Maps window after adding the Patient XSD. 

 

The following figure shows the Excel 2013 workbook after adding the XML Source. 
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The following figure shows the mapping after selecting the ns1:patient line in the XML Source. 
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The following figure shows the Excel 2013 workbook after dragging and dropping the Patient 
XML Mapping to the A1 cell in the workbook. 
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The following figure shows the Excel 2013 workbook after closing the XML Source. 

 

8.1.2.1. Create an Excel Workbook for Patient Medications XML 

Once the Developer tab is available, the Patient Medications XSD Mapping can be added to a 
new 2013 Excel Workbook. The XSD file for the Patient Medications mapping is the WEB-
INTERFACE-MEDICATIONS.xsd file. The remaining steps to create the Patient Medications 
mapping are the same as for the Patient mapping. 

To add the XSD Mapping: 

1. Select the File tab. 

2. Select New. 

3. Select Blank workbook. 

4. Select the Developer tab. 

5. Select Source in the Developer tab. The XML Source is added to the workbook. 

6. Select the XML Maps… button. 

7. Select the Add… button on the XML Maps screen. 

8. Select the WEB-INTERFACE-MEDICATIONS.xsd file in the Select XML Source 
window. 
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9. Select OK in the XML Maps window. 

10. Select the ns1:patient line on the XML Source with the left mouse button. 

11. Hold the left mouse button down and drag the ns1:patient line to the A1 cell in the 
workbook, then release the mouse button. 

12. Close the XML Source by selecting the Source option in the Developer tab, or selecting 
the “X” in the upper right corner of the XML Source. 

8.1.3. Import the XML File 
Once the XSD mapping has been created, a Patients XML file or a Patient Medications XML file 
exported from the GPRO Web Interface can be imported into the mapped workbook. 

To import the file in Excel 2013: 

1. Open the Excel workbook mapped for the type of XML file (Patient or Patient 
Medications) to be imported. 

2. Click Developer. 

3. Click Import. 

4. Select the appropriate XML file for the mapped workbook in the file selection window. 

5. Click Import. 

The following figure shows the Excel 2013 ribbon with Developer Tab and the Import option 
identified. 

 

8.1.3.1. Export the Modified Data 

After editing the imported data, the modified data can be exported into the XML format. The file 
will require modification after exporting from Excel and before uploading into the GPRO Web 
Interface. See Editing the Exported XML File for the required modifications. 

To export the file in Excel 2013: 

1. Click Developer. 

2. Click Export. 
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3. Set Save as type: to XML file (*.xml). 

4. Click Export. 

The following figure shows the Excel 2013 workbook with the Export XML screen displayed. 

 

8.2. Microsoft Excel 2010 
The following content explains the steps necessary to complete XML to Excel processing with 
Microsoft Excel 2010. In this section, you will learn how to: 

• Add the Developer Tab to Excel 
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• Create an Excel Workbook for Patient XML 

• Create an Excel Workbook for the Patient Medications XML 

• Import the XML File 

• Export the Modified Data 

8.2.1. Add the Developer Tab to Excel 
If the Developer Tab is not shown on the Excel Ribbon it can be added. The following figure 
shows the Excel 2010 ribbon with the Developer Tab displayed. 

 

Steps to display the Developer Tab: 

1. Click the File tab. 

2. Click Options. 

3. Click Customize Ribbon on the Excel Options window. 

4. Select the Developer checkbox under the Main Tabs list if not already checked. 

5. Click OK to apply the setting. 
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The following figure shows the Excel 2010 File Tab with the Options selection highlighted. 
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The following figure shows the Excel 2010 Options screen with the Customize Ribbon and the 
Developer checkbox highlighted. 

 

8.2.2. Create an Excel Workbook for Patient XML 
Once the Developer tab is available, the Patient XSD Mapping can be added to a new 2010 
Excel Workbook. The XSD file for the Patient mapping is the WEB-INTERFACE-PATIENT.xsd 
file. 

To add the XSD Mapping: 

1. Select the File tab. 

2. Select New. 

3. Select Blank workbook. 

4. Select the Developer tab. 

5. Select Source in the Developer tab. The XML Source is added to the workbook. 

6. Select the XML Maps… button. 
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7. Select the Add… button on the XML Maps screen. 

8. Select the WEB-INTERFACE-PATIENT.xsd file in the Select XML Source window. 

9. Select OK in the XML Maps window. 

10. Select the ns1:patient line on the XML Source with the left mouse button. 

11. Hold the left mouse button down and drag the ns1:patient line to the A1 cell in the 
workbook, then release the mouse button. 

12. Close the XML Source by selecting the Source option in the Developer tab, or selecting 
the “X” in the upper right corner of the XML Source. 

The following figure shows the File tab with New Blank Excel 2010 workbook selection 
highlighted. 
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The following figure shows the Source option highlighted with the associated hint displayed. 

 

The following figure shows the blank Excel 2010 workbook with the XML Source. 
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The following figure shows the XML Maps window before adding the XSD to the maps. 

 

The following figure shows the Select XML Source window. 

 



XML to Excel Processing 

GPRO Web Interface XML Specification V1.0 122 PQRS PY2016 

The following figure shows the XML Maps window after adding the Patient XSD. 

 

The following figure shows the Excel 2010 workbook after adding the XML Source. 
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The following figure shows the mapping after selecting the ns1:patient line in the XML Source. 
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The following figure shows the Excel 2010 workbook after dragging and dropping the Patient 
XML Mapping to the workbook. 
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The following figure shows the Excel 2010 workbook after closing the XML Source. 

 

8.2.3. Create an Excel Workbook for Patient Medications XML 
Once the Developer tab is available, the Patient Medications XSD Mapping can be added to a 
new 2010 Excel Workbook. The XSD file for the Patient Medications mapping is the WEB-
INTERFACE-MEDICATIONS.xsd file. The remaining steps to create the Patient Medications 
mapping are the same as for the Patient mapping. 

To add the XSD Mapping: 

1. Select the File tab. 

2. Select New. 

3. Select Blank workbook. 

4. Select the Developer tab. 

5. Select Source in the Developer tab. The XML Source is added to the workbook. 

6. Select the XML Maps… button. 

7. Select the Add… button on the XML Maps screen. 

8. Select the WEB-INTERFACE-MEDICATIONS.xsd file in the Select XML Source 
window. 

9. Select OK in the XML Maps window. 

10. Select the ns1:patient line on the XML Source with the left mouse button. 
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11. Hold the left mouse button down and drag the ns1:patient line to the A1 cell in the 
workbook, then release the mouse button. 

12. Close the XML Source by selecting the Source option in the Developer tab, or selecting 
the “X” in the upper right corner of the XML Source. 

8.2.4. Import the XML File 
Once the XSD mapping has been created, a Patients XML file or a Patient Medications XML file 
exported from the GPRO Web Interface can be imported into the mapped workbook. 

To import the file in Excel 2010: 

1. Open the Excel workbook mapped for the type of XML file (Patient or Patient 
Medications) to be imported. 

2. Click Developer. 

3. Click Import. 

4. Select the appropriate XML file for the mapped workbook in the file selection window. 

5. Click Import. 

The following figure shows the Excel 2010 ribbon with Developer Tab and the Import option 
identified: 

 

8.2.5. Export the Modified Data 
After editing the imported data, the modified data can be exported into the XML format. The file 
will require modification after exporting from Excel and before uploading into the GPRO Web 
Interface. See Editing the Exported XML File for the required modifications. 

To export the file in Excel 2010: 

1. Click Developer. 

2. Click Export. 

3. Set Save as type: to XML file (*.xml). 

4. Click Export. 
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The following figure shows the Excel 2010 workbook with the Export XML screen displayed. 

 

8.3. Microsoft Excel 2007 
The following content explains the steps necessary to complete XML to Excel processing with 
Microsoft Excel 2007. In this section, you will learn how to: 

• Add the Developer Tab to Excel 

• Create an Excel Workbook for Patient XML 

• Create an Excel Workbook for the Patient Medications XML 

• Import the XML File 
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• Export the Modified Data 

8.3.1. Add the Developer Tab to Excel 
If the Developer Tab is not shown in Excel, it can be added. The following figure shows the 
Excel 2007 ribbon with the Developer Tab displayed. 

 

Steps to display the Developer Tab: 

1. Click the Microsoft Office Button. 

2. Click Excel Options. 

3. Click Popular. 

4. Select the Show Developer tab in the Ribbon check box. 

5. Click OK to apply the setting. 
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The following figure shows the Excel 2007 Options screen with the Show developer tab in the 
Ribbon option. 

 

8.3.2. Create an Excel Workbook for Patient XML 
Once the Developer tab is available, the Patient XSD Mapping can be added to a new 2007 
Excel Workbook. The XSD file for the Patient mapping is the WEB-INTERFACE-PATIENT.xsd 
file. 

To add the XSD Mapping: 

1. Click the Microsoft Office Button. 

2. Select New. 

3. Select Blank workbook. 

4. Select Create. 

5. Select the Developer tab. 

6. Select Source in the Developer tab. The XML Source is added to the workbook. 
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7. Select the XML Maps… button. 

8. Select the Add… button on the XML Maps screen. 

9. Select the WEB-INTERFACE-PATIENT.xsd file in the Select XML Source window. 

10. Select OK in the XML Maps window. 

11. Select the ns1:patient line on the XML Source with the left mouse button. 

12. Hold the left mouse button down and drag the ns1:patient line to the A1 cell in the 
workbook, then release the mouse button. 

13. Close the XML Source by selecting the Source option in the Developer Tab, or 
selecting the “X” in the upper right corner of the XML Source. 

The following figure shows the New Workbook screen with Blank Workbook selection 
highlighted. 
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The following figure shows the Source option highlighted with the associated hint displayed. 

 

The following figure shows the blank Excel 2007 workbook with the XML Source. 
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The following figure shows the XML Maps window before adding the Patient XSD to the maps. 

 

The following figure shows the Select XML Source window. 
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The following figure shows the XML Maps window after adding the Patient XSD. 

 

The following figure shows the Excel 2007 workbook after adding the XML Source. 
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The following figure shows the mapping after selecting the ns1:patient line in the XML Source. 
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The following figure shows the Excel 2007 workbook after dragging and dropping the Patient 
XML Mapping to the workbook. 

 

The following figure shows the Excel 2007 workbook after closing the XML Source. 
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8.3.3. Create an Excel Workbook for Patient Medications XML 
Once the Developer tab is available, the Patient Medications XSD Mapping can be added to a 
new 2007 Excel Workbook. The XSD file for the Patient Medications mapping is the WEB-
INTERFACE-MEDICATIONS.xsd file. 

To add the XSD Mapping: 

1. Click the Microsoft Office Button. 

2. Select New. 

3. Select Blank workbook. 

4. Select the Developer Tab. 

5. Select Source in the Developer tab. The XML Source is added to the workbook. 

6. Select the XML Maps… button. 

7. Select the Add… button on the XML Maps screen. 

8. Select the WEB-INTERFACE-MEDICATIONS.xsd file in the Select XML Source window. 

9. Select OK in the XML Maps window. 

10. Select the ns1:patient line on the XML Source with the left mouse button. 

11. Hold the left mouse button down and drag the ns1:patient line to the A1 cell in the 
workbook, then release the mouse button. 

12. Close the XML Source by selecting the Source option in the Developer Tab, or 
selecting the “X” in the upper right corner of the XML Source. 

8.3.4. Import the XML File 
Once the XSD mapping has been created, a Patients XML file or a Medications XML file 
exported from the GPRO Web Interface can be imported into the mapped workbook. 

To import the file in Excel 2007: 

1. Open the Excel workbook mapped for the type of XML file (Patient or Medications) to be 
imported. 

2. Click Developer. 

3. Click Import. 

4. Select the appropriate XML file for the mapped workbook in the file selection window. 

5. Click Import. 



XML to Excel Processing 

GPRO Web Interface XML Specification V1.0 138 PQRS PY2016 

The following figure shows the Excel 2007 ribbon with Developer Tab and the Import option 
identified. 

 

8.3.5. Export the Modified Data 
After editing the imported data, the modified data can be exported into the XML format. The file 
will require modification after exporting from Excel and before uploading into the GPRO Web 
Interface. See Editing the Exported XML File for the required modifications. 

To export the file in Excel 2007: 

1. Click Developer. 

2. Click Export. 

3. Set Save as type: to XML file (*.xml). 

4. Click Export. 
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The following figure shows the Excel 2007 workbook with the Export XML screen displayed. 

 

8.4. Microsoft Excel 2003 
The steps for Excel 2003 are similar to the steps above. The steps below are from the Excel 
2003 online help. Additional information is available in the Excel 2003 help. 

1. On the Data menu, point to XML and click XML Source to open the XML Source task 
pane. 

2. To map one or more elements to your worksheet, select the elements in the XML Source 
task pane. 

3. Drag the selected elements to the worksheet location where you want them to appear. 

Excel will bold each element in the XML Source task pane to indicate they are currently 
mapped. 

8.5. Editing the Exported XML File 
Excel adds a target name space to the exported XML tags. These tags must be removed before 
uploading the file into the GPRO Web Interface. 
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The mapping for the Patients XML file described in the Creating an Excel Workbook for Patient 
XML sections excludes the header information to prevent duplicate data in the XML files 
imported into Excel. The header needs to be added prior to uploading the file into the GPRO 
Web Interface. 

For more information on creating Excel Workbooks for Patient XML, see the following sections: 

• Create a 2013 Excel Workbook for Patient XML 

• Create a 2010 Excel Workbook for Patient XML  

• Create a 2007 Excel Workbook for Patient XML 

8.5.1. Remove the Name Space from the XML Tags 
The directions below provide the information to remove the name space using Notepad++. 
Notepad++ is a free source code editor available at notepad-plus-plus.org. 

Files must be saved using encoding UTF-8 without Byte Order Mark (BOM). If any other editor 
is used, care should be exercised when saving the file to ensure that BOM characters or non 
UTF-8 characters are not added to the file. 

To remove the name space added by Excel: 

1. Open the file with Notepad++ or any other editor that has the capability to save with 
encoding UTF-8 without BOM. 

2. Click Search. 

3. Click Replace… from the Search toolbar option. 
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The following figure shows a file in Notepad++ with the Replace option highlighted. 

 

4. The Replace screen appears. 

5. Enter “ns1:” in the Find what: field. 

6. Leave the Replace with: field blank. 

7. Click Replace All. 

The following figure shows the Replace screen in Notepad++ used to remove the name space. 
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8.5.2. Add the Header and Group Identification Data to the XML File 
The Header and Group Identification Data are required in the file. In the example, 000000000 
does not represent a real TIN. In your XML file you will need to replace this value with the TIN 
for your group practice TIN or ACO Primary TIN. 

The ACO Primary Taxpayer Identification Number in the file must match the ACO Primary 
Taxpayer Identification Number associated to the identity management account of the user 
uploading the data. 

The PQRS group practice Taxpayer Identification Number in the file must match the PQRS 
group practice Taxpayer Identification Number associated to the identity management account 
of the user uploading the data. 

8.5.2.1. Patient XML File Header 

The following three lines are added when the Patient XML file is created by Excel. They must be 
removed or the file will be rejected as an invalid file. 

<?xml version=”1.0” encoding=”UTF-8” standalone=”yes”?> 
<submission xmlns:ns1=”gov/cms/pqrs/patient/v1”> 

<web-interface> 

After removing those lines, insert the appropriate header as specified by the XML Specification. 
at the top of the file. Note that the XML Declaration must be on a separate line. In addition, the 
data for the <submission> element should be on one line without line returns in the tag. The 
submission tag is wrapped to fit the page 

File Header to replace removed lines in Patient XML file is available in an XML file you 
downloaded from the GPRO Web Interface or from the sample PatientHeader.xml file.  

The sample header files may be downloaded from the online version of this XML Specification; 
they are not downloadable from the PDF file. 

Note that the value in the <group-tin> tag in the sample file must be modified to match your TIN. 

8.5.2.2. Patient Medications XML File Header 

The following three lines are added when the Medications XML file is created by Excel. They 
must be removed or the file will be rejected as an invalid file. 

<?xml version=”1.0” encoding=”UTF-8” standalone=”yes”?> 
<submission xmlns:ns1=”gov/cms/pqrs/medications/v1”> 

<web-interface> 

After removing those lines, insert the appropriate header at the top of the file. Note that the XML 
Declaration must be on a separate line. In addition, the data for the <submission> element 
should be on one line without line returns in the tag. The submission tag is wrapped to fit the 
page.  
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File Header to replace removed lines in Patient Medications XML file is available in an XML file 
you downloaded from the GPRO Web Interface or from the sample MedicationsHeader.xml file. 

The sample header files may be downloaded from the online version of this XML Specification; 
they are not downloadable from the PDF file. 

Note that the value in the <group-tin> tag in the sample file must be modified to match your TIN. 

8.5.2.3. Save the Modified File with UTF-8 Encoding 

After modifying the file to remove the Namespace and replace the header, the file must be 
saved with encoding UTF-8 without BOM. Files that are not saved with encoding UTF-8 without 
BOM will fail the XML format validation. The encoding UTF-8 without BOM is set in the 
Preferences in Notepad++. 

To set preferences to save the file with UTF-8 Encoding in Notepad++: 

1. Click Settings. 

2. Click Preferences…. 

3. Click the New Document/Default Directory tab on the Preferences window. 

4. Select UTF-8 without BOM in the Encoding section, if not already selected. 

5. Check the Apply to opened ANSI files in the Encoding section, if not already selected. 

6. Select Close. 

The following figure shows the Settings options in Notepad++. 
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The following figure shows the Preferences screen with the New Document/Default Directory 
tab selected. 
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Appendix A – XML Elements for Patients XML File 
The indicator that the XML tag is required, or that data is required in the tag when the tag is used, only applies to the XML file format validation. 

Data may or may not be needed in order to complete the required reporting on the quality measures for the patient. Information on the data required 
to complete reporting on a patient may be found in the disease module, CARE measure, or PREV measure sections of this document as well as in 
the referenced Supporting Documents for each module or patient care measure. 

When creating the XML file, the file must be created with UTF-8 encoding without Byte Order Mark (BOM). 

XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

XML Declaration <?xml version=”1.0” encoding=”UTF-8”?> String 38 Yes N/A 

<web-interface-
submission> 

<web-interface-submission 
xmlns:xsi=”http://www.w3.org/2001/XMLSchema-instance” 
xmlns:noNamespaceSchemaLocation=”WEB-
INTERFACE-PATIENT.xsd” 
xmlns=”gov/cms/pqrs/patient/v1”> 

String 180 Yes Yes 

<group-tin> ACO: Primary Taxpayer Identification Number. 

PQRS group practice: Taxpayer Identification Number. 

String 9 Yes Yes 

<patient> Opening element for an individual patient’s data, may be 
repeated with a matching closing element for each patient, 
opening tag does not contain data. 

N/A N/A Yes N/A 

<medicare-id> The Medicare ID is the unique identifier for the patient and 
associated data contained between the opening <patient> 
and closing </patient> tags. 

The Medicare ID should only be used once for each patient 
in the Patients XML file. 

String 15 Yes Yes 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<patient-first-name> String containing the first name of the patient. 

Name is included in the export to aid in locating the patient, 
but the name cannot be modified using an XML upload. 

String 25 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the first name will 
not be updated in 
the database. 

<patient-last-name> String containing the last name of the patient. 

Name is included in the export to aid in locating the patient, 
but the name cannot be modified using an XML upload. 

String 20 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the last name will 
not be updated in 
the database. 

<gender> 1 = Male 

2 = Female 

3 = Unknown 

Gender is included in the export to aid in locating the 
patient, but the gender cannot be modified using an XML 
upload. 

String 1 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the gender will not 
be updated in the 
database. 

<birth-date> MM/DD/YYYY 

Date of birth is included in the export to aid in locating the 
patient, but the date of birth cannot be modified using an 
XML upload. 

String 10 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the date of birth will 
not be updated in 
the database. 

<medical-record-
number> 

Character String 25 No No 

<other-id> Character String 20 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<provider-npi> Numeric 

The NPI must already exist in the in the Web Interface for 
your group before it can be used in the XML file. 

String 10 No No 

<provider-npi-two> Numeric 

The NPI must already exist in the in the Web Interface for 
your group before it can be used in the XML file. 

String 10 No No 

<provider-npi-three> Numeric 

The NPI must already exist in the in the Web Interface for 
your group before it can be used in the XML file. 

String 10 No No 

<clinic-identifier> Identifier associated with the clinic. 

The identifier must already exist in the in the Web Interface 
for your group before it can be used in the XML file. 

ACO: The identifier may be a participating TIN, a CMS 
Certification Number (CCN), or a user entered identifier. 

PQRS group practice: The TIN or user entered identifier. 

String 9 No No 

<general-comments> Text String 140 No No 

<medical-record-found> 2 = Yes 

3 = Medical Record Not Found 

9 = Not Qualified for Sample 

String 2 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<medical-not-qualified-
reason> 

10 = In Hospice 

11 = Moved out of Country 

12 = Deceased 

16 = HMO Enrollment 

String 2 No No 

<medical-not-qualified-
date> 

Date in MM/DD/YYYY format 

Valid date between 01/01/[current program year] and 
12/31/[current program year]. 

String 10 No No 

<carefalls-rank> 

CARE-2 

1 to 616 

Rank is provided in an exported file for information only; 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<carefalls-confirmed> 

CARE-2 

2 = Yes 

15 = No – Other CMS Approved Reason 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 

<carefalls-rm-ticket> Text up to 15 characters String 15 No No 

<falls-screening> 

CARE-2 

1 = No 

2 = Yes 

4 = No – Denominator Exception - Medical Reasons 

String 1 No No 

<carefalls-comments> 

CARE-2 

Text String 140 No No 

<cad-rank> 1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<cad-confirmed> 2 = Yes 

8 = Not Confirmed - Diagnosis 

15 = No – Other CMS Approved Reason 

19 = Not Confirmed – Age 

22 = Not Confirmed – Additional Denominator Criteria 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

Not Confirmed – Additional Denominator Criteria is 
included in an export only to provide information on 
the current status of the patient. If the Not Confirmed – 
Additional Denominator Criteria value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 

<cad-rm-ticket> Text up to 15 characters String 15 No No 

<cad-diabetes-lvsd> 1 = No 

2 = Yes 

String 1 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<cad-acearb> 

CAD-7 

1 = No 

2 = Yes 

4 = No – Denominator Exception - Medical Reasons 

5 = No – Denominator Exception - Patient Reasons 

6 = No – Denominator Exception - System Reasons 

String 1 No No 

<cad-comments> Text String 140 No No 

<dm-rank> 1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<dm-confirmed> 2 = Yes 

8 = Not Confirmed - Diagnosis 

15 = No – Other CMS Approved Reason 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the patient. If 
the Not Confirmed – Age value is used in an upload, the 
value will be ignored and the confirmation will not be set to 
this value. 

String 2 No No 

<dm-rm-ticket> Text up to 15 characters String 15 No No 

<dm-hba1c-test> 

DM-2 

1 = No 

2 = Yes 

String 1 No No 

<dm-hba1c-date> 

DM-2 

MM/DD/YYYY 

(Must be a valid date in the current program year) 

String 10 No No 

<dm-hba1c-value> 

DM-2 

0-25 with one or two optional decimal places (XX.XX) String 5 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<dm-eye-exam> 

DM-7 

1 = No 

2 = Yes 

String 1 No No 

<dm-comments> Text String 140 No No 

<hf-rank> 1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<hf-confirmed> 2 = Yes 

8 = Not Confirmed - Diagnosis 

15 = No – Other CMS Approved Reason 

19 = Not Confirmed – Age 

22 = Not Confirmed – Additional Denominator Criteria 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

Not Confirmed – Additional Denominator Criteria is 
included in an export only to provide information on 
the current status of the patient. If the Not Confirmed – 
Additional Denominator Criteria value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 

<hf-rm-ticket> Text up to 15 characters String 15 No No 

<hf-lvsd> 

HF-6 

1 = No 

2 = Yes 

String 1 No No 



Appendix A – XML Elements for Patients XML File 

GPRO Web Interface XML Specification V1.0 155 PQRS PY2016 

XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<hf-beta-blocker> 

HF-6 

1 = No 

2 = Yes 

4 = No – Denominator Exception - Medical Reasons 

5 = No – Denominator Exception - Patient Reasons 

6 = No – Denominator Exception - System Reasons 

String 1 No No 

<hf-comments> Text String 140 No No 

<htn-rank> 1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<htn-confirmed> 2 = Yes 

8 = Not Confirmed - Diagnosis 

15 = No – Other CMS Approved Reason 

17 = Denominator Exclusion 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient.  

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 

<htn-rm-ticket> Text up to 15 characters String 15 No No 

<htn-recent-bp> 

HTN-2 

1 = No 

2 = Yes 

String 2 No No 

<htn-bp-date> 

HTN-2 

MM/DD/YYYY 

(Must be a valid date in the current program year) 

String 10 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<htn-bp-systolic> 

HTN-2 

0 to 350 

Note: If both Systolic and Diastolic are greater than zero, 
the Systolic value must be greater than the Diastolic value 
in order for the system to mark the patient as complete. If 
the Systolic is less than or equal to the Diastolic, the 
patient will be marked as incomplete by the system. 

String 3 No No 

<htn-bp-diastolic> 

HTN-2 

0 to 200 

Note: If both Systolic and Diastolic are greater than zero, 
the Diastolic value must be less than the Systolic value in 
order for the system to mark the patient as complete. If the 
Diastolic is greater than or equal to the Systolic, the patient 
will be marked as incomplete by the system. 

String 3 No No 

<htn-comments> Text String 140 No No 

<ivd-rank> 1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<ivd-confirmed> 2 = Yes 

8 = Not Confirmed - Diagnosis 

15 = No – Other CMS Approved Reason 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient.  

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 

<ivd-rm-ticket> Text up to 15 characters String 15 No No 

<ivd-antithrombotic> 

IVD-2 

1 = No 

2 = Yes 

String 1 No No 

<ivd-comments> Text String 140 No No 

<mh-rank> 1 to 616 

Rank is provided in an exported file for information only; 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<mh-confirmed> 2 = Yes 

8 = Not Confirmed - Diagnosis 

15 = No – Other CMS Approved Reason 

17 = Denominator Exclusion 

19 = Not Confirmed – Age 

22 = Not Confirmed - Additional Denominator Criteria 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient.  

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

Not Confirmed – Additional Denominator Criteria is 
included in an export only to provide information on 
the current status of the patient. If the Not Confirmed – 
Additional Denominator Criteria value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 

<mh-rm-ticket> Text up to 15 characters String 15 No No 

mh-index-performed 1 = No 

2 = Yes 

String 1 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

mh-index-test 1 = No 

2 = Yes 

String 1 No No 

mh-index-date MM/DD/YYYY 

(Must be a valid date between 12/1/2014 and 11/30/2015) 

String 10 No No 

mh-index-score 10 to 27 String 2 No No 

mh-followup-performed 1 = No 

2 = Yes 

String 1 No No 

mh-followup-test 1 = No 

2 = Yes 

String 1 No No 

mh-followup-date MM/DD/YYYY 

(Must be a valid date between 11/1/2015 to 12/31/2016) 

Note: If both the initial assessment and the follow-up 
assessment were performed and both scores are within the 
appropriate range for the associated assessment, the time 
between the initial assessment date and the follow-up 
assessment date must be 12 months +/- 30 days in order 
for the system to mark the patient as meeting the measure 
when all other criteria is met. If the time between 
assessments is not 12 months =/- 30 days, the patient will 
be marked as not meeting the measure by the system, 
even if all other criteria has been met. 

String 10 No No 

mh-followup-score 0 to 4 String 1 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<mh-comments> Text String 140 No No 

<pcmammogram-rank> 1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 

<pcmammogram-
confirmed> 

PREV-5 

2 = Yes 

15 = No – Other CMS Approved Reason 

17 = Denominator Exclusion 

18 = Not Confirmed – Gender 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient.  

Not Confirmed – Gender is included in an export only 
to provide information on the current status of the 
patient. If the Not Confirmed – Gender value is used in 
an upload, the value will be ignored and the confirmation 
will not be set to this value. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pcmammogram-rm-
ticket> 

Text up to 15 characters String 15 No No 

<pcmammogram> 

PREV-5 

1 = No 

2 = Yes 

String 1 No No 

<pcmammogram-
comments> 

PREV-5 

Text String 140 No No 

<pccolorectal-rank> 1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pccolorectal-
confirmed> 

PREV-6 

2 = Yes 

15 = No – Other CMS Approved Reason 

17 = Denominator Exclusion 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 

<pccolorectal-rm-ticket> Text up to 15 characters String 15 No No 

<pccolorectal> 

PREV-6 

1 = No 

2 = Yes 

String 1 No No 

<pccolorectal-
comments> 

PREV-6 

Text String 140 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pcflushot-rank> 1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 

<pcflushot-confirmed> 

PREV-7 

2 = Yes 

15 = No – Other CMS Approved Reason 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 

<pcflushot-rm-ticket> Text up to 15 characters String 15 No No 

<pcflushot> 

PREV-7 

1 = No 

2 = Yes 

4 = No – Denominator Exception - Medical Reasons 

5 = No – Denominator Exception - Patient Reasons 

6 = No – Denominator Exception - System Reasons 

String 1 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pcflushot-comments> 

PREV-7 

Text String 140 No No 

<pcpneumoshot-rank> 1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 

<pcpneumoshot-
confirmed> 

PREV-8 

2 = Yes 

15 = No – Other CMS Approved Reason 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the patient. If 
the Not Confirmed – Age value is used in an upload, the 
value will be ignored and the confirmation will not be set to 
this value. 

String 2 No No 

<pcpneumoshot-rm-
ticket> 

Text up to 15 characters String 15 No No 

<pcpneumoshot> 

PREV-8 

1 = No 

2 = Yes 

String 1 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pcpneumoshot-
comments> 

PREV-8 

Text String 140 No No 

<pcbmiscreen-rank> 1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 

<pcbmiscreen-
confirmed> 

PREV-9 

2 = Yes 

15 = No – Other CMS Approved Reason 

17 = Denominator Exclusion 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 

<pcbmiscreen-rm-
ticket> 

Text up to 15 characters String 15 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pcbmicalculated> 

PREV-9 

1 = No 

2 = Yes 

String 1 No No 

<pcbminormal> 

PREV-9 

1 = No 

2 = Yes 

String 1 No No 

<pcbmiplan> 

PREV-9 

1 = No 

2 = Yes 

String 1 No No 

<pcbmi-comments> 

PREV-9 

Text String 140 No No 

<pctobaccouse-rank> 1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pctobaccouse-
confirmed> 

PREV-10 

2 = Yes 

15 = No – Other CMS Approved Reason 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the patient. If 
the Not Confirmed – Age value is used in an upload, the 
value will be ignored and the confirmation will not be set to 
this value. 

String 2 No No 

<pctobaccouse-rm-
ticket> 

Text up to 15 characters String 15 No No 

<pctobaccoscreen> 

PREV-10 

1 = No (Screened and a non-tobacco user) 

2 = Yes (Screened and a tobacco user) 

4 = No – Denominator Exception - Medical Reasons 

14 = Not Screened/Unknown 

String 2 No No 

<pctobaccocounsel> 

PREV-10 

1 = No 

2 = Yes 

String 1 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pctobaccouse-
comments> 

PREV-10 

Text String 140 No No 

<pcbloodpressure-
rank> 

1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 

<pcbloodpressure-
confirmed> 

PREV-11 

2 = Yes 

15 = No – Other CMS Approved Reason 

17 = Denominator Exclusion 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the patient. If 
the Not Confirmed – Age value is used in an upload, the 
value will be ignored and the confirmation will not be set to 
this value. 

String 2 No No 

<pcbloodpressure-rm-
ticket> 

Text up to 15 characters String 15 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pcbloodpressure> 

PREV-11 

1 = No 

2 = Yes 

4 = No – Denominator Exception - Medical Reasons 

5 = No – Denominator Exception - Patient Reasons 

String 1 No No 

<pcbpnormal> 

PREV-11 

1 = No 

2 = Yes 

String 1 No No 

<pcbpfollowup> 

PREV-11 

1 = No 

2 = Yes 

5 = No – Denominator Exception - Patient Reasons 

String 1 No No 

<pcbp-comments> 

PREV-11 

Text String 140 No No 

<pcdepression-rank> 1 to 616 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pcdepression-
confirmed> 

PREV-12 

2 = Yes 

15 = No – Other CMS Approved Reason 

17 = Denominator Exclusion 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 

<pcdepression-rm-
ticket> 

Text up to 15 characters String 15 No No 

<pcdepression> 

PREV-12 

1 = No 

2 = Yes 

4 = No – Denominator Exception - Medical Reasons 

5 = No – Denominator Exception - Patient Reasons 

String 1 No No 

<pcdepression-
positive> 

PREV-12 

1 = No 

2 = Yes 

String 1 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pcdepression-plan> 

PREV-12 

1 = No 

2 = Yes 

String 1 No No 

<pcdepression-
comments> 

PREV-12 

Text String 140 No No 

<pcstatin-rank> 1 to 750 

Rank is provided in an exported file for information only, 
rank cannot be modified in an XML upload or in the GPRO 
Web Interface. 

String 3 For Export Only 

If used in upload, 
the tag will be 
ignored. 

For Export Only 

If used in upload, 
the rank will not be 
updated in the 
database. 

<pcstatin-ascvd> 2 = Yes 

15 = No - Other CMS Approved Reason 

19 = Not Confirmed – Age 

23 = No – Diagnosis 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pcstatin-ldlc> 1 = No 

2 = Yes 

15 = No - Other CMS Approved Reason 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pcstatin-diabetes> 1 = No 

2 = Yes 

15 = No - Other CMS Approved Reason 

19 = Not Confirmed – Age 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

Not Confirmed – Age is included in an export only to 
provide information on the current status of the 
patient. If the Not Confirmed – Age value is used in an 
upload, the value will be ignored and the confirmation will 
not be set to this value. 

String 2 No No 

<pcstatin-ldlc-reading> 1 = No 

2 = Yes 

15 = No - Other CMS Approved Reason 

No – Other CMS Approved Reason may only be selected 
when an approval has been received from CMS in the form 
of a response to a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when this answer is 
selected, to complete the patient. 

String 2 No No 

<pcstatin-rm-ticket> Text up to 15 characters String 15 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size 

Tag Required in 
File for Format 

Validation  

Data Required in 
Tag for Format 

Validation  

<pcstatin-prescribed> 1 = No 

2 = Yes 

4 = No - Denominator Exception - Medical Reasons 

String 2 No No 

<pcstatin-comments> Text up to 140 characters String 140 No No 

</patient> Closing element for an individual patient’s data, may be 
repeated with a matching opening element for each 
patient, closing tag does not contain data. 

N/A N/A Yes N/A 

</web-interface-
submission> 

Closing tag for header N/A N/A Yes N/A 
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Appendix B – XML Elements for Patient Medications XML File 
The indicator that the XML tag is required, or that data is required in the tag when the tag is 
used, only applies to the XML file format validation. 

Data may or may not be needed in order to complete the required reporting on the quality 
measures for the patient. Information on the data required to complete reporting on a patient 
may be found in the individual disease module, CARE measure, or PREV measure sections of 
this document as well as in the referenced Supporting Documents for each module or patient 
care measure. 

When creating the XML file, the file must be created with UTF-8 encoding without Byte Order 
Mark (BOM). 

XML Element 
/ Measure Valid Values Data 

Type 

Fiel
d 

Size 

Tag 
Required 
in File for 
Format 

Validatio
n  

Data 
Required 
in Tag for 

Format 
Validatio

n  

XML 
Declaration 

<?xml version=”1.0” encoding=”UTF-8”?> Strin
g 

38 Yes Yes 

<web-
interface-
submission> 

<web-interface-submission 
xmlns:xsi=”http://www.w3.org/2001/XMLSchem
a-instance” 
xmlns:noNamespaceSchemaLocation=”WEB-
INTERFACE-MEDICATIONS.xsd” 
xmlns=”gov/cms/pqrs/medications/v1”> 

Strin
g 

180 Yes Yes 

<group-tin> ACO: Primary Taxpayer Identification Number 

PQRS group practice: Taxpayer Identification 
Number 

Strin
g 

9 Yes Yes 

<patient> Opening element for an individual patient’s 
medications data elements; may be repeated 
with a matching closing element for each visit 
date for the patient, opening tag does not 
contain data. 

Closing element for an individual patient’s 
medication documentation data elements may 
be repeated with a matching opening element 
for each visit date for the patient, closing tag 
does not contain data. 

N/A N/A Yes N/A 
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XML Element 
/ Measure Valid Values Data 

Type 

Fiel
d 

Size 

Tag 
Required 
in File for 
Format 

Validatio
n  

Data 
Required 
in Tag for 

Format 
Validatio

n  

<medicare-
id> 

The Medicare ID is the unique identifier for the 
patient and associated data contained between 
the opening <patient> and closing </patient> 
tags 

The Medicare ID should be used once for each 
set of the patient’s medication data in the 
Patient Medications XML file. There is one set 
of medication data for each separate visit date. 

Strin
g 

15 Yes Yes 

<patient-first-
name> 

String containing the first name of the patient. 

Name is included in the export to aid in locating 
the patient, but the name cannot be modified 
using an XML upload. 

Strin
g 

25 For 
Export 
Only 

If used in 
upload, 
the tag 
will be 
ignored. 

For 
Export 
Only 

If used in 
upload, 
the first 
name will 
not be 
updated 
in the 
database. 

<patient-last-
name> 

String containing the last name of the patient. 

Name is included in the export to aid in locating 
the patient, but the name cannot be modified 
using an XML upload. 

Strin
g 

20 For 
Export 
Only 

If used in 
upload, 
the tag 
will be 
ignored. 

For 
Export 
Only 

If used in 
upload, 
the last 
name will 
not be 
updated 
in the 
database. 
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XML Element 
/ Measure Valid Values Data 

Type 

Fiel
d 

Size 

Tag 
Required 
in File for 
Format 

Validatio
n  

Data 
Required 
in Tag for 

Format 
Validatio

n  

<gender> 1 = Male 

2 = Female 

3 = Unknown 

Gender is included in the export to aid in 
locating the patient, but the gender cannot be 
modified using an XML upload. 

Strin
g 

1 For 
Export 
Only 

If used in 
upload, 
the tag 
will be 
ignored. 

For 
Export 
Only 

If used in 
upload, 
the 
gender 
will not 
be 
updated 
in the 
database. 

<birth-date> MM/DD/YYYY 

Date of birth is included in the export to aid in 
locating the patient, but the date of birth cannot 
be modified using an XML upload. 

Strin
g 

10 For 
Export 
Only 

If used in 
upload, 
the tag 
will be 
ignored. 

For 
Export 
Only 

If used in 
upload, 
the date 
of birth 
will not 
be 
updated 
in the 
database. 

<medical-
record-
number> 

Character Strin
g 

25 No No 

<other-id> Character Strin
g 

20 No No 

<provider-
npi> 

Numeric 

The NPI must already exist in the in the Web 
Interface for your group before it can be used 
in the XML file. 

Strin
g 

10 No No 

<provider-
npi-two> 

Numeric 

The NPI must already exist in the in the Web 
Interface for your group before it can be used 
in the XML file. 

Strin
g 

10 No No 
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XML Element 
/ Measure Valid Values Data 

Type 

Fiel
d 

Size 

Tag 
Required 
in File for 
Format 

Validatio
n  

Data 
Required 
in Tag for 

Format 
Validatio

n  

<provider-
npi-three> 

Numeric 

The NPI must already exist in the in the Web 
Interface for your group before it can be used 
in the XML file. 

Strin
g 

10 No No 

<clinic-
identifier> 

Identifier associated with the clinic. 

The identifier must already exist in the in the 
Web Interface for your group before it can be 
used in the XML file. 

ACO: The identifier may be a participating TIN, 
a CMS Certification Number (CCN), or a user 
entered identifier. 

PQRS group practice: The TIN or user entered 
identifier. 

Strin
g 

9 No No 

<general-
comments> 

Text Strin
g 

140 No No 

<medical-
record-
found> 

2 = Yes 

3 = Medical Record Not Found 

9 = Not Qualified for Sample 

Strin
g 

1 No No 

<medical-not-
qualified-
reason> 

10 = In Hospice 

11 = Moved out of Country 

12 = Deceased 

16 = HMO Enrollment 

Strin
g 

2 No No 

<medical-not-
qualified-
date> 

MM/DD/YYYY 

(Must be a valid date in the current program 
year) 

Strin
g 

10 No No 
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XML Element 
/ Measure Valid Values Data 

Type 

Fiel
d 

Size 

Tag 
Required 
in File for 
Format 

Validatio
n  

Data 
Required 
in Tag for 

Format 
Validatio

n  

<caremeddoc
-rank> 

1 to 616 

Rank is provided in an exported file for 
information only, rank cannot be modified in an 
XML upload or in the GPRO Web Interface. 

Strin
g 

3 For 
Export 
Only 

If used in 
upload, 
the tag 
will be 
ignored. 

For 
Export 
Only 

If used in 
upload, 
the rank 
will not 
be 
updated 
in the 
database. 

<caremeddoc
-confirmed> 

CARE-3 

2 = Yes 

15 = No – Other CMS Approved Reason 

19 = Not Confirmed – Age 

7 = Not Confirmed – No Qualifying Visits 

No – Other CMS Approved Reason may only 
be selected when an approval has been 
received from CMS in the form of a response to 
a QualityNet Help Desk inquiry. That Help 
Desk Ticket number must be provided when 
this answer is selected, to complete the patient. 

Not Confirmed – Age is included in an 
export only to provide information on the 
current status of the patient. If the Not 
Confirmed – Age value is used in an upload, 
the value will be ignored and the confirmation 
will not be set to this value. 

Not Confirmed – No Qualifying Visits is 
included in an export only to provide 
information on the current status of the 
patient. If the Not Confirmed – No Qualifying 
Visits value is used in an upload, the value will 
be ignored and the confirmation will not be set 
to this value. 

Strin
g 

2 No No 

<caremeddoc
-rm-ticket> 

Text up to 15 characters Strin
g 

15 No No 
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XML Element 
/ Measure Valid Values Data 

Type 

Fiel
d 

Size 

Tag 
Required 
in File for 
Format 

Validatio
n  

Data 
Required 
in Tag for 

Format 
Validatio

n  

<caremeddoc
-visit-date> 

CARE-3 

MM/DD/YYYY 

Must be a valid date in the current program 
year, and must be one of the pre-populated 
dates for the patient. 

See note in Visit Date for information on date 
range validation. 

Strin
g 

10 Yes Yes 

<caremeddoc
-visit-
confirmation> 

CARE-3 

2 = Yes 

21 = No – Visit Outside Practice 

Strin
g 

2 No No 

<medications
-
documented> 

CARE-3 

1 = No 

2 = Yes 

4 = No – Denominator Exception - Medical 
Reasons 

Strin
g 

1 No No 

<caremeddoc
-comments> 

CARE-3 

Text Strin
g 

140 No No 

</patient> Closing element for an individual patient’s 
medication documentation data elements; may 
be repeated with a matching opening element 
for each visit date for the patient, closing tag 
does not contain data. 

N/A N/A Yes N/A 

</web-
interface-
submission> 

Closing tag for header N/A N/A Yes N/A 
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Appendix C – Error Messages for Patient XML Files 
If there are errors in the format of the Patients XML file to be uploaded, the error messages and 
the line on which the error occurs will be provided. If the file contains XML elements that are not 
included in the specification, the error displayed will indicate an invalid XML format. If the file 
format is not valid, the first error message will be logged and processing will not continue. 
Examples of invalid file formats include an incorrect XML declaration, incorrect header, a 
missing required tag, a tag that is not one of the tags specified in the XML Specification, or any 
text that is not one of the valid tags. 

The table below shows the possible errors and associated condition causing the error for the 
XML validation. 

Message 
Number XML Element Condition Message Description 

3300 N/A A problem exists in the system. The 
XML file cannot be processed until the 
problem is resolved. 

System Error. Please 
contact the helpdesk. 

3301 XML Declaration The XML Declaration does not exactly 
match XML Specifications. 

May also be caused by including the 
Byte Order Mark (BOM) in the encoding 
when saving the file. 

Invalid XML header. 
Expected <?xml 
version=”1.0” 
encoding=”UTF-8”?> 

3302 N/A Invalid or mismatched Data Element 
Tag/Attribute, missing parent tag for 
sub-tag, invalid or missing elements in 
the <submission> tag, any tag that does 
not exist in the XML spec, or including 
any characters that are not in the 
specification for a tag or allowable data. 

Note: Additional information may be 
provided in the error message 
indicating the invalid tag. An invalid tag 
may be indicated for a valid tag missing 
the parent tag. 

If an invalid tag is found in the file, 
processing will not continue and 
additional errors will not be logged. 

Invalid XML File. 
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Message 
Number XML Element Condition Message Description 

3303 Any XML 
element indicated 
as required in the 
XML 
Specification, or 
Any XML tag in 
an unexpected 
order. 

A required XML element tag is missing 
or the tags are not in the order specified 
in Appendix A. When the error message 
appears, it will show the next expected 
XML tag in the [<tag>] portion of the 
error message. 

If a missing required tag is detected in 
the file, or the tags are out of order, 
processing will not continue and 
additional errors will not be logged. 

[<tag>] tag is expected. 
XML tags are out of order. 
Please refer to XML 
specifications for correct 
order of tags. 

3304 Any XML 
Element, except 
a date or 
comment 
element, 
containing 
validated data 

The data in the tag is not one of the 
allowable values for the XML Element. 
The XML Specification indicates the 
allowable values for each of the tags. 
When the error message appears, it will 
show the XML tag containing the invalid 
value in the [<tag>] portion of the error 
message. 

The value in [<tag>] is not 
an allowable value for this 
tag. Allowable values for 
each tag are provided in 
the XML Specification. 

3305 <group-tin> ACOs: The Primary Taxpayer 
Identification Number in the file and the 
Primary Taxpayer Identification Number 
to which the user is associated do not 
match. 

PQRS group practices: The Taxpayer 
Identification Number in the file and the 
Taxpayer Identification Number to 
which the user is associated do not 
match. 

When the user’s identity management 
account is associated to multiple 
Primary Taxpayer Identification 
Numbers or Taxpayer Identification 
Numbers, the number used to log in 
must match the number in the file. If 
you need to upload XML files for 
multiple TINs, you must log in 
separately for each TIN. 

Note that for this error message a line 
number will not appear. 

When the error message appears, the 
“[TIN]” will be replaced with the TIN in 
the file. 

Could not process the file 
because the TIN – [TIN] in 
the XML file does not 
match the user’s TIN. You 
may only upload XML files 
for the TIN used for this 
login. 
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Message 
Number XML Element Condition Message Description 

3306 <medicare-id> Medicare ID specified in the XML file 
does not exist in the database. All the 
patients selected for the sample are 
loaded into the database. The Medicare 
ID specified for a patient in the file must 
be the Medicare ID for one of the 
patients selected for the sample. 

Note that for this error message a line 
number will not appear. 

When the error message appears, the 
“[MEDICARE ID]” will be replaced with 
the Medicare ID in the file that is not in 
the database. 

Medicare ID – 
[MEDICARE ID] is not one 
of the sampled patients for 
this TIN. You may only 
update data for the 
patients pre-populated in 
the Web Interface for your 
TIN. 

3307 <medicare-id> Medicare ID is duplicated in the XML 
file. All data for a single patient must be 
contained between the opening 
<patient> and closing </patient> tags. 
The Medicare ID is the identifier for the 
patient, and may only be used once in a 
file. 

Medicare ID can only be 
specified once per patient. 

3308 <provider-npi> 

OR 

<provider-npi-
two> 

OR 

<provider-npi-
three> 

The Provider NPI must exist in the 
database before it may be used in the 
XML file to associate a provider to a 
patient. 

Provider NPIs are loaded into the 
database when the patient sample is 
loaded. Additional Provider NPIs may 
be entered into the GPRO Web 
Interface, which will store the Provider 
NPI in the database. 

Note that for this error message a line 
number will not appear. 

When the error message appears, the 
“[NPI]”will be replaced with the NPI in 
the file that does not exist in the 
database. 

When the error message appears, the 
“[MEDICARE ID]” will be replaced with 
the Medicare ID in the file for the patient 
where the NPI does not exist.  

Provider NPI – [NPI] 
specified for Medicare ID 
– [MEDICARE ID] is not 
an existing NPI. An NPI 
used in an XML file must 
be one of the pre-
populated NPIs or an NPI 
added using the Add 
Provider screen. 
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Message 
Number XML Element Condition Message Description 

3309 Any XML 
Element 
containing a 
validated date 

Date is not in a valid format: 

Valid Format = MM/DD/YYYY. 

Month and Day may be one (1) or two 
(2) digits, but year must be four (4) 
digits. 

Month cannot be 0 or 00 and cannot be 
greater than 12. 

Date cannot be 0 or 00 and cannot be 
greater than 31. 

Date cannot exceed limit for month. 

Date is not an allowable 
value or the format is 
incorrect. Correct format is 
MM/DD/YYYY. See XML 
Specification for more 
details. 

3310 <clinic-id> The Clinic ID must exist in the database 
before it may be used in the XML file to 
associate a clinic to a patient. 

Clinic IDs are loaded into the database 
when the patient sample is loaded. 
Additional Clinic Ids may be entered 
into the GPRO Web Interface, which 
will store the Clinic ID in the database. 

Note that for this error message a line 
number will not appear. 

When the error message appears, the 
“[CLINIC ID]”will be replaced with the 
Clinic ID in the file that does not exist in 
the database. 

When the error message appears, the 
“[MEDICARE ID]” will be replaced with 
the Medicare ID in the file for the patient 
where the Clinic ID does not exist. 

Clinic ID – [CLINIC ID] 
specified for Medicare ID 
– [MEDICARE ID] is not 
an existing clinic. A clinic 
used in an XML file must 
be one of the pre-
populated clinics or a 
clinic added using the Add 
Clinic screen. 
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Message 
Number XML Element Condition Message Description 

3312 Any XML tag for 
the general or 
module 
comments 

The length of the comment text 
exceeds 140 characters. The optional 
General Comments or module specific 
comments are limited to 140 
characters.  

The length of the 
comment in <tag> 
exceeds allowable size. 
Comments are limited to 
140 characters. 
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Appendix D – Error Messages for Patient Medications XML Files 
If there are errors in the format of the Patient Medications XML file to be uploaded, the error 
messages and the line on which the error occurs will be provided. If the file contains XML 
elements that are not included in the specification, the error displayed will indicate an invalid 
XML format. If the file format is not valid, the first error message will be logged and processing 
will not continue. Examples of invalid file formats include an incorrect XML declaration, incorrect 
header, a missing required tag, a tag that is not one of the tags specified in the XML 
Specification, or any text that is not one of the valid tags. 

The table below shows the possible errors and associated condition causing the error for the 
XML validation. 

Message 
Number XML Element Condition Message 

Description 

3300 N/A A problem exists in the system. The XML 
file cannot be processed until the 
problem is resolved. 

System Error. Please 
contact the helpdesk. 

3301 XML Declaration The XML Declaration does not exactly 
match XML Specifications. 

Including the Byte Order Mark (BOM) in 
the encoding when saving the file. 

Invalid XML header. 
Expected <?xml 
version=”1.0” 
encoding=”UTF-8”?> 

3302 N/A Invalid or mismatched Data Element 
Tag/Attribute, missing parent tag for sub-
tag, invalid or missing elements in the 
<submission> tag, any tag that does not 
exist in the XML spec, or including any 
characters that are not in the 
specification for a tag or allowable data. 

Note: Additional information may be 
provided in the error message indicating 
the invalid tag. An invalid tag may be 
indicated for a valid tag missing the 
parent tag. 

If an invalid tag is found in the file, 
processing will not continue and 
additional errors will not be logged. 

Invalid XML File. 
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Message 
Number XML Element Condition Message 

Description 

3303 Any XML element 
indicated as 
required in the 
XML 
Specification 

or 

Any XML tag in 
an unexpected 
order. 

A required XML element tag is missing or 
the tags are not in the order specified in 
Appendix B. When the error message 
appears, it will show the next expected 
XML tag in the [<tag>] portion of the 
error message. 

If a missing required tag is detected in 
the file, or the tags are out of order, 
processing will not continue and 
additional errors will not be logged. 

[<tag>] tag is 
expected. XML tags 
are out of order. 
Please refer to XML 
specifications for 
correct order of tags. 

3304 Any XML 
Element, except 
a date or 
comment 
element, 
containing 
validated data. 

The data in the tag is not one of the 
allowable values for the XML Element. 
The XML Specification indicates the 
allowable values for each of the tags. 
When the error message is displayed, 
the error message will display the XML 
tag containing the invalid value in the 
[<tag>] portion of the error message. 

The value in [<tag>] is 
not an allowable value 
for this tag. Allowable 
values for each tag 
are provided in the 
XML Specification. 

3305 <group-tin> ACOs: The Primary Taxpayer 
Identification Number in the file and the 
Primary Taxpayer Identification Number 
to which the user is associated do not 
match. 

PQRS group practices: The Taxpayer 
Identification Number in the file and the 
Taxpayer Identification Number to which 
the user is associated do not match. 

When the user’s identity management 
account is associated to multiple Primary 
Taxpayer Identification Numbers or 
Taxpayer Identification Numbers, the 
number used to log in must match the 
number in the file. If you need to upload 
XML files for multiple TINs, you must log 
in separately for each TIN. 

Note that for this error message a line 
number will not appear. 

When the error message appears, the 
“[TIN]” will be replaced with the TIN in 
the file. 

Could not process the 
file because the TIN - 
[TIN] in the XML file 
does not match the 
user’s TIN. You may 
only upload XML files 
for the TIN used for 
this login. 
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Message 
Number XML Element Condition Message 

Description 

3306 <medicare-id> Medicare ID specified in the XML file 
does not exist in the database. All the 
patients selected for the sample are 
loaded into the database. The Medicare 
ID specified for a patient in the file must 
be the Medicare ID for one of the 
patients selected for the sample. 

Note that for this error message a line 
number will not appear. 

When the error message appears, the 
“[MEDICARE ID]” will be replaced with 
the Medicare ID that is not in the 
database. 

Medicare ID – 
[MEDICARE ID] is not 
one of the sampled 
patients for this TIN. 
You may only update 
data for the patients 
pre-populated in the 
Web Interface for your 
TIN. 

3307 <caremeddoc-
visit-date> 

Visit Date is duplicated in the XML file. 
The Visit Date is the identifier for the 
patient, and may only be used once in a 
file. 

Medicare ID - 
[MEDICARE ID] has 
duplicate 
caremeddoc-visit-
date. Visit date 
:[VISIT DATE] 



Appendix D – Error Messages for Patient Medications XML Files 

GPRO Web Interface XML Specification V1.0 190 PQRS PY2016 

Message 
Number XML Element Condition Message 

Description 

3308 <provider-npi> 

OR 

<provider-npi-
two> 

OR 

<provider-npi-
three> 

The Provider NPI must exist in the 
database before it may be used in the 
XML file to associate a provider to a 
patient. 

Provider NPIs are loaded into the 
database when the patient sample is 
loaded. Additional Provider NPIs may be 
entered into the GPRO Web Interface, 
which will store the Provider NPI in the 
database. 

Note that for this error message a line 
number will not appear. 

When the error message appears, the 
“[NPI]”will be replaced with the NPI in the 
file that does not exist in the database. 

When the error message appears, the 
“[MEDICARE ID]” will be replaced with 
the Medicare ID in the file for the patient 
where the NPI does not exist.  

Provider NPI – [NPI] 
specified for Medicare 
ID – [MEDICARE ID] 
is not an existing NPI. 
An NPI used in an 
XML file must be one 
of the pre-populated 
NPIs or an NPI added 
using the Add 
Provider screen. 

3309 Any XML 
Element 
containing a 
validated date 

Date is not in a valid format: 

Valid Format = MM/DD/YYYY. 

Month and Day may be one (1) or two (2) 
digits, but year must be four (4) digits. 

Month cannot be 0 or 00 and cannot be 
greater than 12. 

Date cannot be 0 or 00 and cannot be 
greater than 31. 

Date cannot exceed limit for month. 

When validating the format of the data, 
the dates must be for the current 
program year. However, when 
processing the XML file the Visit Dates 
are limited to the pre-populated dates 
which are between January 1, [current 
program year] and October 31, [current 
program year]. 

Date is not an 
allowable value or the 
format is incorrect. 
Correct format is 
MM/DD/YYYY. See 
XML Specification for 
more details. 



Appendix D – Error Messages for Patient Medications XML Files 

GPRO Web Interface XML Specification V1.0 191 PQRS PY2016 

Message 
Number XML Element Condition Message 

Description 

3310 <clinic-id> The Clinic ID must exist in the database 
before it may be used in the XML file to 
associate a clinic to a patient. 

Clinic IDs are loaded into the database 
when the patient sample is loaded. 
Additional Clinic Ids may be entered into 
the GPRO Web Interface, which will 
store the Clinic ID in the database. 

Note that for this error message a line 
number will not appear. 

When the error message appears, the 
“[CLINIC ID]”will be replaced with the 
Clinic ID in the file that does not exist in 
the database. 

When the error message appears, the 
“[MEDICARE ID]” will be replaced with 
the Medicare ID in the file for the patient 
where the Clinic ID does not exist. 

Clinic ID – [CLINIC 
ID] specified for 
Medicare ID – 
[MEDICARE ID] is not 
an existing clinic. A 
clinic used in an XML 
file must be one of the 
pre-populated clinics 
or a clinic added 
using the Add Clinic 
screen. 

3311 <caremeddoc-
visit-date> 

The Visit Date for the patient must exist 
in the database. The Visit Dates are 
loaded into the database when the 
patient sample is loaded. The pre-filled 
dates are the only dates which may be 
used for a patient. 

Note that for this error message a line 
number will not be displayed. 

When the error message appears, the 
“[DATE]” will be replaced with the date in 
the file that is not in the database for this 
patient. 

When the error message appears, the 
“[MEDICARE ID]” will be replaced with 
the Medicare ID in the file for the patient 
where the Visit Date does not exist.  

Visit Date – [DATE] 
does not exist for 
Medicare ID – 
[MEDICARE ID]. You 
may only update data 
for the visits that were 
pre-filled for this 
patient. 

 

  



Acronyms 

GPRO Web Interface XML Specification V1.0 192 PQRS PY2016 

Acronyms 
This section describes the acronyms used in this document. 

Acronym Literal Translation 

ACE-I/ARB Angiotensin-Converting Enzyme Inhibitor or Angiotensin Receptor 
Blocker 

ACO Accountable Care Organizations 

ASCVD Atherosclerotic Cardiovascular Disease 

BMI Body Mass Index 

CAD Coronary Artery Disease 

CARE Care Coordination/Patient Safety 

CCN CMS Certification Number 

CMS Centers for Medicare & Medicaid Services 

DM Diabetes Mellitus 

GPRO Group Practice Reporting Option 

HF Heart Failure 

HMO Health Maintenance Organization 

HTN Hypertension 

IVD Ischemic Vascular Disease 

LDL-C Low-Density-Lipoprotein Cholesterol 

LVEF Left Ventricular Ejection Fraction 

LVSD Left Ventricular Systolic Dysfunction 

NPI National Provider Identifier 

mg/dL Milligrams per Deciliter 

MH Mental Health 

mmHg Millimeters of Mercury 

PQRS Physician Quality Reporting System 

PREV Preventive Care 

TIN Taxpayer Identification Number 

XML Extensible Markup Language 

XSD XML Schema Definition 
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Referenced Documents 
The documents listed in the table below were used in whole or in part to develop the content 
within this document. Documents are available on the CMS website on the PQRS GPRO Web 
Interface page. 

Document Name Document 
Number 

Issuance Date 

2016 GPRO CAD Supporting Documents  N/A December 2015 

2016 GPRO CARE Supporting Documents  N/A December 2015 

2016 GPRO DM Supporting Documents  N/A December 2015 

2016 GPRO HF Supporting Documents  N/A December 2015 

2016 GPRO HTN Supporting Documents  N/A December 2015 

2016 GPRO IVD Supporting Documents  N/A December 2015 

2016 GPRO MH Supporting Documents N/A December 2015 

2016 GPRO PREV Supporting Documents  N/A December 2015 

  

http://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
http://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/PQRS/GPRO_Web_Interface.html
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